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Preface 
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sequence to ensure smooth flow of the subject. 

The primary aim of the authors has been to present the material in a comprehensive 

manner so as to help the students to easily grasp the subject and reproduce it whenever and 

wherever required. Complex topics are covered in illustrative manner at appropriate places; 

teachers will find it easy to make students understand the concepts. Student need not to go 

for another book to find the topics, as all the syllabus is covered in the same book with easy 

language. Some of the questions serve as exercises for the material covered in the chapter. 

Solved short answer questions and long answer questions have been provided at the end of 

every unit. 

It is an earnest desire of the authors that the readers should make the best use of it. 

There are still many ways in which the presentation of this book can be further improved. 

The valuable suggestions for further improvement of the book will be gratefully accepted. All 
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advertently. The readers are requested to write us in this regard. 
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Fig. 1.1 (Computer System)

1.1 INFORMATION TECHNOLOGY

The term Information Technology (IT) is widely used nowadays. It refers to the subjects 
related to creating, managing, processing and exchanging information. It defines an 
industry that uses computers, networking, software programming, and other equipment 
and processes to store, process, retrieve, transmit, and protect information. 

In this era of information technology, computers are used in almost all walks of life. 
Computers are widely used in several fields, such as education, communication, 
entertainment, banking, medicine, weather forecasting and scientific research. We can use 
computers to perform a variety of tasks, such as drafting letters, performing calculations, 
maintaining records about students, creating question papers, analyzing exam results and 
even creating attractive pictures. In spite of the field of working, today eveiy person needs to 
have basic knowledge of computers to excel in his/her respective field. IT proficiency allows 
a person to be an active and effective participant in the emerging information or knowledge 
society. To be successful in today's information or knowledge age, we must have knowledge 
and understanding of computers and their uses. 

1.2 COMPUTER (COMMONLY OPERATED 
MACHINE PARTICULARLY USED FOR 
TRADE EDUCATION AND RESEARCH) 

The word computer comes from the word “compute”, 
which means, “to calculate”. 

A Computer is an electronic device or machine that 
can perform arithmetic operations like addition, 
subtraction, multiplication, division etc. as well as 
logical operations like comparisons at very high speed. 
A computer is also called a “Data Processor” because it 
can store, process, and retrieve data whenever desired. 

1.3 CHARACTERISTICS OF COMPUTERS 
A computer is equipped with number of characteristics that helps it to handle the 

different problems more efficiently. Some of the general features of computers are: * 

• Accuracy 
Computer system always produces accurate results with valid data and instructions. In 
simple terms, one cannot expect correct and accurate results when the instruction set to 
manipulate the data is incorrect or the data which user is supplying to the computer is 
wrong. 

• Speed 
A computer performs operations with very high speed. It can process millions of 
instructions in fraction of seconds. The speed of a computer varies from computer to 
computer. It is basically measured in nanoseconds (10 9 seconds) and picoseconds (1012 
seconds). With the introduction of very fast processing units and other devices 
connected to computer the speed of the computer is increasing day by day.
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• Large storage capacity 
A computer has large storage capacity. It can store large volume of data. We car store any kind 
of data in computer’s storage. This data can be text, picture, sound video etc. 

• Versatility 
A computer is a versatile machine. It can perform a number of jobs depending upor the 
instructions fed to it. Like a computer can be used to write a letter to a friend ir a word 
processor and at the same time listen to various songs through a medis player. The same 
machine (computer) works in different fields with differenl applications to perform various 
tasks. This property of computer is called versatility. 

• Reliability 
Computerized storage of data is much more reliable than the manual storage. We can store the 
data in computer’s storage for a long period of time except until anj kind of system failure 
occurs. 

• Diligence 
Unlike human beings, the computer can work continuously without getting tired. II can 
perform the same task repeatedly with same processing speed. Without the lack of 
concentration they help us in doing a number of jobs that require a greal accuracy. 

• Automatic 
A machine that works itself without any human involvement is said to be an automatic 
machine. Computers are automatic machines; they can work on any given job automatically till 
it gets finished without any human interference. 

• Source of Entertainment 
Today, computer has become a great source of entertainment. We can play video games, enjoy 
music and watch movies or various satellite channels through computer. We can also 
communicate with each other through computer by means ol text messages, audio/video 
messages. 

• Cost effectiveness 
Computers reduce the amount of paperwork and human effort, thereby reducing costs. For 
example: we can create and edit student reports easily using a computer. We can send electronic 
reports to management via e-mail. 

• No intelligence 
A computer has no intelligence of its own. It depends upon user’s instructions for any kind of 
task. Now days, some artificial intelligence (AI) has been introduced that helps the computer to 
take some decisions on its own. Robots are the example of such AI systems. 

S Prolonged or improper computer use can lead to injuries or disorders of the hands, wrists, elbows, eyes, 
necks, and back. Computer users can protect themselves from these health risks through proper 
workplace design, good posture while at the computer, and appropriately spaced work breaks. 

1.4 GENERATIONS OF COMPUTERS 
“Generation” in computer talk is a step in technology. It provides a framework (structure) for 

the growth of computer industry. It was used to distinguish between various hardware and software 
technologies in the development of computer i.e. due to technological advancement; different 
changes have come in the computer system. Till today, there are five computer generations. The 
following segment discusses the 
main characteristics of each generation one by one. 
/ Fi t G ti (1942 1955) V T b
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Fig. 1.3 
(Transistor)

Fig. 1.4 (Integrated 
Circuit)

consumptions of electricity. Therefore, these computers required continuous maintenance
and proper cooling with the help of large Air-conditioners. 

5. They were relatively unreliable as they could produce inaccurate results sometimes. 
6. Input was based on punched cards and paper tape. 
7. They performed slow input-output operations. 
8. Limited programming capabilities. Only machine language and  (Vacuum Tube) assembly

languages were used. 
9. These computers had limited commercial use. 

10. The UNIVAC and ENIAC computers are examples of first-generation computing devices. 

7 Second Generation (1955 -1964) - Transistors 
The characteristics of second-generation computers were: 

1. This generation computers used Transistors in place of vacuum tubes. 
2. They were much smaller in size and required lesser space for 

installation. 
3. Magnetic tapes were used as secondary storage. 
4. They consumed lesser power and therefore lesser amount of heat 

was generated as compared to first generation computers, but 
still air conditioning was required. 

5. They were highly reliable and lesser prone to hardware failures 
as compared to first generation computers. 

6. They were about 10 times faster than the first generation 
computers. 

7. High-level languages were used to instruct the computers for 
performing various tasks. 

8. These computers were more versatile than first generation 
computers. 

9. High Input/Output operations speed than first generation computers. 
10. The commercial production of second-generation computers was limited and costly. 

7 Third Generation (1964 -1975) - Integrated Circuits 
The characteristics of third generation computers were: 

1. Integrated Circuits (IC’s) were used instead of Vacuum tubes and Transistors. 
2. The size of these computers was smaller than the earlier computers. 
3. Magnetic disk used for external storage and storage space available in these computers was

much more than earlier computers. They consumed less 
power than second-generation computers, but still air- 
conditioning was required. 

4. They were more reliable and lesser prone to errors . than 
earlier computers. 

5. They had high processing speed than second- generation 
computers. 

6. Monitors and keyboards were used for Input and Output. 
7. Development of standardized High-level languages like 

PASCAL, BASIC etc. 
8. Maintenance cost of these computers was very less as 

compared to earlier computers. 
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Fig. 1.6 
(Artificial 

Intelligence - 
(ROBOT)) 

2. They were much smaller and cheaper than third generation computers. 
3. They consumed less power than third generation computers. 
4. They were more reliable and less prone to hardware failures than third generation 

computers and therefore their maintenance cost is negligible. 
5. They had faster and larger primary and secondary storage as compared to third 

generation computers. 
6. Graphical User Interface (GUI) enabled new users to quickly learn how to use computers. 
7. Use of standard high-level languages allowed program to be transferred from one 

computer to another. 
8. Supports more Input and Output devices or other terminals than previous generations 

computers. 
9. Network of computers enabled sharing of resources like disks, printers etc. among 

multiple computers and users. 
10. They were general-purpose machines used in application 
development. 

s Fifth Generation (1989 - Present) - Artificial Intelligence 
The characteristics of fifth generation computers are: 

1. Fifth generation computers, based on Artificial Intelligence 
(AI) are still in development. Artificial Intelligence is a 
branch of computer science concerned with making 
computers behave like humans. 

2. Portable computers (called notebook computers) are much 
smaller and handy than fourth generation computers. 

3. Fifth generation computers are several times more 
powerful than fourth generation computers. 

4. They consume less power than earlier computers. 
5. They are much more reliable and less prone to hardware 

failures than previous generation computers. 
6. They have faster and larger primary and secondary storage 

as compared to previous generation computers. 
7. More user-friendly interfaces with multimedia features make the systems easier to learn 

and use by anyone, including children. 
8. The goal of fifth generation computing is to develop devices that respond to natural 

language input (i.e. Human languages like English, Hindi, and French etc.) and are 
capable of learning. 

1.5 BASIC TERMINOLOGY 
Being a data processing system, computer has importance in providing in-depth knowledge of 

whatever is involved in processing the data. But before looking into that, we require to define 
some of the basic terms associated with it. 
> Input 

Input refers to the data and instructions given to the computer. Where data is a raw set of facts 
and figures associated with an individual, an entity, or an event. It is basically a collection of 
unorganized facts or concepts that does not convey any meaning. Data can be represented in 
various forms i.e. in figures, characters, symbols, pictures, audio, video etc. 
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do with the data. 
Example: 
2 + 3 (Here 2 and 3 are the data, and the instruction is addition operation (+)) 

> Process 
It is the actual interpretation and execution of the instruction on data, which is carried out by 
the computer’s processing unit (microprocessor) to obtain the required result. 
Example: 

2 + 3-4 (Here 2, 3 and 4 is the data, and the process to be carried out is to first take out the 
sum of 2 and 3, and from the result of the summing process subtract the value of 4). 

> Output 
The result obtained from the process is called as an output. Computer processes the data 
according to the instructions fed into it and produce the required results. This result is known 
as output. 
Example: 

In the above example stated for process (2 + 3 - 4 ) ,  the output is 1. 
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> Information 
Meaningful output is information. When we apply some process on data, we get some result. 
This result is called output. But if that output is meaningful foi someone, then it becomes 
information for him/her. 
Example: 
The average performance of a class is derived as an output from the process ol summing up all 
the marks of the class, and dividing it by the number of students. This output would be 
meaningful to the class teacher, but maybe not to the peon o1 the school. The output derived is 
information for the class teacher but not to the peon. 

1.6 DATA VS. INFORMATION 

1.7 TYPES OF COMPUTERS 
There are various methods on which the computers can be classified. The classification may 

depend on size, technology, area of application, type of data processed etc. 

The above figure shows that the computer can be divided into digital, analog and hybrid 
computers, where digital computers can be further divided into purpose wise, size wise and function 
wise computers. 
> DIGITAL COMPUTERS 

 
Data 

 
Information 

• Data is raw fact and figures. For 
example: 32 is data. 

• 
Information is a processed form of data. 
For example: Age 32. 

• Data is not significant to a business. © Information is significant to a business. 
« : Data are atomic level pieces of 

information. It can be in the form of 
numbers, characters, symbols, or even 

• Information is a collection of data. For 
example: Age and 32 collected together to 
form information (Age 32). 

 pictures.   

© Data does not help in decision making. • Information helps in decision making. 
© Observations and recordings are done to 

obtain data. 
• Analysis is done to obtain information. 

'§11
1 

Input to any system may be treated as 
data. 

• Output after processing the system is 
Information. 

© Difficult to understand properly. • Easy to understand. 
© Data must be processed to understand. • 

Information is already in understandable 
form, it may be processed further to 
make it more understandable. 

• Data may not be in the order. • Information should be in the order. 
 

COMPUTER 
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• They are the most commonly used computers in homes and offices. 
• The real life example of a digital computer is a digital watch. Now days, computer used for

the purpose of business and education are also example of digital computers. 
• In digital computers, data flows in the form of clock pulses as shown below: 

 

Digital computers can be further classified into following classifications: 
(i) Classification by purpose 
(ii) Classification by size 

(iii) Classification by function 
(i) Classification by purpose 

There are some needs that are specific to a particular environment or a particular user.
Depending upon the purpose of use, the computers can be special purpose or general purpose. 
(a) Special Purpose Computers 

• These computers are specially designed to perform a specific task of a specific environment.
That’s why these computers are not versatile. 

• The instructions used by these computers are permanently stored in the machine. 
• These computers are generally embedded in various automatic devices. For example: A

computer that has been designed to count the telephone call pulses and display the amount
payable can only serve this purpose. It cannot be used for other purposes. 

(b) General Purpose Computers 
• These computers can be used for all general needs of all environments 8s users. 
• These are the versatile computers that can perform a variety of jobs for a variety of

environments i.e. general-purpose computers can be used anywhere to solve any problem.
For example: A general purpose computer can be used to calculate accounts, data, writing
letters, drawing pictures, playing games, listening music, watching movies and accessing
internet etc. 

(ii) Classification by size 
Computers can be classified by their physical size and appearance. By size we can classify them

into following types: 
(a) Micro Computers 

• A microcomputer is a small, relatively inexpensive computer with a microprocessor as its 
central processing unit. 

• A microcomputer is a computer designed for individual use.  



INTRODUCTION TO COMPUTERS 1.19

Fig. 1.10 (Micro Computer)

Fig. 1.11 (Mini 
Computer)

Fig. 1,12 (PDA - A 

Programmable Computer)

• This is the smallest category of digital computers, in which 
a single microprocessor performs the function of ALU 
(Arithmetic logic unit) and Control unit. 

• In micro computers, microprocessor is connected with 
primary memory (RAM & ROM), input, output and 
secondary storage devices. 

• Microcomputers are supported by single user operating 
systems. 

• Home computers and personal computers are the best 
examples of Microcomputers. 

(b) Mini Computers 
• Mini Computers are general purpose computers, which are more expensive than the 

microcomputers. 
• They also use 16 bit or 32-bit microprocessor as their main 

CPU. Intel80386, 80486 and Pentium are some processors of 
these computers. 

• The capabilities of mini computers lie somewhat between the 
mainframes and personal computers. 

• They can support multiple input-output devices. 
• They contain less memory and processing capabilities than a 

mainframe. 
• A large number of computers can be connected to a network 

with a mini computer acting as a server. 
• Mini Computers can be used for systems like- ticket 

reservation or banking. 
• Most commonly used operating system on such computers 

is UNIX. 
(c) Programmable Computers 

• Programmable computers are the smallest computers that 
can be programmed by the user. 

• Personal Digits Assistants (PDA), latest mobiles and 
address books fall under this category. 

• These computers have capabilities of keeping track of 
appointments, meetings, call lists, SMS, image & video 
capturing etc. 

• They also contain accessories like calculator, notepad, 
MP3 players, Bluetooth communication etc. 

(d) Laptop 
Laptop computers are so small that they can be placed 
on our lap. 
These computers can work while traveling and even 
without any power connection. 
These computers are commonly used at homes or offices 
to perform commonly used operations like word 
processing, spreadsheets and presentations. 
These computers are light in weight and compact in size. 
They contain all features of desktops or personal 
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Fig. 1.14 (Desktop or 
Personal Computer)
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Fig. 1.15 (Mainframe 
Computer)

Crystal Display) screens and pointing sensors. Today, Laptop computers are coming with
LED (Light Emitting Diodes) screens also. 

(e) Desktop or Personal Computers (PC) 
• Personal Computers are the most widely used computers in the world. 
• These computers are normally placed on the top of the desk, so they are also known as the

Desktop computers. 
• These computers are equipped with huge 

volumes of main and secondary memories. 
• They are mainly used for managing personal 

data of a company or an individual, that’s why 
they are called Personal computers. 

• Number of softwares can be installed on these 
computers to perform various kinds of data 
processing operations. 

• We can manage accounts, design graphics or 
images, surf internet, write letters and listen to 
music or watch movies on these computers. 

• The size of desktop computers is greater than laptops. 
(f) Mainframe Computers 

• A mainframe computer is a veiy large size computer capable of handling and processing
very large amounts of data quickly. 

• Mainframe computers have more main and secondary storage and contain multiple
processing units (CPUs). 

• These computers are generally used in large 
organizations like government agencies, banks, 
flight scheduling, ticket reservations and insurance 
companies where a large number of people need 
frequent access to the same data which is usually 
organized into one or more huge databases. 

• In a mainframe, several computer terminals which 
basically contain keyboard and monitor are plugged 
into a single mainframe. These terminals act as an 
input/output device to the mainframe. 

• Mainframe computers occupy a lot of space and 
require proper air-conditioning. 

• Mainframes are so called because the earliest ones were housed in large metal frames. 
• A typical mainframe system can support hundreds of users at the same time. 
• With the technological advances in personal computers, the need for mainframe computing

has significantly reduced over the years. The computing power of a typical desktop
computer today is greater than that of a mainframe system. 

(g) Super Computers 
• Super Computers are the most powerful computers typically used for scientific and

engineering applications that must handle very large databases or do a great amount of
computation   
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Fig. 1.16 (Super Computer) 
• Super computers are the fastest and most expensive computers ever built b] humans. 
• These computers contain multiple processors that work together to solve a singlf problem at 

a time. 
• The size of these computers is hundreds of times bigger than a persona computer. 
•  These computers have huge main memories and secondary storage. 
•  These computers cost in millions of dollars and owned by countries or very largr business 

organizations. 
• Supercomputers are used for very complex jobs such as nuclear research or forecasting 

weather patterns. 
•  The major difference between a supercomputer and a mainframe is that £ supercomputer 

channels all its power into executing a few programs as fast as possible, whereas a 
mainframe uses its power to execute many programs concurrently. 

(iii) Classification by function 
Computers can be classified into following four basic categories based on the 

functions it can perform: 
(a) Server 

• Server refers to a computer that is dedicated to provide some services to the other 
computers (called clients). 

• Some servers are committed to a specific task; often referred to as dedicated. As a result, 
there are a number of dedicated server categories, like database servers, file servers and 
print servers. 

• Servers are named depending on the type of service they offer. For example, s computer 
dedicated to a database may be called a "database server". A computei manages a large 
collection of computer files may be called a "File server". 

• As servers are commonly used to deliver services that are required constantly, sc most of the 
servers are never turned off. 

• They are bit different because high performing servers are set-up with high configuration 
hardwares and softwares. 

(b) Workstation 
• A workstation is a computer intended for individual use i.e. primarily to be used by one 

person at a time. 
• A high-performance computer typically used for software development, audio/video editing 

and scientific applications.  
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• It is mainly designed for business or professional use rather than home use. 
• A workstation has advanced graphics capabilities, large storage capacity, and a powerful

microprocessor. 
• Workstations are commonly connected to a local area network and run multiuser operating

systems. 
• In terms of computing power, workstations lie between personal computers and

minicomputers. 
(c) Embedded Computers 

• Embedded computers are fixed inside various electronic devices to automate and control
their working. 

• Various modem electronic devices like Microwave, washing machine, televisions and many
other devices contain embedded computers. For example - A small computer fitted in a
digital washing machine controls the washing cycle of the machine. 

• The user could not program these computers. The manufacturer of these computers
programs them. 

• The central processing emits (CPUs) used in embedded computers are often sufficient only
for the computational requirements of the specific application and may be slower and
cheaper than CPUs found in a personal computer. 

(d) Information Appliances 
• Information appliances are easy-to-use portable computing devices which are designed to

perform a limited set of tasks like basic calculations, playing multimedia, browsing internet,
photography, editing text etc. 

• Many information appliances will be connected to service providers that provide various
services for a monthly subscriber fee. 

• They are generally referred as the mobile devices having limited functionality. 
> ANALOG COMPUTERS 

• Analog computers are the computers that work on continuous data. 
• Analog computers are used to measure the physical quantities like pressure, temperature,

speed etc. 
• These computers accept input data in the form of signals and convert them to numeric

values. For example: A thermometer does not perform any calculations but measures the
temperature of the body. 

• Analog computers are mainly used for scientific and engineering purposes, because they deal
with quantities that vary constantly. 

• Analog computers are faster than digital computers but they are not as accurate as digital
computers. That’s why they are less commonly used. 

• The representation of flow of data in analog computer is shown as: 

Fi 1 17 (D t Fl i A l C t )
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• These computers are useful in those environments, where both digital & am signals are used 

in processing. 
• The uses of hybrid computers are increasing day by day as ther-e are numbei areas in the 

real world where we need both analog and digital computers, example: In a hospital, there 
may be number of devices like E.C.G. machine c which are used to measure the patient’s 
heart beat, temperature and otl information. This is done by analog computers. The 
information received fr these analog computers is then supplied to digital computers to 
generate repoi Thus, this whole system uses hybrid computers. 

1.8 COMPARISON OF COMPUTER SYSTEMS 
1.8.1 DIGITAL Vs. ANALOG COMPUTER 

1.8.2 MINI Vs. MAINFRAME COMPUTER 

Digital Computer Analog Computer 
 Digital computers work on discontinuous or 
discrete data.  Analog computers work on continuoi data. 

 Digital computers carry out operations on 
binary data at a very fast rate and generate 
output in user understandable language. 

 Analog computers carry out operations o 
variable electrical signals and general 
output in the form of analog electric! signals. 

 Digital computers basically work by 
counting and adding the binary digits i.e. it 
is based on counting operation. 

 Analog computers work by measurin analog 
or electrical signals. 

 Digital computer is more efficient in discrete 
calculations. 

 Analog computer is more efficient i 
continuous calculations. 

 Digital computer represents data in binary 
format (0 and 1). 

 Analog computer represents data a physical 
quantities like voltage temperature, current 
etc. 

 More accurate and reliable.  Analog computers are not as accurate a 
digital computers. 

 In digital computers, data flows in the form 
of pulses. 

JlfUUML
 In analog computers, data flows in thi form 
of sine waves. 

mm r A digital computer can perform one 
calculation at a time. 

 An analog computer works in parallel This 
means it can carry out multiple tasks 
simultaneously. 

 Digital computers are used in banking, 
manufacturing, personal usage etc. 

 Analog computers are used in scientific and 
engineering applications. 

 

Mini Computer Mainframe Computer 

Minicomputer is a kind of computer that 
works stand alone. It is used by small and 
mid size businesses for normal business 
applications  

 Mainframe computer is a kind of computer 
which is used by large organizations for 
crucial applications and processing  
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It has a multiprocessing system. It can 
support around 400 users simultaneously. 

It is capable of hosting multiple operating 
systems. 

• Slow processing speed. It has huge processing ability and is able to do 
complex tasks. 

• Memory is less than that of mainframe. . 
Therefore used in small companies. 

Mainframe computers have large amount of 
memory and serve number of workstations 
used in large companies. 

1.8.3 PC (PERSONAL COMPUTER) Vs. SUPER COMPUTER 
PC (Personal Computer) Super Computer 

 Slow processing speed. Super computer use mrmber of processors, so 
speed of execution is higher than personal 
computer. 

 Storage capacity is minimum. Storage capacity is very high, generally in 
Terabytes. 

 Limited peripheral devices (like: keyboard, 
mouse) can be connected to personal 
computer. 

Super computer can have multiple computers 
connected to it so multiple peripheral devices 
can be connected to super computer. 

 Used for word processing, small data 
maintenance, small applications like: Bill 
processing system etc. 

Used for weather forecasting, research work 
and image processing etc. 

1.8.4 MINI COMPUTER Vs. MICRO COMPUTER 
Mini Computer Micro Computer 

• Bigger than micro computer. 
Relatively small in size. The microcomputer 
system is designed to fit on a desktop. 

• More expensive. Less expensive. 
• Mini computer can have multiple 

processors. 
Single processor. 

• High performance, capable of doing 
highly | specific and complex tasks 

Relatively low performance. 
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1.9 BASIC COMPONENTS OF A COMPUTER SYSTEM 
A system is defined as a set of interacting elements, responding to inputs so as to

produce outputs. A computer system consists of the following major elements or
components: 
i) Software 
ii) Hardware 
iii) Firmware 
iv) Humanware 
(i) Software 
All the intangible components of the computer system are known as software. Intangible
components mean those components or parts, which we can’t touch physically. In other
language, we can say that all those computer applications or programs, which run behind
the monitor’s screen, are known as softwares. 
Example: 
Windows, Notepad, WordPad, Internet Explorer, Windows Media Player etc.
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Storage Unit

CPU (C t l P i U it)

(ii) Hardware 
All the tangible components of the computer system are known as hardwar Tangible 
components mean all the physical components of the computer systei which we can 
touch and can freely move from one place to another. 
Example: 
CPU (Microprocessor), Monitor, Keyboard, Mouse, Speakers, Printer, Scanner etc. 

(iii) Firmware 
Firmware can be defined as a group of software and hardware. Because in comput 
system, without hardware components, software have no meaning and withoi 
software components, hardware have no meaning i.e. both of these componen 
(software & hardware) are mutually dependent. Both of them must work together 
order to make computer produce some useful output. This group is called Firmware. 
Example: 
All the software applications or programs are installed in the hard disk, which is 
hardware component. This combination of software and hardware is firmware. 

(iv) Hu man ware 
User or an operator, who uses the computer machine, is known as Humanwar 
Humanware can be a computer professional, a student, a novice user (beginner) < any 
other person, who operates this machine for completing his or her task. 

1.10 BLOCK DIAGRAM OF COMPUTER 
A typical computer system irrespective of its size, class or type consists of hardwaj 

and software, integrated and synchronized together to perform computational work < 
data processing. 

Computer Anatomy is concerned with the way the various functional units opera! and 
how they are connected together to form the computer system. 
A computer system consists of the following functional units: 

(i) Input Unit. 
(ii) Memory / Storage Unit. 

(iii) CPU (Central Processing Unit) 
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The block diagram of a computer system is shown in Fig. 1.18 depicts the working of 
computer and its various functional units. 

(i) Input Unit 
As the computer process the data according to the instructions given to it and produces 

the results. The input unit is used to feed the data as well as instructions to the computer. 
The commonly used input devices are keyboard, mouse, scanner, joystick etc. 

In brief, an input unit performs the following functions: 
• It accepts or reads the list of data and instructions from the user. 
• It converts these data and instructions in computer acceptable form. 
• It supplies the converted data and instructions to the computer system for further 

processing. 
(ii) Memory/Storage Unit 

The basic function of this unit is to store the data, instructions and final results in the 
system so that it can deliver them on demand to the user or other computer units at a later 
time. The data and instructions are transferred to other computer units or devices from 
the main storage under the supervision of control unit. It also referred as the primary 
storage. 
• Primary Storage 

Primary storage is a direct access storage device, consisting of a number of storage 
locations. Each location in the storage has a unique number, called Storage Address. The 
system assigns a unique location to each data element. Once the data is assigned to the 
location, the system accesses it directly by means of the address of the particular storage 
locations. 

The various types of primary storages are: 
(a) RAM (Random Access Memory) (b) ROM (Read Only Memory) 
(c) Cache Memory (d) Virtual Memory 

• Secondary Storage 
The data and instructions in primary storage (RAM) are temporary in nature and they 

are erased automatically as soon as the power is switched off. The secondary storage is 
used to store the data permanently. The user can access the data from secondary storage 
whenever required. Some commonly used secondary storage devices that are used to store 
the data permanently are: 

(a) Floppy Disk (c) Compact Disk 
(b) Hard Disk (d) Magnetic Tape 

(iii) Central Processing Unit (CPU) 
CPU is considered as the “Brain of the computer”. It is also called as microprocessor. 

It is the fastest and costly unit of the computer system. All major calculations and 
comparisons are made inside the CPU. CPU converts all the supplied input into required 
output as per the instructions supplied by the user. The performance and the speed of the 
computer mainly depend upon the type of microprocessor installed in it. 

Within CPU, there exists a temporary storage location known as Registers. These are 
used for storage of smaller data (up to 64 bits). Registers are being used for faster data 
supply to processor for processing. The number, size and capacity of register in a CPU can 
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controls all the activities of various functional units of the computer. 
• It fetches (transfers) the required instructions from the main memory, interprets 

them and then sends them to ALU for processing. 
• It controls the execution of instructions in a sequential order. 
• It works as a central nervous system for the computer. It controls the flow of data to 

and from the main memory. 
• It sends and receives control signals from various peripheral devices. 
• It ensures that data reaches the correct place at the correct time. 
In brief, control unit acts as monitor that tells the other components what to do, when to 

do and how to do. 

(b) ALU (Arithmetic & Logical Unit) 
• The function of ALU is to perform the actual calculations in the computer. It 

performs arithmetic (addition, subtraction, multiplication & division) and logical 
(comparisons or decisions) calculations in the computer. 

• Under the control of the control unit, the data and instructions stored in the 
primary storage are transferred to ALU for processing. ALU performs the 
calculations and sends intermediate and final results to the main memory i.e. no 
processing is done in the primary storage unit. 

• In some computer processors, the ALU is divided into two distinct parts, the AU 
and the LU. The AU performs the arithmetic operations and the LU performs the 
logical operations. 

• ALU has internally two temporary registers into which the incoming data from 
memory is loaded and then operated inside ALU. 

(iv) Output Unit 
During data processing, computer process the data according to the instructions 

applied to it and produce the result or output. The output unit is used to provide the results 
to the user. The commonly used output devices are monitor or VDU (Visual Display Unit), 
printer, plotter, speakers etc. 

In brief, an output unit performs the following functions: 
• It accepts the results produced by the computer that are in binary form. 
• It converts these binary coded results to human acceptable form. 
• Finally, it supplies the converted results to the user. 
• It offers ample features to analyze data using charts, graphs, year-to-year 

comparisons and much more, with only the click of a button. 

□□□□□



 

2.5

Typical input devices are listed below: 
□ 
□ 

Keyboard 
Mouse 

□ 

□ Trackball □ 
□ Joystick a 
□ Light Pen □ 
□ Touch Screen □ 
□ Optical Mark Reader (OMR) □ 

 

Magnetic Ink Character Recognition (MICR) 
Barcode Reader Scanner / 
Image Scanner Digital 
Camera Microphone 
Graphic Tablet/Digitizer 

INPUT 85 OUTPUT 
DEVICES 

2.1 PERIPHERAL DEVICE 
A peripheral device is a device attached to a host computer in order to expand its 

capabilities. More specifically the term is used to describe those computer devices that are 
optional in nature and are not required in principle. 

Examples of some commonly used peripheral devices are Microphones, Cameras, 
Scanners, CD-ROM, DVD-ROM, Pen Drive, Modem, Network Card etc. The following 
section covers some of the basic peripheral devices used for input and output. 

2.2 INPUT DEVICES 
Input devices are those peripheral devices that are used to supply input to the computer. 

An input device converts input (data and instructions) into suitable binary form that can be 
accepted by the computer. 

The data entered through the input devices can be text, graphical image/symbol, audio, 
video etc. Depending on the form of the data the various input devices are available. 

2.2.1 KEYBOARD 

• Keyboard is the most common input device used for entering text data directly into a 
computer. 

• A computer keyboard is similar to that of a typewriter, but it has additional keys as well. 
• The most commonly available computer keyboard has 104 keys. Data is entered into a 

computer by pressing a set of keys available with the keyboard. 
• Keyboard is the oldest input device, which is still being used with the modern computers. 

When user presses a key, the corresponding character appears on screen. 
• Today, a multimedia keyboard contains various additional keys to perform functions like - 

volume control, launching Internet explorer, changing song and video tracks, launching e-mail 
software etc. 

• Wireless keyboards are also available today, but at a higher price than wired keyboard. These 
keyboards do not have any wire attached to them. 

• Wireless keyboard interacts with the computer through Bluetooth or Infrared technology. 
• Wireless keyboard operates on battery power rather than using electricity from the user's 

computer.
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Internal Microphone 

F1 through F12

Windows Key

Escape 
Key 

Scroll Lock 
Key 

Function 
Key 

Delete, Home, 
Page Up, Page 

Down, End 

Application Key

Fig. 2.1 (Keyboard)

Fig. 2.2 (Mouse)

2.2.2 MOUSE 
• Mouse is another popular input device used with modern computer. 
• It is basically a pointing device, which is used to provide input in graphic-usei interface 

(GUI) operating systems, like-Windows. 
• It is a small palm size box, which appears a bit like a mouse. 
• A simple mouse has a round ball at its base which senses the 

movement of mouse and sends the corresponding signals to CPU 
on pressing the buttons. 

• The mouse is represented on the screen in the form an arrow. 
This arrow is called a Cursor. Moving the mouse on your desk 
will move the arrow on the screen. 

• The mouse is usually attached to the computer system by using 
a wire. Wireless mouse is also available today that doesn’t have 
any wire attached to the computer system. 

• The main goal of any mouse is to translate the motion of your hand into signals that the 
computer can use. There are five simple techniques to use the mouse: Click, Double Click, 
Drag, Right Click, and Scroll. 

• A mouse allows us to create graphic elements on the screen, such as lines, curves and free 
hand shapes etc. 

• An optical mouse is an advanced computer-pointing device that uses light to detect 
movement rather than by interpreting the motion of a rolling sphere. 

• Optical mouse is more reliable and easy to use than simple ball mouse. Optical mice 
typically don't require a mouse pad and can be used on many surfaces, including those that 
are not entirely flat. 

2.2.3 TRACKBALL 
• A trackball is a computer cursor control device that is mostly used in notebook or laptop 

computers.  
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2.2.5 LIGHT PEN 

Fig. 2.5 (Light Pen)

• It is a specific style of computer mouse that allows the user to 
keep their hand and arm in one place, while manipulating a ball 
that moves the on-screen pointer. 

• It is a pointing device similar to the mouse except one difference 
that in trackball, the ball is fixed in a container that is placed on 
the desk. Fingers are used to rotate the ball and thus the cursor. 

• Track balls also have buttons like mouse. It is used to position the 
cursor at a specific locations and the input is supplied by pressing 
buttons attached with trackball. 

• A trackball requires less space than a mouse because there is no 
need to move the whole device i.e. the trackball is stationary so it 
does not require much space to use it. 

• The trackball mouse does not need a mouse pad or smooth surface underneath it to operate 
efficiently. 

• A track ball comes in various shapes like a ball, a button and a square. 
2.2.4 JOYSTICK 

• Joystick is another pointing device that has been designed to play games on the computer. 
• It is used to move cursor position on a monitor screen. 
• It consists of a small vertical lever (called a stick) mounted on the 

base that is used to steer the screen cursor around. Lever moves in 
all directions and controls the movement of a pointer. 

•  A joystick contains various buttons for various functions. The 
functioning of these buttons differs in different games. 

• With a joystick, the pointer continues moving in the direction Fi9- 2.4 

(Joystick) the joystick is pointing. To stop the pointer, you must 
return 
the joystick to its upright position. 

• Joysticks are also used in the industry to control the operations of 
computer driven machines like- huge cranes. 
Light Pen is another pointing device, which is similar to a pen. 
It is mainly used to draw pictures or lines on the monitor screen. 
The light pen contains a photocell and an optical system that is 
placed in the pen shaped small tube. Whenever this cell is 
brought closer to the screen, it senses the light coming from the 
screen and it generates the electrical pulses. These pulses are 
transmitted to a signal processor that identifies the particular 
pixel of the monitor, where the pen is touching. 

• The light pen is used for correction in architecture design, data collection, digital signature 
and computer-aided-design (CAD) applications. 

• In cricket matches, the commentators mark a portion of screen while explaining a particular 
area or the field set or a particular shot of a batsman in a cricket match. This is done with 
light pen.  
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Fig. 2.6 (Touch Screen)

Fig. 2.7 (Optical Mark Reader (OMR))

• Light pen based systems are common part of personal digital assistants (PDJ and hand-held 
computers. 

2.2.6 TOUCH SCREEN 
Touch screen is a special input device, which only needs a finger touch to supp: input to the 
system, rather than typing on a keyboard or pointing with a mouse 
Touch screens or touch screen panels are display 
overlays which have the ability to display and 
receive information on the same screen. 
Touch screens are the monitors with a special 
pressure sensitive screen that detects the touch of a 
finger on a particular point of screen. 
Simply touching and lifting the finger generates the 
action of single mouse click. Touching the screen twice, 
after a short interval generates the action of mouse 
double click and touching and moving finger without 
lifting it, generates the action of mouse dragging. 
The popularity of smart phones, PDAs, portable 
game consoles and many type of information 
appliances is driving the demand for touch screens. 
A typical application of touch screen is for selection of processing options th: are represented 
with graphical icons. 

2.2.7 OPTICAL MARK READER (OMR) 
• OMR is a special type of optical scanner, which reads presence or absence of mark made 

with pen/pencil. 
• OMRs are basically used in checking results of multiple choice tests in which tf answers are 

marked on a special pre-printed test scoring sheet (OMR Sheet) t darkening a small square 
or circle with a pen or pencil to indicate the corre< answer. 

• Optical Mark Readers are very economical devices and can read up to 1000 documents per 
hour. 

• OMRs use laser beam scanning technology. They focus a light on page beir scanned and 
detect the reflected light pattern from the darkened circles on tf paper sheet. 

• OMRs process huge volumes of data in a very short span of time. 
• The only disadvantage is that we have to design a very good quality OMR form 1 feed into 

the OMR device. A small change in the needs, leads to the change i the forms. 
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Fig. 2.8 (Magnetic Ink Character 

Recognition (MICR)) 
 

2.2.8 MAGNETIC INK CHARACTER RECOGNITION (MICR) 
• Magnetic Ink Character Recognition (MICR) is a character recognition system that uses 

special ink and characters. 
• When a document that contains this ink needs to be 

read, it passes through MICR machine, which 
magnetizes the ink and then translates the magnetic 
information into characters. 

• MICR technology is used by banks. Numbers and 
characters found on the bottom of cheques (usually 
containing the check number and account number) are 
printed using magnetic ink. 

• To print magnetic ink characters, we need a laser 
printer that accepts MICR toner. MICR reads data on 
cheques and sorts them for distribution to other banks 
or for further processing. 

• The main advantage of MICR is that it is fast and less 
error prone. 

2.2.9 BARCODE READER 
• Barcodes are made up of bars (lines or stripes) of different widths that convey numeric 

information about the products. 
• Barcode reader is a type of handheld scanner that is widely used to read the barcodes printed 

on products. By reading a barcode, all the required information about a product is directly 
transferred into computer. This way, there is no need to type the name, price, size and 
weight of the product. 

• A barcode reader consists of a scanner, a decoder and a cable used to connect the reader with 
a computer. 

• A barcode reader works by directing a beam of light 
across the bar code and measuring the amount of 
light that is reflected back. The scanner converts 
the light energy into electrical energy, which is then 
converted into data by the decoder and forwarded to 
a computer. 

• The use of barcode reader is increasing day by day. 
It is being used in business for point Fig. 2.9 (Barcode 

and Barcode Reader) of sale management. Thus selling 
items can 
be identified quickly and reordered automatically. It has now started to be used in large 
libraries for the management of books. 

2.2.10 SCANNER/IMAGE SCANNER 
• Scanner is a very popular input device, which works more like a photocopy machine. 
• They are mainly used to transfer printed or handmade 

pictures, photographs and text- document into computer. 
• It simply translates a paper document into digital image 

format that can be stored in a computer. The stored 
images can even be altered and manipulated in 
interesting ways, if the computer has image- processing 
software
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Fig. 2.12 (Digital Camera)

Fig. 2.13 
(Microphone

• Every scanner has a variety of specifications, including resolution, color deptI and speed. 
These specifications will help you determine the best use 
for the scanner. 

• A Flatbed scanner is like photocopy machine consisting of a 
box having a glass plate on its top and a lid that covers the 
glass plate. A document to be scanned is placed upside 
down on the glass plate. 

• A handheld scanner is a small manual scanning device which 
is moved over the object that needs to be scanned. 

• To scan a document, the scanner is dragged slowly 
over it from its one end to the other end with its light on

 
Fig. 2.11 (Handheld Scanner) 

• They are much cheaper than flatbed scanners. One of the most utilized handheld scanners 
is the barcode scanner, typically used in shopping stores to valuate goods. 

2.2.11 DIGITAL CAMERA 
• Digital Cameras are the latest type of cameras, which records and stores photographic 

images in digital form. These pictures can be easily transferred to computers at any time. 
• Many current models of digital cameras are also 

capable to capture sound or video, in addition to still 
images. They are equipped with qualities like high 
resolution and zooming. 

• The number of photographs that a camera can shoot 
depends on the memory capacity of the camera. 

• Kodak, Canon, Sony, Nikon, Olympus and several other 
companies make digital cameras. 

• Web Cameras are also a type of cameras that can be 
used after attaching therr with the computers. They 
are used for video-conferencing and movie making. 

2.2.12 MICROPHONE 
• Microphone is the commonly used audio input device in computers. It is used tc amplify or 

record the sounds using computers. 
• These are the devices that transfer sound inputs to the computer. 
• Microphone is connected to the sound input socket of the sound 

card of computers. 
• Modern motherboards have in-built sound chips. In such case, the 

microphones are attached to the motherboard. 
• Microphones are becoming very common due to the trend of 

chatting and video conferencing. 
• The signals produced by microphone are sent to the sound card of 

your computer. This card converts these analog sound signals into 
digital signals. 

2.2.13 GRAPHIC TABLET/DIGITIZER 
• A graphics tablet or digitizer is a computer peripheral device that 

allows for i
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graphics or art into a 

Fig. 2.14 (Graphic Tablet)

relatively simple method of inputting hand-drawn computer 
in real time. 

• Graphic designers mainly use graphic tablets to create and 
edit line art pictures. 

• It converts analog information into a digital form. 
• It contains a pressure sensitive pad and a pen that is 

attached to the system unit. The pad can recognize the lines 
drawn on it with the pen and produces the output on the 
computer. 

• When the stylus is moved, a cursor on the CRT screens 
moves simultaneously to provide visual feedback. 

• These can be used as an input device where drawings are required from end users. 

2.3 OUTPUT DEVICES 
The devices that produce output or result after processing of data values are called as output 

devices. We have different output devices for the different types of outputs. 
Depending upon the type of output produced, the output devices may be categorized into two 

broad categories: 
(i) Softcopy output (ii) Hardcopy output 
(i) Softcopy Output: A type of output that is available to the user till the computer is switched 

on. This output goes off as soon as we switch off our computer. 
Example: The data displayed on the screen of monitor is available till the computer is switched 

on & similarly the songs can be heard from the speakers till the computer is switched on. 
A softcopy output device can be further classified as: 
(a) Computer monitor (b) Speakers 
(ii) Hardcopy Output: It is the permanent type of output, which is available on paper in art 

form. 
Example: A printed report even if our computer is switched off. 
A hardcopy output device can be further classified as: 
(a) Printer (b) Plotter 

2.3.1 COMPUTER MONITOR 
• A monitor (sometimes called a visual display unit) is a softcopy output device that produces 

output in the form of a picture on the screen. 
• It is just like a television screen usually used to see programs on a computer. 
• The main difference between a monitor and a television is that a monitor does not have a 

television tuner to change channels. 
• A monitor may be used to watch television if it is connected to a device, called television 

tuner card (TV Tuner Card). 
• The monitor immediately displays the text & graphics as you create them 8s reflect changes 

to them as you perform. 
• At present, computer monitors are available in a variety of shapes, designs and colors. 

However, based on the technology used in the making of computer monitors, they can be 
broadly categorized into following three types: 
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Fig. 2.16 (CRT Monitor)

Fig. 2.17 (LCD Monitor)

(i) CRT MONITOR 
• The monitors that use cathode ray tube for producing 

the output are known a CRT Monitors. 
• In CRT monitors, a cathode ray tube is used as the 

picture tube of the monitor. 
• In CRT monitors, cathode ray tubes are glass 

vacuum tubes into which an electron gun emits a 
flow of electrons guided by an electrical field towards 
a screen covered in small phosphorescent elements. 

• The screen of this tube is divided into rows and 
columns. So, the intersection of rows and columns 
makes a cell and that cell is called a Pixel. 

• The number of pixels per unit area of the screen is 
called Resolution. More the resolution, more clearly 
will be the picture. 

• The image seen on the monitor screen is made up of 
thousands of pixels. The distance between individual pixels 
is called DOT PITCH. 

• The CRT monitor comes in 15-inch to 21-inch sizes (38 — 53 
cm) and even larger. Screens are measured diagonally from 
corner to corner, including the case. 

• CRT monitors are considerably heavier than other types 
and use lots more power than Plasma or LCD displays. 

(ii) LCD MONITOR 
• The monitors, which use liquid crystals for producing the 

image, are known as LCD monitors. 
• The cathode ray tube is large in size so it can’t be fitted in 

small sized computers like laptops. For these devices, a 
compact output device is needed to produce the output on 
screen. The screen used in these devices is LCD screen. 

• LCD screen produces the image by aligning molecular 
crystals. These crystals are packed in two screens. 
The front screen is transparent & back screen is reflective. 
The back screen reflects the light towards the front screen, 
which produces images on the front layer. 

• The main advantage of LCD monitors is that they take up 
less desk space, lighter in weight and safer to human eyes as 
it does not flicker. 

• LCDs use only one-third to one-half the electricity of their CRT counterparts. 
• An LCD monitor comes in standard sizes from 15-inches to 21-inches, and larger. Screens 

are measured diagonally from corner to corner, including the case. 
• LCDs are used in a wide range of applications, including computer monitors, television and 

instrument panels etc. They are common in consumer devices such as video players, gaming 
devices, clocks, watches, calculators, and telephones.  
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Fig. 2.19 (Speakers)

(iii) TFT MONITOR 
• The thin film transistor or the TFT screen is commonly used interchangeably with the LCD 

monitors, but there is a difference between the two. 
• The TFT screens for the computer monitors are also used in 

the LCD screens. It is an upgrading of the technology that is 
being used in the computer. 

• The thin film transistor monitors are usually used in the 
Laptops and they are much more sensitive than the LCD 
monitors. 

• They are also better as far as resolution is concerned. 
They have much better resolution than the LCD Fig. 2.18 (TFT 

Monitor) monitors. 
• The benefit of a TFT monitor is a separate, tiny transistor for each pixel on the display. 

Because each transistor is so small, the amount of charge needed to control it is also small. 
This way, the display gets refreshed several times per second, ensuring great visual clarity. 

• A TFT monitor delivers crisp text, vibrant color and an improved response time for 
multimedia applications. 

• TFT monitors are ideal for games, video displays and everything involving multimedia. 
2.3.2 SPEAKER 

• Speakers also produce softcopy output in the form of sounds. 
• Speakers are used to play sound in computers. They may 

be built-in or externally connected to your system. 
• Speakers allow user to listen to music and hear sound 

effects and spoken text using computer. 
• Speakers convert the digital signals coming from 

computer to analog sound waves. 
• Computer speakers range widely in quality and in price. 

The computer speakers typically packaged with 
computer systems are small, plastic, and have average 
sound quality. Some computer speakers have 
equalization features such as bass and treble controls. 

• A personal computer generally contains 200 to 500 watts 
speakers, which can produce sound output for a small room. To cover a bigger area, amplified 
speakers and woofer systems are used. 

• Laptops come with integrated speakers. Restricted space available in laptops means these 
speakers usually produce low-quality sound. 

2.3.3 PRINTER 
• Printers are the most important output devices, which produce hard copy output on different 

types of papers i.e. printers are used to print information on papers. 
• Printed documents are essential in many working environments, where people share reports, 

budgets, memos and other type of information. 
• Today, wireless printing technology makes the task of printing from a Notebook computer, 

PDA, Digital camera, or Smart phone much easier. 
• Two common wireless technologies for printing are Bluetooth and Infrared.
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• With Bluetooth printing, a computer or device transmits output to a printer v radio waves. 
The computer and devices do not have to be aligned with eac other; rather, they need to be 
within an approximate 30-100 foot range. 

• With infrared printing, a printer communicates with a device using infrared ligl waves. 
• Some important factors generally considered while purchasing a printer are: 

(a) Speed of the printer 
(b) Image quality / Resolution of the printer 
(c) Cost of operation 

• The speed of printer is either measured in character per second (CPS), lines p< minute 
(LPM) or pages per minute (PPM). 

• A printer can be broadly classified into two categories: 

 

2.3.3.1 IMPACT PRINTERS 
Those printers, which print by touching the print head to paper, are called Impa printers. That is 

in impact printers, different characters print on the paper with th impact of hammer. The impact 
printers are further divided into character printers an line printers. These printers use typewriter like 
mechanism to print the output. 
2.3.3.1.1 Character Printer 

• Character printers are also called Serial Printers. These are the printers, whic print one 
character at a time in a serial order. 

• In this type of printer, the print head moves across a line while printing th characters. 
• The speed of the character printers ranges in 100 to 300 characters per secon (CPS). 
• The advantage of character printer is that they are low cost and are mainly use with 

personal computers. 
• The disadvantage is, it is low speed and makes lot of noise while printing. 
• Today, these printers are rarely used because of speed issues and because on! text is capable 

of being printed. 
• Character printers are of two types: 

i. Dot matrix printer 
ii. Daisy wheel printer  

(i) Impact printer. 
(ii) Non Impact printer. 

 

Fig. 2.20 (Printer Hierarchy) 
An impact printer can be further divided into character printer and line printe whereas a non-impact 
printer can be further divided into line printer and page printer. 
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Fig. 2.21 (Dot matrix printer)

the range of 100 to 300 

Fig. 2.22 (Daisy wheel printer) 

—

2.3.3.1.1.1 Dot Matrix Printer 
• It is one of the most widely used printers. The head of these printers contains a matrix of 

dots or pins or hammers, that’s why these printers are 
named Dot matrix printers. 

• Pins or hammers of dot matrix printer are arranged in 
rows and columns. Generally a dot matrix printer has 9 or 
24 pins in its head. 

• A character is printed by striking the appropriate number 
of pins against the printer head. 

• Due to the continuous striking of the pins on paper, these 
printers produce a lot of noise. 

• These printers have lowest running cost. Dot matrix 
printer’s ribbon costs around 20 rupees and gives you 1000 
prints. 

• The speed of a dot matrix printer is generally in characters 
per second. Due to least cost of per print, the dot matrix printers are widely used in banks, 
organizations etc. 

• These printers are specially used to print characters only; they can print images but the 
quality of print of the image is not so good. 

2.3.3.1.1.2 Daisy Wheel Printer 
• It is an uncommon character printer. It uses a circular 

printing mechanism, called a Daisy wheel. 
• The head of this printer is in the shape of a flower. 
• A motor spins this wheel at a rapid rate. When the 

desired character is brought forward by spinning the 
wheel, a print hammer strikes it to produce the output. 

• Daisy wheel printers have low speed, ranges from 10 to 50 
characters per second. 

• These printers have a defined type and set of characters 
and they can print the defined characters and shapes 
only. No new shapes can be generated. 
That means you cannot print different fonts in this 
printer. 

• Daisy-wheel printers cannot print graphics, and in 
general they are noisy. 

• Daisy-wheel technology is now found only in some 
electronic typewriters. 

2.3.3.1.2 Line Printer 
• As character printers can print only one character at a time, line printers print a line in one 

printing cycle, i.e. it prints one line at a time. 
• They are mostly associated with the early days of computing, but the technology is still in 

use. 
• The line printer is typically enclosed in a cabinet that completely seals the unit from the 

outside world. 
• The speed of line printers ranges from 250 to 2500 lines per minutes. 
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2.3.3.1.2.1 Chain Printer 
• Chain printers are the line printers that contain a moving chain called as the print chain. 
• The chain rotates and when the desired character comes, hammer strikes the chain. This 

action presses the paper against a ribbon and against the character located at that 
position. The result leaves an impression of the character. 

 

• When the requirements of the printed line are fulfilled, the printer carriage control I moves 
the page to the next line position. 

• The chain contains multiple copies of characters to increase the speed. More is | the number 
of characters on the chain, lesser are the chances of full circle (' rotation of the chain, after 
printing a character. 

• The chain printers can print at a speed of 400 to 2500 lines per minute. 
2.3.3.1.2.2 Drum Printer 

• A drum printer is a type of line printer that prints by striking the paper against the inked 
ribbon. 

Fig. 2.24 (Drum printer) 
• This printer uses a cylindrical drum that has 
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Fig. 2.25 (Inkjet printer)

• Print hammers are located above the paper, opposite to each band of the drum. These 
hammers strike the paper, along with the inked ribbon when the proper character on the 
drums comes at the printing position. 

• The disadvantage of drum printers is that they take much time to position the characters, 
which degrades their performance. 

• Drum printers have a speed of 300 to 2000 lines per minute. 
2.3.3.2 NON-IMPACT PRINTERS 

Non-impact printers print without any physical contact with the paper. The printers belonging 
to this category generally print by using heat, pressure or laser technology. 

Non-impact printers have greater resolutions and speed as compared to impact printers. The 
most important property, which is not available in impact printers, is that they can print colored 
outputs. The most commonly used non-impact printers are Inkjet printer (Line printer) and Laser 
printer (Page printer). 
2.3.3.2.1 Inkjet Printer (Line Printer) 

• These printers contain cartridges of liquid ink. Separate cartridges are used for black and 
colored inks. These cartridges are arranged in a print head that contains tiny holes to spray 
the ink. 

• When the print command is fired, the printer sends 
information signals to printer-head. By using these 
signals, the head sprays ink drops on the paper. 

• The ink of the inkjet printer is manufactured in such a 
manner that the paper quickly absorbs it. 

• These printers are considered as best printers to be 
used with personal computers. 

• They offer good quality in lesser cost. 
• Inkjet printers are capable of printing photo quality 

images. 
• The speed of these printers ranges from 6 to 20 pages per minute. 
• It needs only 3 or 4 primary colors to create thousands of colors. 
• The initial cost of these printers is very low but running cost of these printers is very high, as 

their cartridges cost a lot. 
2.3.3.2.2 Laser Printer (Page Printer) 

• Laser printers are the other popular type of non-impact printers, which use laser and 
heating technologies to print. 

• The main advantage of laser printer is speed. It can print one page at a time. That’s why it is 
also known as page printer. 
Laser printers provide a combination of high speed and 
best quality along with very low cost of printing. 
In laser printers, a head fires a laser on the drum to draw 
an inverted image on the paper. After this the paper is 
passed through a heater, which fixes the ink on the paper. 
The speed of laser printers ranges from 12 to 25 pages per 
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Fig. 2.27 (Drum plotter)

hundred prints depending upon the type of the prints, the laser printer cat produce 
thousands of prints from a single toner of dry ink. 

• The standard resolution in most laser printers today is 600 dots-per-inch (dpi) This 
resolution is sufficient for normal everyday printing including small desktof publishing 
jobs. 

2.3.4 PLOTTER/GRAPHIC PLOTTER 
• Plotter is an output device that draws pictures on a large piece of paper. 
• Plotter is a very versatile tool. It is sometimes confused with a printer, but a plotter uses 

line drawings to form an image instead of using dots. 
• A common type of plotter is one that uses a pen or pencil to draw lines on paper. 
• It may be a component that is added to a computer system or it may have its own internal 

computer. 
• Multicolor plotters use different-colored pens to draw different colors. 
• Plotters are mainly used to print maps, layouts, banners and reports that are very large in 

size. 
• The main advantage of plotter is producing line drawings with a very high degree or 

accuracy. 
• In general, plotters are considerably more expensive than printers. 

• They are used in engineering applications where precision is mandatory. 

• A Plotter can be mainly categorized into two types: 
(i) Drum plotter (ii) Flatbed plotter 

2.3.4.1 Drum Plotter 
• The drum plotters contain a drum on which the paper is 

rolled. 
• The impression is generated by moving the paper up and 

down. 
• The plotter consists of one or more pen holders mounted 

horizontally across the drum. 
• The pens can move to produce horizontal motion. The pens 

having ink of different colors can be mounted in different 
holders to produce multi-colored designs. 

• The drum plotters make more noise than flat bed plotters. 
• The drum plotters are more compact than flat bed 

plotters. 
2.3.4.2 Flatbed Plotter 

• The flatbed plotters are horizontally aligned with a flat 
surface to which a piece of paper is attached. 

• The paper remains stationary and the printer moves 
pens across the paper to draw the image. 

• The pens with ink of different colors are used for 
multi-colored plotting. 
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MEMORY 

3.1 COMPUTER MEMORY 
Memory is the storage area of computer where all the inputs (data as well as instructions) are 

stored before processing and the outputs are stored after processing of inputs. 

As there can be many input devices attached with a computer, all these devices may supply 
input at a time but the CPU may not be able to process all the inputs in one go. Therefore, a place 
is required to queue up these inputs and then process them one by one. All these inputs are 
queued up in the memory. The same case is there with the outputs produced by the CPU. If the 
output device is busy in producing an output, the other outputs are queued up in the memory. 

The memory of a computer can be divided into two broad categories: 
(i) Primary storage/Internal memory (ii) Secondary storage/External memory 

3.2 PRIMARY STORAGE 
Primary storage, also known as main storage or main memory or internal memory is a direct 

access storage device, consisting of a number of storage locations. Each location in the storage has 
a unique number, called Storage Address. The system assigns a unique memory location to each 
data element. Once the data element is assigned to the location, the system accesses it directly by 
means of the address of the particular storage location. 

The various types of primary storage are: 
(i) RAM (Random Access Memory) 
(ii) ROM (Read Only Memory) 

(iii) CACHE Memory 
(iv) Virtual Memory 

3.2.1 RAM (RANDOM ACCESS MEMORY) - VOLATILE MEMORY 
Whenever user enters any kind of data into the computer system, it moves into primary 

memory for Storage. This type of primary memory is known as RAM. It is the ! most randomly 
access storage type among all types of storage. The main features of RAM j are: 

• The word “random” refers to the fact that any piece of data can be returned quickly, and in 
a constant time, regardless of its physical location and whether or not it is related to the 
previous piece of data. 

• RAM is volatile in nature i.e. once the system is switched off, the contents of RAM will 
automatically be erased. 

• RAM stores the data purely on temporary basis i.e. user can remove the previous data and 
write new information into it whenever required. 

• RAM is small, both in terms of its physical size and in the amount of data it can hold.
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• Every computer application demands a particular amount of memory from Rr in order to 
execute. 

• All kinds of displays on the display device (monitor) will be possible because RAM i.e. if we 
remove the RAM chip from the system then there will be display on the monitor’s screen. 

• RAM is also referred as read and write memory of the computer i.e. user can re the data from 
RAM as well as write the data into RAM. 

• A small amount of RAM is also integrated with the CPU, but this is usue referred to as 
“Cache Memory”, rather than RAM. 

• RAM is a semiconductor memory so it is very costly. Still many people use lai amount of 
RAM in order to increase the speed of the computer. 

• The disadvantage of RAM over physically moving media is cost and the loss data when 
power is turned off. 

• The storage capacity of RAM varies. Today, it is available in Megabytes (M (Like - 512MB) 
and also in Gigabytes (GB) (Like - 1GB, 2GB, 4GB. 8GB). 

 

> Types of RAM 
There are mainly two types of RAM: 
(i) Static RAM (ii) Dynamic RAM 

(i) Static RAM 
• The word “static” indicates that the memory retains its contents as long power remains 

applied, unlike dynamic RAM (DRAM) that needs to periodically refreshed. Data are lost 
when the circuit gets powered dow however, which makes static RAM a volatile memory. 

• The Static RAM consumes more power. There are six transistors needed to for a memory 
cell of static RAM. 

• Static RAM is more expensive and holds less data than dynamic RAM. 
(ii) Dynamic RAM 

• The term “dynamic” indicates that the memory must be constantly refresh because 
Dynamic RAM (DRAM) loses its stored information in a few millisecon even though its 
power supply is ON. 

• It stores information in the form of charge on a capacitor, which leaks away in very short 
time. Therefore its contents must be periodically refreshed after eve two milliseconds. 

• The Dynamic RAM consumes less power and is cheaper than the Static RAM. 

3.2.2 ROM (READ ONLY MEMORY) - NON-VOLATILE MEMORY 
ROM is "built-in" computer memory also known as Firmware. Instructions that a 

required all the time in the system for running the computer are stored in the ROM.

Fig. 3.1 (Random Access Memory - RAM Chip) 
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• It consists of small chip located near CPU on 
the motherboard. 

• It is the read only memory i.e. user can only 
read the instructions but cannot write into it. 

• The instructions stored in it are permanent in 
the nature and are usually designed by the 
manufacturer of the computer. 

• ROM is non-volatile in nature i.e. data does not 
get erased when the computer’s power is 
switched off. 

• Instructions that are stored in the ROM, execute as soon as the computer is 
switched on. For example: when we switch on the system all the instructions stored
in the ROM load and get executed automatically and make the system ready to 
load the operating system in the memory. 

• The memory organization of ROM is exactly the same as that of RAM. 
• ROM chips are used not only in computers, but in most other electronic items as 

well (like: calculator). 
• In ROM, it is not possible to randomly select and store the information. 
Types of ROM 

Fig. 3.2 (ROM- Chip)
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There are mainly three types of ROM: 
(i) PROM (Programmable Read Only Memory) 
(ii) EPROM (Erasable Programmable Read Only Memory) 

(iii) EEPROM (Electrically Erasable Programmable Read Only Memory) 

(i) PROM (Programmable Read Only Memory) 
• It is also the read only memory like ROM. The only difference between ROM and

PROM is that the instructions in ROM are designed by the manufacturer of the
computer where as in PROM, the instruction are programmed by the user himself
according to his requirement. 

• PROM is also known as one-time programmable non-volatile memory. 
• In PROM, user can design the instructions only for once; he cannot change the

instructions later whenever required. 
• The major disadvantage of PROM is that a shock of electricity can easily cause

fuses in ROM to burn out thereby corrupting the PROM. 
(ii) EPROM (Erasable Programmable Read Only Memory) 

• Although, PROM is not a flexible memory, as the instructions in it cannot be
changed. EPROM is designed to overcome the drawback of PROM. 

• In EPROM, the user can program the instructions himself according to his
requirement and later on, he can also erase the instructions by using Ultra-Violet
R (UV R ) d  th   i t ti  i  it  
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(iii) EEPROM (Electrically Erasable Programmable Read Only Memory) 

• It is also the read only memory and user can program /reprogram th instructions 
according to his requirement, but here the instructions will b reprogrammed through 
special electrical pulses. 

• EEPROM such as Flash memory allow the entire ROM to be electrically erase 
then written to without taking them out of the computer. 3 

• In EEPROM, user can electrically erase a portion of the contents of the ROW This is 
very important in situations where minor changes to the ROM content! are needed. 

3.2.3 CACHE MEMORY 
The processor accesses the main memory to read the instructions. The speed which the 

processor executes the instructions is much faster than the speed at whidj- the instructions are 
transferred from the main memory. In order to make it compatible a small very high-speed 
memory is used between main memory (RAM) and processor. This 
type of memory is called Cache Memory/Buffers. Some of the main 
features of Cache memory are: 

• Cache memory is small, fast and expensive type of storage 
that is placed between the CPU and the main memory. 

• The CPU transfers the instructions from the cache memory 
towards its processing area at the very high speed, thus it 
improves the processing speed. Hence, instead of every 
time reading from the main memory, now CPU first check 
the cache memory for the required data and if CPU finds 
the data there, it is called Cache Hit and if the required data 
is not present in cache, 
CPU then reads it from main memory. This state is called 
Cache Miss. 

• The advantage of cache memory is that the CPU does not 
have to use the motherboard’s system bus for data transfer. 
Whenever data must be passed through the system bus, 
the data transfer speed slows to the motherboard’s 
capability. The CPU can process data much faster by 
avoiding the bottleneck created by the system bus. 

• Cache memory is random access memory (RAM) that a 
computer microprocessor can access more quickly than it can access regular RAM. As 
the microprocessor processes data, it looks first in the cache memory and if it finds the 
data, it does not have to do the more time-consuming reading of data from larger 
memory. 

• Initially the cache memory is empty. When CPU access data from main memory it 
places a copy of it in cache memory. This process continues for each access to main 
memory. When cache memory becomes full, then the new data will be stored by 
replacing some existing information using a FIFO (First In First Out) algorithm. 

• Cache memory is not addressable by the user of the computer system. Its purpose is to 
look ahead and to provide the CPU with currently needed information. 

• Cache memory makes main memory appear to be faster and larger than it really 
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(Virtual Memory) 

Fig. 3.4 (Virtual Memory)

• It is very expensive as compared to the main memory and hence its size is normally very 
small. 

• Today, cache memory is embedded with the processor of the system and normally 
processor provides up to 4MB of cache memory, but we can also upgrade the cache 
memory of the system by introducing external cache memory. 

3.2.4 VIRTUAL MEMORY 
When the computer is to process a large amount of data, some times the size of main memory 

or RAM becomes inadequate or not sufficient to store that data. To overcome this problem the 
technique of virtual memory is used. 

In this case, operating system approaches to the secondary storage (hard disk) and borrows 
the required amount of memory from it and utilizes it as a main memory or RAM for processing 
the data. This borrowed or shared memory is called virtual memory. 

When virtual memory is being used, the system allows the users to carry on working without 
worrying about the availability of data storage or memory saturation. It is often addressed as 
logical memory and allows users to access a larger volume of memory, allowing them to use more 
applications simultaneously. 
3.2.5 RAM Vs. ROM 

RAM ROM 
• Information stored and retrieved 

anytime. 
• Information is permanently stored. 

• Volatile storage. • Non-volatile storage. 
• It is read / write memory. • It is read only memory. 
• Information can be altered. • Information can not be altered. 
• It is possible to randomly select and 

store the information. 
• It is not possible to randomly select and 

store the information. 

• Execution speed depends upon the 
capacity of RAM. 

• No such dependency. 

• RAM allows the computer to read data 
quickly to run appli-cations. 

• ROM stores the program required to 
initially boot the computer. 

• The two main types of RAM are static 
RAM and dynamic RAM  

• The types of ROM include PROM, EPROM 
and EEPROM  
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external memory is used to store the data permanently. The user can access the data from 
secondary storage whenever required. The secondary storage devices offer huge storage 
volumes with high speed and reliability. 

The various types of secondary storages are: 
• Magnetic storage 
• Optical storage 
• Solid state storage 

3.3.1 MAGNETIC STORAGE > 
A storage medium, in which different patterns of magnetization are used to represent 

stored bits or bytes of information, is called magnetic storage. Magnetic storage consists of: 
(i) Magnetic tape (ii) Magnetic disk (a) 

(i) Magnetic Tape 
Magnetic tapes provide a compact and inexpensive method of storing data and 

programs. Magnetic tapes are mainly used for backup of data. The main features of a 
magnetic tape are: 

• Magnetic tape is half-inch wide tape of Mylar material, coated with magnetic 
material. 
Magnetic tapes have much higher data transfer rate and are preferred for highspeed 
applications. 
Magnetic tape is as same as playing an 
audio cassette in a tape recorder. 
Whenever we like to hear a particular 
song from an audio cassette, we need to 
rewind or forward the tape for that 
particular song. 
Data is stored as binary digits (i.e. 0 and 
1) in magnetic tape, which represents the 
presence and absence of magnetic 
field. Fig. 3-5 (Ma9netic Tape) 

• Magnetic tapes are portable in size i.e. we can carry this storage device easily from one 
place to another. 

• Magnetic tape is reversible i.e. data can be erased from the tape and new data can 
be stored onto it. 

• It is a multipurpose medium i.e. it can be used for input, output and storage. 
• Magnetic tape is very economical device. 
• The life of magnetic tape is very high as compared to some other storage devices. 
• Magnetic tape is sensitive to dust, temperature, moisture and other environmental 

factors. 
(ii) Magnetic Disk 

Magnetic disks are the most popular medium of data storage in these days. It is like a 
gramophone record, which is made up of plastic like material called Mylar. 

Th  i  f  f  i  di k  
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• Data is randomly stored and retrieved from these disks i.e. the drive can access any 
portion of data directly. 

• To store data on magnetic disks it should be formatted. Formatting is a process of 
creating tracks and sectors on the surface of disk so that the data can be stored. 

• Tracks are concentric circles and Sectors are the portions created by dividing the disks into 
number of portions. These sectors are often grouped into clusters. 

> Types of Magnetic Disk 
On the basis of read/write mechanism, the magnetic disks are classified into two types: 
(a) Floppy disk/Removable disk, (b) Hard disk/Fixed disk. 

(a) Floppy Disk / Removable Disk 
Floppy disk is one of the most popular data storage medium, used for permanent data 

storage and data transfer before the invention of compact disks. The floppy disk was 
introduced by IBM in 1972. Floppy disk basically consists of a round, flat piece of plastic, 
coated with a magnetic material. The main features of a floppy disk are: 

• The two principal sizes or dimensions of floppy disk are 3.5 inch and 5.25 inch. 
• Floppy disks are portable i.e. we can easily carry this storage device from one place 

to another for data storage. 
• Floppy disks are slower to access than hard disks and 

have less storage capacity. 
• Data stores on a floppy disk in tracks, which is further 

divided into small segments, called sectors. 
• The storage capacity of a 3.5-inch floppy disk is 1.44 

MB and 5.25 inch floppy disk is 1.2 MB. 
• Floppy disks are reusable i.e. we can write the new 

data on a floppy disk after erasing the previous one;. 
• Floppy disks allowed sequential as well as random 

access of data. 
• Floppy disks were not very much durable. It could be 

used for 3-4 times only. People used to carry same 
data in multiple floppies so that in case of damage of 
one floppy, the other one could be used. 

• Floppy disk is sensitive to dust, temperature, moisture and other environmental 
factors. 

(b) Hard Disk/Fixed Disk 
Hard disk is another type of magnetic disk on which we can store data and information 

permanently. IBM (International Business Machine) invented hard disk in 1957. 
Initially, they were called fixed disks and later they were named hard disks. 

A hard disk contains a number of platters of aluminum coated with magnetic material. 
Each of these platters is divided into tracks and sectors. All the platters are arranged on a 
spindle. This spindle is attached to a motor that can rotate at a speed of 5600 rotations per 
minute (rpm) or 7200 rpm. The main features of hard disk are: 

• Hard disks hold more data than floppy disk. Its storage capacity comes in Gigabyte 
(GB) and now also in Terabytes (TB). (1 TB=1024 GB) 

• Hard disk stores the data permanently. 
• To store data on hard disks, it should be formatted. Formatting is a process 
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Fig. 3.7 (Hard Disk)

creating 
tracks and 
sectors on the 
surface of 

hard 
disk so 
that 

the data can 1 
stored. 

• Tracks are concentric circles and Sectors are the portions 
created by dividing tl disks into number of portions. 

• Hard disks are enclosed in a sealed container. The hard disk is 
a non-removal form of storage device but nowadays removable hard disk (external 
hard disk) also available. 

Ribbon Cable 
(attaches 
heads to Logic 
Board) 

• Hard disks are faster in use than floppy disks i.e. the different data operation like- 
cut, copy, paste etc. are performed at a higher speed than floppy disk o any other 
magnetic storage device. 

• Hard disks are more reliable than floppy disks because they are generally fitter 
inside the cabinet of the computer (internal hard disks), so they remaii protected 
from external environmental factors like- dust, temperature etc. 

• Hard disks are less portable than the floppies, although it is possible to bu; 
removable hard disks. A removable hard disk is enclosed in a plastic box, so tha 
they can be removed like floppy disk. 

• Hard disks generally offer quicker access to data than floppy disks. 
• Hard disks offer very low cost of data storage. Today, we can purchase a 500 GI 

hard disk for around 1800 rupees. 
• A hard drive needs to be periodically defragmented, where the computer re 

organizes all of what is written on the drive surface for optimized performance.
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3.3.2 OPTICAL STORAGE 
With the advancement in technologies, such type of storage devices came in the 

market, which has more storage capacities and used optical or light technology, to store or 
retrieve the data. These kinds of storage devices are known as optical storage devices. 

Optical storage devices are non-volatile i.e. they retain their contents if power supply is 
off. In such devices, data is recorded by making marks in a pattern that can be read back 
with the aid of light, usually a beam of laser light precisely focused on a spinning disk. 

Advantages of Optical Storage: • 
• It offers very high storage capacity. 
• It offers very high data density. 
• It has very compact size. 
• It has very low cost. 
• It stores data permanently, i.e. non-volatile in nature. 
• It offers a considerable resistance to environmental factors like heat, dust and moisture. 
• With proper care, optical media can last a long time, depending on what kind of optical 

media we choose. 
• It provides random access of data. Optical media provide the capability to pinpoint 

a particular piece of data stored on it, independent of the other data on the volume 
or the order in which that data was stored on the volume. 

• Optical storage on the system provides an economical and efficient way to store 
and retrieve large amounts of information at a high performance level. 

• The capacity, price, and performance of optical storage continually improve, and 
IBM remains committed to providing its customers with these improvements over 
time. 

• Optical storage is any storage method that uses a laser to store and retrieve data 
from media. 

> Types of Optical Storage 
(i) CD-ROM (Compact disk read only memory) 
(ii) DVD (Digital versatile disk or Digital video disk) 

(i) CD-ROM (Compact Disk Read Only Memory) 
A CD-ROM is a round disk coated with very thin reflective layer of aluminum. CD- 

ROM has a spiral track of data from inside to outside direction of the disk. The main 
features of a compact disk are: 

• It is capable of storing large amounts of data. A typical CD can store data unto 
700MB. 

• The vendor stamps CD-ROM’s and once stamped, they cannot be erased or filled 
with new data. 

• To read a compact disk, you need a CD-ROM player. We can load any type of CD 
into any CD-ROM player. 

• CD-ROM player also known as a CD-ROM drives a device that can read 
information from CD-ROM. 

• Compact disk is more reliable than floppy disk and higher data processing speed 
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Fig. 3.9 (Digital Versatile 
Disk)

• The performance of a CD-ROM depends upon the number 
of rotations it can ts in a second. More number of rotations 
more is the data transfer rate and lesser the access time. 

• CD’s of 4x, 8x, 16x, 32x, 48x, and 52x are available in the 
market. Here, ‘x’ means rotations per second i.e. 52x 
means a CD can rotate at a speed of 52 times in a second. 

• A CD-ROM can be further classified as: 
(a) WORM Disk 
(b) CD-Recordable (CD-R) 
(c) CD-Rewritable (CD-RW) Fig. 3.8 (Compact Disk 

(a) WORM DISK 
o Compact disks that can be written only once and can be read for many timi are 
called as WORM disks (Write once read for many), o We use a device called CD-ROM 
drives to read the data from a CD and CJ Writer to record and re-record (write and 
rewrite) a CD. o The audio CD’s that purchase from market are WORM Disks 
which ai recorded by the company and can be played or read for many times. 
(b) CD-RECORDABLE (CD-R) 
o The recordable CD can be written only once. The data that we don’t want 1 be 
modified is stored on a recordable CD. o One of the main features of a CD-R drive 
is called multi-session recording, enables you to keep adding the data to the disk 
overtime i.e. suppose w have recorded 100MB data on a CD-R disk under 
multi-session feature, the: after that we can reuse the disk for recording purpose 
i.e. the remainin 600MB space can be recorded later. By this way, we can utilize 
every MB c disk. 
o We can write or record any type of data file on a CD-Recordable (CD-R) disk 

whether it is an audio file, video file, text file, graphical file etc. But tb 
condition is that the size of the file should not exceed than the size of thi CD-R. 

o To run CD-R disk on the system, CD-R drive will be required. 
(c) CD-REWRITABLE (CD-RW) 

o CD-RW stands for CD-Rewritable Disk. It is a type of CD that enables you tc 
write onto the disk more than once or multiple times. This means we can use a 
CD-RW disk just like a floppy or hard disk for writing data multiple times, o The 
first CD-RW disk became available in 1997. To write the data on a CD-R disk or on 
a CD-RW disk, CD-writer will be required, o To write the data again on a CD-RW 
disk, we have to format the disk first and after that 
we can rewrite the data onto it. 

(ii) DVD (DIGITAL VERSATILE / VIDEO DISK) 
DVD is a new type of CD-ROM that can hold the data 

minimum of 4.7GB and maximum of 17GB. Today, DVDs are 
now replacing audio, video, and data CDs. A DVD has a 
layered structure and extremely high data density, which 
makes it capable of storing up to 17 GB in a single disk. 
DVD-ROM uses the same principle as that used in CD-ROM 
for reading and writing data.
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Some other variants of DVD-ROM are DVD-R, DVD+R, DVD-RW, DVD+RW etc. • As far as 
the storage capacity’s concern, DVD comes in eight different flavors: 

Physical Size Stors 

Single Layer 

ige Capacity 

Double / Dual Layer 
12cm Single Side 4.7GB 8.5GB 
12cm Double Side 9.4GB 17GB 

8cm Single Side 1.4GB 2.66GB 
8cm Double Side 2.8GB 5.2GB 

 

 

Fig. 3.10 (Flash Drive)

Some of the main features of DVD are: 
• DVD-ROM drives are used to read data from a DVD. 
• A new device, called as COMBO DRIVE is also capable of reading DVD-ROM as well 

as CD-ROM and it can also write or rewrite data on a CD-ROM. 
• DVD-WRITER is also a new device, capable of reading as well as writing on a CD- 

ROM and DVD-ROM. 
• The writing speed for DVD is 18X or 20X. Here, ‘X’ means rotations per second. 

3.3.3 SOLID STATE STORAGE 
Solid State Storage is one of the latest secondary storage devices. This type of storage 

is also called Flash memory. It is a permanent storage device i.e. data will not be erased 
even when the power is switched off. 

> Types of Solid State Storage 
(i) Flash Drive (Pen Drive) (ii) Memory Card 

(i) Flash Drive (Pen Drive) 
It is a compact device of the size of a pen comes in various shapes and stylish designs 

and may have different storage capacities. The main features of flash drive or pen drive 
are: 

It enables easy data transmission from 
one computer to another. 
It is a plug and play device that simply 
plugs into a USB port of a computer. The 
computer detects it automatically as a 
removable drive. 
We can easily read, write, copy, delete or 
move data from the computer’s hard disk-, 
drive to pen drive and vice versa. 

• It does not require any kind of cable, battery or software and is compatible with 
almost every PC. 

• It has very compact size and very low energy consumption. 
• It stores data permanently, i.e. non-volatile in nature. 
• USB flash drives have less storage capacity than an external hard drive, but they 

are smaller and more durable because they do not contain any internal moving 
parts. 

• As flash memories do not have any moving devices like heads and arms etc. so, they 
are faster than the mechanical disks. 
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Fig. 3.71 (Memory 
Cart

(ii) Memory Card (SD / MMC) 
• A memory card or flash card is an electronic flash memory data storage devi used 

for storing digital information. 
• Some of the most popular ones are Secure Digital (SD) and 

Multimedia Memory Card (MMC). Storage capacity of these 
cards range from 64MB to 8GB normally. 

• They are commonly used in many electronic devices, 
including digital camerasmobile phones, laptop computers, 
MP3 players, and video game consoles. 

• They are small, re-recordable, and they can retain data 
without power. 

• This also facilitates easy transfer of data from these 
electronic devices to computer and vice versa. 

anaon
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Fig. 4.1 (Operating System)

OPERATING SYSTEM 

4.1 OPERATING SYSTEM 
The operating system (sometimes abbreviated as "OS") is an important component of the 

computer system. It can be defined as a set of programs that 
control how the system works. It is the most important program 
that runs on a computer. It is considered the backbone of a 
computer, managing both software and hardware resources. All 
computers must have an operating system used for starting the 
computer and to run other programs. It provides an interface 
between the users and the hardware of a computer system. 

Operating systems perform basic tasks, such as recognizing 
input from the keyboard, sending output to the display screen, 
keeping track of files and directories on the disk, and controlling 
peripheral devices such as disk drives and printers. 

For large systems, the operating system has even greater 
responsibilities and powers. It is responsible for security, 
ensuring that unauthorized users do not access the system. 
The operating system is loaded automatically into the computer 
whenever we start the computer. More than one type of operating 
systems can also be installed on one computer but at one time 
only one operating system will be functional. 

Once the operating system has started up, it manages all of the software and hardware on 
the computer. Most of the time, there are many different programs running at the same time, 
and they all need to access your computer's central processing unit (CPU), memory, and 
storage. The operating system coordinates all of this to make sure that each program gets 
what it needs. Without the operating system, the software wouldn’t even be able to talk to the 
hardware, and the computer would be useless. 

It also allows you to communicate with the computer without knowing how to speak the 
computer's language. The most popular operating systems are MS-DOS, OS/2, UNIX, Windows 
98, Windows XP, Windows Vista, Windows 7, Window 8 and Linux. 

4.1.1 Functions of Operating Systems 
The operating system performs many important functions in a computer. Following are 

the main functions of an operating system: 
(a) It works as an interface between computer’s hardware and software. 
(b) Process Management, i.e. assignment of processor to different tasks being performed 

by the computer system. 
(c) Memory Management, i.e. allocation of main memory and other storage areas to the 

system programs as well as user programs. 
(d) Input/Output Management, i.e. assignment of the different input/output devices to 

one or more programs, while they are being executed. 
(e) File Management, i.e. creation of a new file, modification in an existing file, 

copying/moving a file from one storage location to another. 
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(f) Establishment of a priority system, i.e. it determines and maintains the order in 2. 
which jobs are to be executed in the computer system. 

(g) Interpretation of commands or instructions. 
(h) Assignment of software program(s) to different computer users according to their 

demand. 
(i) Establishment of data security and data integrity, so that unauthorized users does 

not access the system. 
(j) Automatic transition from job to job as directed by special control statements. 
(k) Error handling, During program loading or executions, errors may occur in 

computer’s hardware or memory. The operating system detects such error and 
takes appropriate action to ensure correct and consistent computing. 

(l) Operating system facilities easy communication between the computer system 
and the computer user. 

4.2 TYPES OF OPERATING SYSTEM 
Various operating systems have evolved depending on the requirement and the cost 

bearing capacity of the users. 
1. Single user operating system 
2. Multi-user operating system 
3. Single tasking operating system 
4. Multi-tasking operating system 
5. Multi-programming operating system 
6. Single processing operating system 
7. Multi-processing operating system 
8. Multi-threading operating system
 C 
9. Time sharing operating system 

10. Network operating system 
11. Real time operating system 
12. Distributed operating system 
13. Online operating system 
14. Batch processing operating system 
Following is the brief description of these operating systems: 

1. Single user operating system 
• A single user operating system is a type of operating system (OS) that is I developed 

and intended for use on a computer that will only have a single user at any given 
time, i.e. only one person can use the machine at a time and operating system is 
available to the single user at a time. 

• An example of single user operating system is MSDOS (Microsoft Disk Operating I 
System). 

Advantages: 
• It is simple to design, implement and maintain. 
• It is relatively bug-free. 
• It executes with little overhead. 
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2. Multi-user operating System 
• A multi-user operating system is a type of operating system (OS) that allows 

multiple users on different computers or terminals to access a single system with 
one operating system on it. 

• It allows two or more users to run programs at the same time. Some operating 
systems permit hundreds or even thousands of concurrent users. 

• Such operating system is made for machines which are more commonly called 
shamble machines, i.e. data from one machine can be shared by other users at other 
machines. 

• This operating system is more complex in nature, bigger in size and more costly as 
compared to single user operating system. 

• Some multi-user operating systems are: Windows-2000, Windows-NT and Windows 
2003. 

Advantages: 
• It makes better use of resources. 
• It improves productivity by allowing access of resources to multi -users 

simultaneously. 
• It reduces response time. 
Disadvantages: 
• It has complex configuration. 
• It is difficult to handle and maintain. 
• It requires a lot of memory to process. 
• It is relatively expensive than single user operating system. 
• It is difficult to maintain security and integrity of user programs and data. 

3. Single tasking operating system 
• Single tasking operating systems are those operating systems that can process one 

application at one time. 
• The user can only work on one application at a time; i.e. user can’t start another 

application till the processing of one application has been finished by the operating 
system. 

' • An example of single tasking operating system is MSDOS (Microsoft Disk Operating 
System). 

4. Multi-tasking operating system 
• A multi-tasking operating system is a type of operating system that is capable of 

running more than one application at a time. For example, at some time you might 
be downloading some thing from internet, as well as you are writing mail to your 
friend and listening music also. 

• Multi-user operating systems also have the property of multitasking. It improves 
the overall efficiency of the computer. 

• Today, most desktop, laptop, and notebook (mini laptop) operating systems 
function with some type of multitasking operating system. Even equipment such 
as Automatic Teller Machines or ATMs still make use of some type of multitasking 
system, using a series of programs to check balances and execute the requests 
made by users. 

• Some multitasking operating systems are: Windows-2000, Windows-XP, 
Windows-Vista and Windows-NT. 

Advantages:
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• In this two or more program resides in main memory (RAM} and are execut 
concurrently. This is done by switching the CPU from one program to anotb 
almost instantaneously. 

• Since there is only one processor, there can be no true simultaneous executi of 
different programs. Instead, the operating system executes part of o program, 
then part of another, and so on. To the user it appears that programs are 
executing at the same time. 

• Some multi-programming operating systems are: Windows-2000, Windows-> 
Windows-Vista and Windows-NT. 

Advantages: 
• It increases CPU utilization. 
• It decreases total read time needed to execute a job. 
• It increases overall throughput of a computer. 
Disadvantages: 
• It is relatively more complicated. 
• It requires CPU scheduling. 
• Proper memory management is required. 
• It requires tracking of all kinds of jobs running concurrently. 

6. Single processing operating system / Uni-processor operating system 
• Single processing operating systems are designed to work with o processor/CPU. 
• Desktop computers and laptops are generally uni-processor systems. 
• These systems can manage the processing needs of a home or a sm organization, 

but they are not suitable for high level designing and compl calculations. 
• Some single processing operating systems are: Windows 98, Windows-ME etc. 

7. Multi-processing operating system 
• A multi-processing operating system allows a program to run on more than o 

central processing unit (CPU) at a time. 
• If one of the CPU breaks down, the other CPU will automatically takes over job. 

This is also called parallel processing. 
• By allowing parallel processing of segments of program, it improves performan 

of computer systems. 
• Some multiprocessing operating systems are: Windows-2000, UNIX and Linux. 
Advantages: 
• It increases the reliability of the system. 
• It increases the overall productivity of the system. 
• It has better performance than single-processing system. 
• If one CPU get failed other CPU are used to do that CPUs job. 
Disadvantages: 
• It is very expensive. 

• It requires a lot of memory to run and execute several user programs. 
• If one CPU gets failed, it affects the speed of processing. 
• It is relatively more complex than single-processing system. 

8. Multi-threading operating system 
• A multi-threading operating system allows different parts of a single program 

(threads) to run concurrently. 
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programming, where CPU is allocated to programs on priority basis. 
• This very brief share of CPU time is called the time slice or time slot or quantum, 

which may vary from 10 milliseconds to 20 milliseconds. Each program gets 
predetermined “time slice”. 

• At end of time slice, current program is set aside and a new one starts. By rapidly 
shuffling programs, illusion of several programs executing simultaneously is 
created. 

• The timesharing operating system keeps only a few programs in the main memory 
and rest are stored in the disk storage. The program remains in hard disk until it is 
not active and when CPU time is allocated to it the program is brought to the main 
memory. 

• This operation of transferring programs from disk storage to main memory and 
back is known as swapping. 

• Some time sharing operating systems are: Windows-2000, Windows 2003, UNIX and 
Linux. 

Advantages: 
• Provide advantage of quick response. 
• Avoids duplication of software. 
• Reduces CPU idle time. 
• Allows the many users to execute their task simultaneously. 
• It offers better utilization of resources. 
Disadvantages: 
• It is very difficult and expensive to develop. 
• It is hard to implement. 
• Memory management must be provided to the system. 
• It has problem of reliability. 
• It is difficult to maintain security and integrity of user programs and data. 
• Problem of data communication. 

10. Network operating system 
• Networking operating system (NOS) is the software that runs on a computer, 

which acts as a server. 
• NOS provide the capabilities required for network operations. It enables the
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server to manage data, users, groups, security, applications, and othej networking 
functions. 

• NOS are based on a client/server architecture in which a server enables multipit 
clients to share data and resources. 

• It allows remote users to connect to a network. 
• It monitors the status and functionality of network elements. 
• The most popular network operating systems are Microsoft Windows Serve: 2003, 

Microsoft Windows Server 2008, UNIX, Linux and Novell NetWare. 
Advantages: 
• It is highly stable because of Centralized servers. 
• It maintains security and integrity of user programs and data. 
• New hardware and technology can be easily integrated into the system. 
• Remote access to servers is possible from different locations and types of systems. 
Disadvantages: 
• It is expensive because of high cost of buying and running a server. 
• Dependency on a central location for most operations. 
• Regular maintenance and updates are required. 

11. Real Time operating system 
• A Real Time operating System is an operating system that has been developed for 

real-time applications. 
• It responds to input instantly. 
• Real time operating systems are designed to handle events as they occur. 
• Real-time operating systems are commonly found and used in Robotics. 
• General-purpose operating systems, such as DOS and UNIX, are not real-time 

because they can take a few seconds, or even minutes, to react. “Lynx” is an example 
of a real time operating system. 

Advantages: 
• It is easy to design and develop. 
• It offers maximum consumption of the system. 
• It relatively requires less memory space. 
• It is bugs-free in performing tasks. 
Disadvantages: 
• It perform limited task and hence cannot be used for general purpose. 
• It is expensive as it requires a lot of system resources. 
• It uses complex algorithm. 

12. Distributed operating system 
• The development of networked computers that can be linked and communicate with 

each other, gave rise to distributed computing. 
• A distributed operating system manages a group of independent computers and 

makes them appear to be a single computer. 
• Distributed computations are carried out on more than one computer. 
•  A distributed system may have more total computing power than a mainframe. 
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Advantages: 
• Computation distribution over several processors offers high performance. 
• It is reliable i.e. One machine’s failure need not bring down the system. 
• Computers and software can be added incrementally. 
• Aggregates computing power. 
• It offers better utilization of resources. 
• It facilitates human-to-human communication. 
• Speedup the exchange of data with one another. 
• Reduction of delays in data processing. 
Disadvantages: 
• It is very difficult to maintain. 
• It is much more complex to setup. 
• It is difficult to maintain security and integrity of user programs and data. 
• It requires special software to be able to recover networking problems such as lost 

messages and congestion etc which make system overloaded. 
13. Online processing operating system 

• In online processing operating system, the processing is performed under the direct 
control of the CPU while at the same time the user remains in communication with 
the computer. 

• Time sharing is an example of online processing. As there is direct contact with the 
CPU, so access and retrieval of record are quick and direct. 

• The systems which employ online processing need high capacity memory, so that user 
data, operating system elements and programs can be store and accessed quickly. 
Moreover, as simultaneous access is there so proper security provisions are necessary 
to prevent any unauthorized access. 

14. Batch processing operating system 
• In earlier computers, the users didn’t interact directly with the system, instead, a user 

prepared a job, which consisted of program, data, and some control information about 
the nature of the job and submit it to the computer operator. 

• The operating system of such a computer had the function to transfer the control from 
one job to another. 

• Batch processing operating systems are ideal in situations where: o 
There are large amounts of data to be processed. 
o Similar data needs to be processed, o Similar processing is 
involved when executing the data. 

• Batch processing is also known as serial, sequential, off line, or stacked job processing. It is 
the most appropriate method of processing for many types of applications such as 
payroll or preparation of customer statements where it is not necessary to update 
information (records) on daily basis. 

Advantages 
• It increases overall performance as a new job gets started on completion of previous 

job without human intervention. 
• It is efficient because these systems use very little computer processing time to 

prepare a batch of data  





 

Disadvantages 
• It is difficult to provide the desired priority scheduling. 
• Lack of interaction between the user and hence job could enter an infinite loop 
• It is difficult to debug program. 
• Due to lack of protection scheme, one batch job can affect pending jobs. 

4.3 DOS-AN OVERVIEW 
DOS is a “Disk Operating System” used for operating the disks, developed by Microsoft 

Corporation in 1981 with name as MS-DOS version 1.0. But in practice, DOS does more than 
just operate the disks. It enables the user to organize data files, load and execute program 
files, and control the input and output devices attached to the computer. 

DOS is a program comprising set of executable instructions, loaded into the memory 
(RAM) of user’s personal computer before execution of any application. It creates an interface 
between system’s hardware and software. 

DOS is a single user and single tasking operating system, which provides character user 
interface/ text-based interface. That means the user interacts with this operating system by 
using set of character/text-based commands. DOS provides a prompt screen for the user 
(Command prompt/Dos prompt- like: C:\> or A:\>), where the user can type in commands from 
the keyboard. The flashing underscore next to the command prompt is called the cursor. The 
cursor shows where the command user type will appear. The system is entirely case 
insensitive, i.e. user can type the command either in uppercase or lowercase letters. Through 
the commands provided by DOS, we can perform tasks like file and directoiy management, 
disk management, hardware configuration and memory management etc. MS-DOS 
commands are written in simple English language and 

 

4.3.1 Features of DOS 
The features of DOS differ from version to version. That means the features of MS- DOS 

version 5.0 are not same as of MS-DOS version 4.0 or 6.22. Each new version comes with some 
additional features in the form of additional commands. Some of the important features of 
DOS are: 

• As DOS is a single user operating system and works on text-based commands issued 
by the user. It directly interprets the commands typed on DOS-prompt. 

• DOS provides easy commands to perform various file operations, like- file creation, 
file copy  file movements and file deletion  

Fig. 4.2 (DOS Window)
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Fig. 4.3 (DOS 
Directory 
Structure)

is present under root 
directoiy of C: drive (\). The following figure shows the above directoiy structure: 

• It provides DATE and TIME commands to modify the system’s date and time as per 
user requirements. 

• DOS allows users to retrieve a deleted file, using UNDELETE command. 
• DOS allows users to perform a sequence of tasks automatically, when the system is 

booted. This is done by using a DOS-based file called “autoexec.bat”. 
• DOS supports a full screen text editor to easily create and edit text files. User can open 

this text editor by using EDIT command of DOS. 
• DOS enables users to view the memory status of computer system by using MEM 

command. It displays the amount of used and free memory of the system. 
• DOSKEY command of DOS, recalls the previously typed commands that can be edited. 

This way, time required to retype commands is saved. 
• The DIR command of DOS helps to show a list of all files, directories or subdirectories 

present in the system or a particular directory. 
• The TREE command of DOS helps to show a graphical representation of all files, 

directories or sub-directories present in the system or a particular directory. 
• DOS enables users to set different attributes/properties on files with ATTRIB 

command. 
• The system’s settings can be changed by making appropriate changes in CONFIG.SYS 

file. 
DOS enables users to retrieve data from a formatted disk by using UNFORMAT 
command. 
By using pipe symbol (|), user can execute more than one command simultaneously. 
Thus it reduces the command’s typing time. 
DOS provides DISKCOPY command to copy the complete contents of a disk into some 
another disk. 
DOS allows users to find a particular text/string from a specific file by using FIND 
command. 
A special utility of DOS called HIMEN.SYS automatically tests system memory on 
startup. 
Microsoft Defragmenter, a powerful utility of DOS can optimize hard disk’s storage 
space by combining small unused areas between files to form a big unused area, which 
can be further used for storage purpose. 

4.3.2 Structure of DOS 
DOS has tree like structure. All the directories are 

created under root directory of drive, i.e. the root directoiy is 
at the topmost level. The directories further contain sub 
directories and files and the sub-directories can also further 
contain directories and files in them. 

The address from root directoiy to a particular file or 
directory is called Path. 

Example: C:\Course\BTech\pl.txt 
The above example depicts a path to file “pl.txt”, which is 

present under a sub-directory “BTech”, which is present 
under a directory “Course”. The directory “Course” 
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This means, every computer application store data values in the form of a file. Or computer 
file can store only one kind of information. The file that store text or words et is called text file 
or document file, whereas the database is stored in a database file. 
File Naming Conventions in DOS: 

DOS uses the concept of files to organize data on disk. To remember the physic; layout of 
each file, DOS expects each file to be named. File naming conventions are th rules that must 
be followed in order to create a file in DOS. Following rules should t followed while creating a 
file in DOS: 

• File name has two parts: Primary name and Secondary name, separated by period (.) 
symbol. The primary name is mandatory while the secondary name : optional. 

• Primary name can be of 1-8 characters in length and secondary name if specifier can have 
3 characters at the most. 

• The name of the file must start with a letter. That means first character cannr be a 
number or symbol. 

• It cannot contain “, /, \, :, + and = symbols. 
• It cannot contain spaces. 

4.4.2 Directory 
A directory is, in general, an approach to organizing information, the most familis 

example being a telephone directory. 
In computer systems, the information is stored in the form of files. When a organization 

uses computer to perform their day-to-day work, they create files and th number of files 
increases with each single working day. Some mechanism is required t organize these files on 
the disk. DOS offers a smart way to organize files i.e. Directory. directory is just a name given 
to a logical area on the disk, which acts like a cabine having different drawers for different 
types of files. 

Like filename, the directory name can also have up to 8 alphanumeric characters 
Directories can be created by the user or by an application. The directory is furthe divided into 
three parts: 

(a) Current directory 
(b) Sub directory 
(c) Root directory 

(a) Current directory 
The directory in which user is currently working. 
(b) Sub directory 
A directory exists within another directory, is called sub directory. This is also calld a 

child directory. 
(c) Root directory 
It is represented by (\). It is the starting point from which all other directorie branch out. 

In computer system, every drive has a root directory. 
Example: 

 __________________________ C:\COURSES\BCA\BCAl > ________________________  
Here, “C” is the drive, “ \ ” is the root directory, “COURSES” is the first director created 

under root directory, “BCA” is the sub-directory of “COURSES” and “BCA1” i the current 
working directory or sub-directory of “BCA”. 



OPERATING SYSTEM 4.11

 

at

° disk 
ors (If 

memory (RAM). The booting process starts from the moment, when we power on the computer 
and continues till the moment, the computer is ready for use. In case of DOS, booting process 
starts when we start the computer and continues till the DOS prompt is displayed. Each 
operating system has a different booting process. 

The booting process of DOS, mainly deals with loading the three main system files of DOS 
into the memory. These files are IO.SYS, MSDOS.SYS and COMMAND.COM. 

In the booting process of DOS, following steps are performed when we start a computer: 
(i) Once the computer system is turned on, the BIOS (Basic Input/Output System) 

perform a series of activities or functionality test on the programs stored in the ROM, called 
Power on Self Test (POST) that checks to see whether the peripherals in the system are in 
perfect order or not. 

(ii) After the BIOS is done with the pre-boot activities or functionality test, it reads the 
bootable sequence from CMOS (Common Metal Oxide Semiconductor) and looks for the 
master boot record in the first physical sector of the bootable disk as per the boot device 
sequence specified in the CMOS. For example, if the boot device sequence is- 

(a) Floppy Disk, (b) Hard Disk, fc) CDROM. 
Then the master boot record will be searched first in floppy disk drive. If not found, then 

the hard disk drive will be searched for the master boot record. But, if the master boot record 
is not even present in hard disk, then CDROM drive will be searched. If the system is not able 
to read the master boot record from any of these sources, ROM displays a message “No Boot 
device found” and the system is halted. 

On finding the master boot record from a particular bootable disk drive, the operating 
system loader, also called the Bootstrap loader is loaded from the boot sector of that bootable 
drive into the memory. A bootstrap loader is a special program that is present in the boot 
sector of the bootable drive. 

DOS operating system comprises of the following files: 
(a) IO.SYS (b) MSDOS.SYS (c) COMMAND.COM (d) CONFIG.SYS (e) AUTOEXEC.BAT 
Note that the first three files are mandatory while the rest two are optional. Further, the 

first three files should be present in the bootable drive of the disk and in the same sequence as 
shown above for the operating system to function properly. If any of these three files are not 
found, then the message, “Non-system disk or disk error - Replace and press any key when ready” 
is displayed in the console, else the boot process continues. 

(iii) The Bootstrap loader first loads the IO.SYS file. The IO.SYS file as the name 
suggests, is responsible for Input-Output in the DOS environment. The next file that is loaded 
is the MSDOS.SYS, which is the core file of the DOS operating system. The MSDOS.SYS file 
is mainly responsible for memory management and processor management in the DOS 
environment. 

(iv) The MSDOS.SYS file now searches to find the name of the command interpreter in the 
CONFIG. SYS file and when it finds one, it loads the same into the memory. If no command 
interpreter is specified in the CONFIG.SYS file, the COMMAND.COM file is loaded as it is 
the default command interpreter of DOS Operating system. We can load different command 
interpreter by specifying the following in the CONFIG.SYS file: 

Command = C:\TEST.COM 
Here, TEST.COM is a command interpreter that would be used 

interpreter in lie of the default command interpreter COMMAND.C^ 
(v) The last file to be loaded and executed is the AUTOEXEC.B. 

sequence of DOS commands. Now, the prompt is displayed and letter of 
th  b t bl  d i  di l d  t   hi h ti  t  
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4.5.1 Types of Booting 
There are mainly two types of booting in DOS: 
(i) Cold Booting / Switch Booting (ii) Hot Booting / Warm Booting 

(i) Cold Booting / Switch Booting 
When user starts computer by pressing the power switch on the system unit, the 
operating system is loaded from disk to the main memory. This type of booting is called 
cold booting. Cold booting takes a longer time than hot or warm booting. This is also called 
switch booting as the user presses the power switch of the computer. 

(ii) Hot Booting / Warm Booting 
Hot booting is done when the computer system comes into no respond state / hangs state. 
At this state, the computer does not respond to the commands supplied by the user. There 
are many reasons for this state; the only solution is to reboot the computer by using Reset 
button on the cabinet or by pressing a key combination of ALT+CTRL+DEL keys from the 
keyboard. This type of booting is also called hot booting or warm booting. 

4.6 DOS COMMANDS 
A command generally means an instruction to a computer or device to perform a specific 

task. As MS-DOS is purely a text-based operating system, so a DOS user can interact with 
computer only through the text-based DOS commands. These commands are divided into two 
categories: 

(i) Internal Commands (ii) External Commands 
(1) Internal Commands 

Internal commands are those commands, which are internal to DOS. This means, 
internal commands are loaded automatically in the memory when DOS is loaded into the 
memory. These are programs contained in the COMMAND.COM file (Booting file) and no 
other file is needed to run these commands. Thus, these commands are always available 
for execution as long as DOS is running. Following list shows the main internal 
commands of MS-DOS: 

 

o DIR: This command displays the list of contents (all the files and directories) of the 
current working directory. 

o VER: This command displays the current version of operating system loaded in your 
computer. 

o DATE: This command displays the current date of the system and prompts for a new 
one. If no new date is entered, then current date wifi be kept, o TIME: This command 
displays the current time of the system and prompts for a new one. Press ENTER to keep 
the same time, o VOL: This command displays the volume information (volume label and 
serial number) of the selected disk drive. 

o CLS: This command clears the complete contents of the screen and leaves only a 
command prompt (C:\>) on the upper left comer of the screen, o COPY CON: This 

• DIR • VOL • DEL • MD 
• VER • CLS • REN • CD 

• DATE • COPY CON • COPY • RD 
• TIME • TYPE • PROMPT • PATH 
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commands. Following list shows the main external commands of DOS: 
• EDIT • BACKUP • MORE • XCOPY • DBLSPACE 
• DOSKEY • RESTORE • MOVE • FC • DEFRAG 
• ATTRIB • DISKCOPY • SORT • SYS  

• CHKDSK • DISKCOM
P 

• TREE • MEM  

• SCANDIS
K 

 MODE 11 DELTREE  POWER  

• FDISK • LABEL  UNDELETE • PRINT  

• FORMAT • FIND • UNFORMA
T 

• MSAV  

 

o DEL: This command is used to delete files from the computer, o REN: This command is 
used to rename files and directories from the original name to a new name. 
o COPY: This command allows the user to copy one or more files to an alternate location. 
o PROMPT: This command allows the user to change the MS-DOS prompt or command 
prompt to display more or less information, o MD: This command creates a new directory 
or subdirectory on the disk, under the current working directory. 
o CD: This command is used to switch directories in MS-DOS i.e. it changes the control 
from one directory to another directory, o RD: RD (Remove Directory) command removes 
empty directories in MS-DOS. To delete directories with files or directories within them, 
the user must use the DELTREE command. 
o PATH: This command is used to provide access to files located in other directory or other 

disk. User can access only those files that have extension .exe or .com or .bat. By 
setting the path to these executable files, user can execute them from any location of 
the system. 

(2) External Commands 
External commands are the commands that are not automatically loaded when DOS is 
loaded into the memory. The external commands are used less frequently and are stored in 
some external files which are stored in some secondary storage device, like: hard disk. 
Whenever an external command is to be executed then the external file in which that 
particular command is stored is transferred from the disk (hard disk) to main memory 
(RAM). The type and number of external commands may vary from system to system. This 
means, any two computers having same version of DOS will have same number of internal 
commands but they can have different external commands. All executable files with 
extension .com, .exe and .bat are the external 
o EDIT: This command allows a user to create a new file or modify the contents of an 

existing file. 
o DOSKEY: This command allows a user to keep a history of commands used on the 

computer. This allows frequently used commands to be used without having to type the 
commands in each time you need to use it. 

o ATTRIB: This command allows a user to change the properties or attributes of a specific 
file. 

o CHKDSK: This command checks the computer's hard disk drives' status for any 
cross-linked or any additional errors with the hard disk drive, but it can-not repair the 
problems found. 

o SCANDISK: This command is used to check and repair various kinds of disk errors. It 
thoroughly checks the disk and reports any kind of bad sectors (If found).
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o FDISK: This command allows the user to delete and/or create partitions on the hard 
disk drive. The number and size of partitions depends upon the choice of the user 
and capacity of the disk. 

o FORMAT: The newly created disk partitions are generally unformatted and cannot be 
directly used to store data. These disks have to be formatted with FORMAT command of 
MS-DOS. This command creates tracks and sectors on the disk and the data will be stored 
into these tracks and sectors. FORMAT command erases all the data from the target disk, 
o BACKUP: This command enables users to backup their data on their computer, o 
RESTORE: This command is used to restore files copied by BACKUP command. ‘ o 
DISKCOPY: This command allows a user to copy the complete contents of a disk into 
another disk. It first formats the target disk and then copies the files byl collecting files 
from the source disk and copies to the target disk, o DISKCOMP: This command is used 
to compare two disks to find out whether they are identical or not. If disks are identical, 
then “OK” message is displayed else an error is reported. 
o MODE: This command performs various functions relating to the transfer of data 
between the processor, screen, printer and the keyboard. It sets the parallel printer mode, 
the view mode and displays the status of attached devices, o LABEL: This command is 
used to view or change the label of the computer disk | drives. 
o FIND: This command allows you to search for text within a file. Although MS- DOS 
itself is not case-sensitive, when typing in the string that you are looking for with the find 
command, it is case-sensitive, o MORE: This command allows information or contents of 
a file to be displayed one page at a time. 
o MOVE: This command allows you to move files from one directory to another or from 

one drive to another. 
o SORT: This command sorts the input and displays the output on the screen. This 

command can be used with other commands by using pipe symbol in many I 
combinations. i 

o TREE: This command displays the list of files and sub-directories of a given directory 
in a tree like structure. 

o DELTREE: This command deletes all the files and sub-directories of a given 
directory completely. 

o UNDELETE: This command allows the user to restore files that may have been 
deleted. 

o UNFORMAT: This command is used to unformatted a drive that has been ' formatted. 
o XCOPY: This command has the capability of moving files, directories, and even 

whole drives from one location to another. 
o FC: FC or FILE COMPARE command is used to compare two files against each : other. 
Once completed, FC will return lines, which differ between the two files. If I no lines 
differ, you will receive a message indicating no differences encountered, o SYS: SYS 
command is used to copy the system files from one drive to another drive, allowing that 
target drive to be bootable, o MEM: This command allows the user to determine the 
available, used and free | memory space of the computer system. 
o POWER: This command reduces the power usage when system is idle. It is i intended 

for users of battery-operated laptop and portable systems. 
o PRINT: This command is basically used for printing the files. This command is used 
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In MS-DOS, Wildcard characters are used to group number of files at one time. These 
are the symbols used to replace or represent one or more characters. Wildcards can be 
used with the DIR command, COPY command and the DEL command. Wildcards cannot 
be used with the TYPE command. Two kinds of wildcard characters are used in DOS: 

(i) The *** wildcard (ii) The *?’ wildcard 
(i) The **’ wildcard 

**’ is such a wildcard character that replaces a set of characters, it depends on the 
position of the name where the **’ is used. For example, the user wants to list only those 
files having the extension as .COM let the primary name be anything, the command DIR 
*.COM can be used which might show the directory listing of all those files that have the 
extension as COM, let the primary name be anything. 
(ii) The'?’ wildcard 

The *?’ is the second wildcard character that replaces one character at a time. For 
example, the user wants to list all the files with the second character of the file name as 
‘U’and rest of the characters can be anything, the command DIR ?U*.* can be used. 
Example: 

C:\>DEL *.DOC 
(The above command will delete every file with the .DOC extension from the root 

directory (\) of C: drive.) 
C:\>DELD:\BCA\*.* 
(This is the fastest way to clean out a directory. The above command will delete every 

file in the directory D:\BCA.) 
C:\>COPY AB9.TXT D: 
(The above command will copy any file with a three-letter name, of which the first two 

letters will be AB’ and with a .TXT extension to the D: drive.) 
C:\>DIR *.EXE 
(The above command will display the list of all files exist under root directory (\) of C: 

drive with extension .EXE”.) 
C:\>DIR A*.DOC 
(The above command will display the list of all fries primary name beginning with A’ 

exists under root directory (\) of C: drive with extension .DOC.) 
C:\>DIR *.?S? 
(The above command will display the list of all files exist under root directory (\) of C: 

drive with second character of the extension name as ‘S’. 
C:\>DIR *.?S? 
(The above command will display the list of all files exist under root directory (\) of C: 

drive with second character of the extension name as ‘S’.)  
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4.8 VIRUS & HACKERS 
4.8.1 VIRUS 

Virus (Vital Information Resource Under Seize) is a malicious program or piece of coon that 
is loaded onto your computer without your knowledge and runs against yope wishes. A 
computer virus might corrupt or delete data on a computer. Viruses can aim replicate 
themselves. Even such a simple virus is dangerous because it will quickly us.J all available 
memory and bring the system to a halt. An even more dangerous type virus is one capable of 
transmitting itself across networks and bypassing securif systems. 31 

Computer viruses are frequently spread by attachments in E-mail messages or bs< 

instant messaging messages. Therefore, you must never open an E-mail attachment unless 
you know who sent the message or you are expecting the email attachment^ Viruses can be 
disguised as attachments of funny images, greeting cards, or audio anis video files. 
Computer viruses also spread through downloads on the Internet. They cai^ be hidden in 
pirated software or in other files or programs that you might download. ^ 

The dangers of viruses have gotten a lot of attention over the year, and withon 5j simple 
attention they will continue to spread. Computer viruses cause a number o symptoms such as:
 ^ 

• Computer programs taking longer to load than normal. 
• The computer is slower than normal. 
• Computer stops responding or freezes frequently. 
• Computer crashes and restarts every few minutes. 
• The computer does not run as usual. 
• Applications on the computer do not work correctly. 
• Disks or disk drives are inaccessible. 
• Printing items is difficult. 
• Error messages appear rapidly. 
• Distorted menus and dialog boxes. 
• Antivirus programs get disabled for no reason, and cannot be restarted. 
• Antivirus programs will not start, and new programs cannot be installed. 
• Strange sounds play from the speakers unexpectedly. 
• Programs disappear from the computer. 
These symptoms are common signs of computer virus infection, and they are also 

warning signs that you may be getting a computer virus. When you suspect that you are 
getting a computer virus there are many ways to take care of it. Before you can get a virus it 
is best to prevent them from getting into your computer by having antivirus software. 
> WORKING OF VIRUSES 

The working of viruses depends upon the different steps from occurrence until last 
stage. The steps that are involved in the working are as follows: 
(a) Occurrence or Invasion 

The first step in the working of the viruses is the invasion. It is defined as the process or 
the way by which viruses enter in the computer system and infect the system. These viruses 
entered in the system through different types of outside source. However, two important and 
main components that enhance the invasion or attack of the viruses are disk drives and 
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Other source of virus entrance in the system is different types of networking cards that 
are used for communicational purposes such as LAN card, modem etc. When we activate the 
internet through these cards, some web pages that are coded for these infections are straightly 
spread the virus in the computer hardware and the system become corrupted. Different types 
of E-mails are also responsible for the activation of the virus in your systems. 
(b) Working 

When these viruses enter the system, they can directly move towards the hidden areas in 
the system that is far from the vision of the users. In addition, when we open some kind of files 
or different types of documentation related to these viruses, the virus could infect the system, 
destroy its major components of working and completely slows down the progress of the 
system. After this virus can replicate and copy itself into the system and installs its major 
infected components in the memory of the computer. Moreover, due to this infection and 
installation, whole data on the drives will lose and the operating system destroys. 
> TYPES OF VIRUSES 

Based on the working and the ability of doing infection, viruses are categorized into 
several types such as: 

(i) Resident Virus 
A type of virus that infects the whole memory area of the RAM is called as resident virus. 
(ii) Boot Virus 
Boot virus is the type of virus that spread the virus in the bootable part of the hard drive. 
(iii) Direct Action Viruses 
The main purpose of this virus is to replicate and take action when it is executed. When a 
specific condition is met, the virus will go into action and infect files in the directory or 
folder that it is in and in directories that are specified in the AUTOEXEC.BAT file PATH. 
This batch file is always located in the root directory of the hard disk and carries out 
certain operations when the computer is booted. 
(iv) Overwrite Viruses 
Virus of this kind is characterized by the fact that it deletes the information contained in 
the files that it infects, rendering them partially or totally useless once they have been 
infected. The only way to clean a file infected by an overwrite virus is to delete the file 
completely, thus losing the original content. 
(iv) Directory Virus 
Directory viruses change the paths that indicate the location of a file. By executing a 
program (file with the extension .EXE or .COM) which has been infected by a virus, you 
are unknowingly running the virus program, while the original file and program have 
been previously moved by the virus. Once infected, it becomes impossible to locate the 
original files. 
(v) File Infectors 
This type of virus infects programs or executable files (files with an .EXE or .COM 
extension). When one of these programs is run, directly or indirectly, the virus is 
activated, producing the damaging effects it is programmed to cany out. The majority of 
existing viruses belongs to this category, and can be classified depending on the actions 
that they carry out. 
(vi) FAT Virus 
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computer. This type of vims attack can be especially dangerous, by preventing access to 
certain sections of the disk where important files are stored. Damagi caused can result in 
information losses from individual files or even entire directories. 
(vii) Worms 
A worm is a program very similar to a virus. It has the ability to self-replicate, and can 
lead to negative effects on your system and most importantly they are detected and 
eliminated by antivirus. 
(viii) Trojans or Trojan Horses 
A Trojan horse is a malicious software program that hides inside other programs. It 
enters a computer hidden inside a legal or valid program, such as a screen saver, Then 
it puts code into the operating system that enables a hacker to access the infected 
computer. Trojan horses do not usually spread by themselves. They are; spread by 
viruses, worms, or downloaded software. 
(ix) Spyware 
Spyware can install on your computer without your knowledge. These programs car! 
change your computer’s configuration or collect advertising data and personal 
information. Spyware can track internet search habits and can also redirect your web 
browser to a different website than you intend to go to. 

> VIRUS DETECTION PREVENTION AND CURE 
The vims programs should be completely removed from the computer so as to ensure the 

proper functioning of the computer. Today, various companies have designed; various 
antivirus programs which perform the following function; 

(i) Vims Detection 
(ii) Virus Prevention 

(iii) Control the virus 
(iv) Remove the vims 

(i) Virus Detection 
If a virus program is present in your computer the antivirus program when loaded checks 
whether it is present or not. It further checks which part of the disk is infected by it. 
These detectors alert the users with the presence of virus. A message! is displayed on the 
screen telling the user that system is being infected by the vims or not. 
(ii) Virus Prevention 
Once the vims is detected it should be stopped to replicate itself. Moreover the vims, 
which is already present should also be removed. Some steps to prevent your computer 
from viruses: 
• Maintain a strict security level for browsing the internet. 
• Never download data from unfamiliar websites. 
• Scan your computer thoroughly on a regular basis. 
• Do not open any suspicious or unfamiliar E-mail. 
• Set strong passwords so that vims could not guess the password and break the! 

security settings of your computer. 
• Update your antivirus program online on regular basis. 
• Scan external storage devices like Pen drive thoroughly before to attach with I your 

computer. 
(iii) Control the Virus 
The antivirus program prevents and controls the damage from the virus. Once it is I 
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loaded, the antivirus keeps a copy of boot sector information, FAT’s etc. and stops the 
applications to execute when the virus tries to replicate itself. Thus, no further damage 
is caused. Whenever a virus activates, antivirus stops it from spreading and generates a 
message whenever it is found. So, it is good to install an antivirus program as early as 
possible. 
(iv) Remove the Virus 
The antivirus programs remove the virus from the system. 

4.8.2 HACKERS 
In reference to a system’s security, hacking is usually defined as the act of illegally 

entering a computer system, and making unauthorized changes to the files and data 
contain within. 

Hacking is a technique used to destroy the security of a system. It is an unauthorized use 
of computer and network resources. 

Hacker is a person with technical expertise, who uses computers to gain unauthorized 
access to data. 

Hackers usually attack computer systems to- 
• obtain company’s confidential data. 
• steal credit card numbers. 
• steal passwords of other systems. 
• steal programs or files. 
• read others e-mails. 
Following are the main symptoms that show your system has been hacked: 
• If the data files disappear or are modified unexpectedly on your system. 
• Strange files appear or grow in size unexpectedly. 
• Hard disk space shrinks without any reason. 
• Programs stop working unexpectedly. 
• Strange messages or dialog boxes appear on the screen. 
• The computer starts crashing frequently. 
• Your interent connection slows dramatically for a long period. 
If you are accessing the internet without properly securing your computer, hackers can 

gain illegal access to your files-often without your knowledge. So, the most important step 
to consider if you think your system’s security has been compromised is to disconnect all 
the connections to the internet. 
> Types of Hackers 

(i) Novices: Novice hackers are the hackers having very little technical knowledge. For 
these people, hacking is fun. This type of hacking does not show more effect. 

(ii) Students: These people think that hacking is fashion to youth. Usually, they enter 
into unauthorized sites and leave some messages. They try to find out as much information 
as possible about the systems they hack. 

(iii) Tourists: These people have strong mathematical abilities and good knowledge 
about computers, which allow them to hack any system. When they do hack a system and 
find nothing that is interesting, they tend to log off. This type of hacker may not respect the 
systems as much as the student hackers. For tourists, systems are meant to be broken into, 
not studied. This is the reason that their involvement with a system ends after they break 
i  
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profit. To get access to systems, thieves may opt to blackmail or bribery to get the 
information needed to break into computer systems. 
4.9 CRYPTOGRAPHY AND CRYPTOLOGY 

Cryptography (or cryptology) is a technique of secret writing especially code and cipher 
systems, method of storing and transmitting data in a particular form so that only those for 
whom it is intended can read and process it. The term is most often; associated with 
scrambling plaintext (ordinary text, sometimes referred to as cleartexf into ciphertext (a 
process called encryption), then back again (known as decryption). 

The main objectives of cryptography are: f 
(a) Confidentiality: To ensure that the information is not read by anyone for whom ^ it 

was unintended and is read only by authorized parties. 
(b) Integrity: To ensure that the information wasn’t altered in storage or transit 

between sender and intended receiver. 
(c) Non-repudiation: To ensure that the sender of the information cannot deny at a 

later stage his or her intentions in the creation or transmission of thej 
information. 

(d) Authentication: To ensure that the sender and receiver can confirm each others' 
identity and the origin/destination of the information. 

As the Internet and other forms of electronic communication become more prevalent, 
electronic security is becoming increasingly important. Cryptography is used to protect 
e-mail messages, credit card information, and corporate data. 
There are two basic types of cryptographic systems: 

1. Public Key Cryptography/Asymmetric Cryptography 
2. Private Key Cryptography/Symmetric Cryptography 

(1) Public-key Cryptography 
Public-key cryptography, also known as asymmetric cryptography is a class of 

cryptographic system that uses two keys - a public key and a private key. A public key is 
known to everyone while private (or secret key) is known only to the recipient of the message. 

The term “asymmetric” stems from the use of these two keys to perform these opposite 
functions. The public and private keys are related in such a way that only the public key can 
be used to encrypt messages and only the corresponding private key can) be used to decrypt 
them. The public key encrypt plaintext or to verify a digital signature;! whereas the private 

key decrypt ciphertext or to create a digital signature. 
Public key exchange  
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As illustrated in Figure 4.4, asymmetric encryption involves the following steps: 
1. The sender creates a ciphertext message by encrypting the plaintext message with 

an asymmetric encryption algorithm and the recipient's public key. 
2. The sender sends the ciphertext message to recipient. 
3. The recipient decrypts the ciphertext message back to plaintext using the private key 

that corresponds to the public key that was used to encrypt the message. 
The basic motivation of using public key cryptography is to send messages in such a way 

that only the person who receives them can understand them. By using public key encryption, 
a message sender has assurance that only the recipient will be able to read the message. 

Advantages of Public Key Cryptography: 
• Only one part must be kept secret. 
• There is no need to change your public/private key pair (unless someone finds your 

public key). 
• For N people to communicate there need only be N public/private key pairs. 
• There is no need for initial key exchange. 
• It can serve as a digital signature. 
Disadvantages of Public Key Cryptography: 
• Slow do to the enormous amount of computation involved. 
• Keys must be long (at least 1024 bits these days). 
• There is no proof for that any public key scheme is secure. 
• It has not been around long enough to be tested as much. 

(2) Private-key Cryptography 
Unlike public-key cryptography, a private key cryptography (symmetric-key system) is a 

method in which the same key is used to encrypt and decrypt the message. In private-key 
cryptography, sender and the recipient of the message must agree on a common key via some 
alternative secure channel. 

Symmetric-key systems are simpler and faster, but their main drawback is that the two 
parties must somehow exchange the key in a secure way. Public-key encryption avoids this 
problem because the public key can be distributed in a non-secure way, and the private key is 
never transmitted. 

Shared Secret Key 
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Private-key encryption shown in Figure 4.5 involves the following steps: 
1. The sender creates a ciphertext message by encrypting the plaintext message with a 

symmetric encryption algorithm and a shared key. 
2. The sender sends the ciphertext message to the recipient. 
3. The recipient deciypts the ciphertext message back into plaintext with a sharei key. 

Implementations of symmetric-key encryption can be highly efficient, so that user do not 
experience any significant time delay as a result of the encryption and decryption 
Symmetric-key encryption also provides a degree of authentication, since informatioi 
encrypted with one symmetric key cannot be decrypted with any other symmetric kej Thus, as 
long as the symmetric key is kept secret by the two parties using it to encryp communications, 
each party can be sure that it is communicating with the other as Ion as the decrypted 
messages continue to make sense. 

Symmetric-key encryption is effective only if the symmetric key is kept secret by th two 
parties involved. If anyone else discovers the key, it affects both confidentiality am 
authentication. A person with an unauthorized symmetric key not only can decryp messages 
sent with that key, but can encrypt new messages and send them as if the; came from one of 
the two parties who were originally using the key. 

□□□□□





 

 

5.1 WINDOWS - AN INTRODUCTION 
Earlier operating systems like MS-DOS provides a text based or character based interface to 

the user. User is shown a command prompt, like C :\> in MS-DOS. At this command prompt, 
user is required to type the command and press Enter key. After the Enter key is pressed 
operating system comes to know that user has finished its input and the OS starts processing 
on the input. Every statement typed at the prompt should be a valid command understood by 
the operating system. Some commands require specific parameters to be given with them 
through which the operating system understands more about how the command is to be 
carried out. 

This approach of user interface has some drawbacks with it. The drawbacks can be 
summarized: 

• If the command typed at the prompt is misspelled, operating system does not recognize 
the command and thus no work is carried out. The whole command with the 
parameters, if required, has to be typed again. 

• If the command is wrong, misspelled, short of required parameters, then the operating 
system responds with a cryptic error message. These error messages are short in 
length and it is sometimes difficult to understand the error and solve the problem. 

• In a text based interface, if the user has given a command, at the command prompt and 
has pressed enter key, there is no way he can change the command after that . Further, 
there is no easier way to go back and correct errors. 

As the text based interface is facing some problems, as discussed above, there is need to 
change the interface. It is a well-known fact that picture says more than thousand words, so 
this ability can be used to implement a good user interface. Many modem operating systems 
provide this type of interface which is commonly known as Graphical user interface (GUI). In 
graphical user interface there is no need of a prompt to be shown to the user, every command 
that is to be run, is depicted with a diagram known as icon. To trap the abilities of this type of 
interface various devices have been developed which help in giving commands to the operating 
system. These devices include pointing devices like mouse, which shows an arrow like cursor 
using which you can select or execute the required command. 

Windows is a family of operating systems developed by Microsoft Corporation for personal 
computers. The name Windows comes from the basic function of the operating system, it lets 
the user look into computer, just like looking through a window. WINDOWS provides a 
graphical user interface (GUI) based package designed to make computer intuitive and easy to 
use. Windows comes in various versions like Windows 95, Windows 98, Windows 2000, 
Windows XP, Windows Vista, Windows 7 & Windows 8. 

Earlier versions of Windows like Windows 2.0, Windows 3.0, Windows 3.1, and Windows 
3.11 were not operating systems in themselves; they were just an extension of DOS (Text 
based operating system developed by Microsoft). These versions just provide a graphical shell 
over the underlying text based operating system DOS. 
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Why Windows is popular? 
Some reasons why Windows is becoming popular day by day around the world: 
•  It is an easy-to-use, consistent GUI for virtually all programs. 
•  It is capable of multitasking i.e. running several programs simultaneously. 
• With Windows you can communicate and exchange data between prograi without 

transferring or copying files. 
• Because file and disk management activities are heavily used in day to day c of 

computers, Windows help you by not letting you to close and open prograi or use 
DOS commands to do standard file and disk-maintenance tasks. 

• Windows can run application that offer high-quality output. 
• Many utility programs are included with Windows, such as word process 

(WordPad) and a drawing program (Paint Brush). 
• Another good point about Windows is that it has a consistent user interface, 

program’s user interface is how you tell the program what you want to do. In t 
earlier years of MS-DOS, users had to learn a different method to interact wi 
every program. Now Windows programs have a consistent (same) interface, tl 
means if a user is comfortable with one Windows application, then he/she c learn 
the new application easily. 

5.1.1 Features of Windows Operating System 
Windows operating system comprises the following features which makes it us 

friendly and the most commonly used operating system: 
• Windows operating system is a GUI (Graphical User Interface) system. All t 

applications can be accessed efficiently with very high speed by simply clicki at 
their respective graphical symbols (Icons). 

• It is capable of multitasking, i.e. it can execute more than one ta simultaneously. 
• Various operations like: creating, deleting, copying files and folders can be do: 

easily by just clicking on the graphical icons. 
• It runs each program or application in its own separate window. So, if at a: point 

the numbers of screens are open, and then user can easily switch betwei 
windows. 

• The feature of ‘Control Panel’ in windows helps the user to manipulate tl various 
hardware and software components of the computer system. You a easily add any 
kind of new software and hardware devices to your system. 

• Windows operating system also supports multimedia application program which 
help us to play songs, movies and animations etc. 

• The screensaver feature protects your computer’s screen from burning when it 
not being used over for a long period. 

• It has a special disk compression programs that help the user to store the da in 
hard disk in a compressed format, which result in saving a lot of disk space. 

• Windows supports powerful Plug-n-Play feature. This means, user can direct 
attach the peripheral device to the computer and windows automatically detec 
and installs required device drivers for the device. 

• Windows enables user to have file names up to 255 characters long, which w; 
limited to 8 characters in MS-DOS. 

• Windows automatically checks and repairs hard disk of computer through i 
scandisk utility, when it is started after an improper shutdown. 
Wi d  t  OLE (Obj t Li ki d E b ddi ) t  b d d li k   f 
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Fig. 5.1 (Start screen)

• Windows operating system provides built-in internet functionality to set up link 
and access internet with less amount of software and hardware requirement. 

• A vast number of utility softwares like: Notepad, WordPad, Ms-Paint and 
Calculator are available for use under windows platform. 

• Windows offer very easy and user friendly techniques to arrange file and folders on 
huge capacity disks. 

5.2 INTRODUCTION TO WINDOWS 8 
Windows 8 is an operating system launched by Microsoft for use on personal 

computers, including home and business desktops, laptops, netbooks and tablet PCs in 
2012 as an upgrade from Windows 7. Like earlier GUI based operating systems (Windows 
XP, Windows Vista and Windows 7), it also provides a Graphical User Interface (GUI) that 
allows user to visually interact with computer’s functions in a logical, fun and easy way. 

Windows 8 provides an entirely new user interface as compared to its predecessor. The 
goal of the new Windows 8 interface is to function on both traditional desktop PCs, such as 
desktop computers and laptops, as well as tablet PCs. Windows 8 supports both touch 
screen input as well as traditional input devices, such as a keyboard and mouse. 
5.2.1 Features of Windows-8 Operating System 

The Windows-8 Operating system provides many new tools and features that focus on 
improved productivity through improved usability. Some of the unique features of 
Windows-8 are: 

• Start screen: The main screen you'll use is called the Start screen, and it displays 
all of your apps as tiles. You can personalize your Start screen by changing the 
color scheme, choosing a background image, and rearranging your tiles. 

• Live tiles: Some apps use live tiles, which let you see information without even clicking 
on the app. For example, the Weather app displays the current weather on its tile, and 
you can click on it to see more details.  
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Fig. 5.3 (Hot corners) 

Fig. 5.4 (Charms bar) 
• Hot corners: You'll navigate through Windows 8 by using hot comers. To use a hot corner, 

just hover the mouse in the corner of the screen, and it will open a toolbar or tile that you 
can click. For example, to switch to another open app, you can hover the mouse in the 
top-left corner and then click, ff you're using a tablet, you'll swipe from the left or right 
instead of using hot corners. 

• Charms bar: Many of your computer's settings are now found in a toolbar called the Charms 
bar. You can access it by hovering in the top-right or bottom-right corner of the screen. If 
you're using a tablet, you can swipe from the right to open the Charms bar. 

• Cloud Computing: Many people are starting to save their files and other information 
online (also known as the cloud). One way to do this is with: Microsoft's OneDrive service 
(previously call SkyDrive). Windows 8 is designed to connect seamlessly to OneDrive, as 
well as to other online services like Facebook and Twitter. Instead of creating an account on 
your computer, you can sign in with your free Microsoft account. This will bring all of your 
OneDrive files, contacts, and more into your Start screen. 

• Social networking features: You can connect your Facebook, Twitter, and Flicker 
accounts to Windows 8, allowing you to see your friends' updates directly from your Start 
screen. 

• Fast Booting: In Windows-8 operating system, you can expect faster boot times than 
earlier Windows. The average Windows-8 machine will boot up in under 60 seconds. 

• Simplified Desktop for increased speed: Microsoft has not removed the Desktop, and 
you can still use it to manage your files or open many of your I existing programs. 
However, it has removed some of the transparency effects I that often caused Windows 7 
and Vista to run slowly. The new Desktop should I run more smoothly on most computers.
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• Press Enter. 
• The Windows sign-in screen appears. 

Fig. 5.5 (Windows Sign-in screen) 

• Start menu has been replaced: The Start menu was an important feature in earlier 
versions of Windows, but it has been replaced with the Start screen. You can use the 
Start screen to open programs or search your computer. 

• Improved security: Windows 8 has a built-in antivirus program called Windows 
Defender, which can also protect you from other types of malware such as spyware. The 
built-in Windows Store also helps to keep you and your computer safe by showing you 
what information each app will have access to. For example, some apps have access to 
your location, so if you're uncomfortable sharing your location you can decide not to 
download those apps. 

• Improved Search: One of the best things about Windows-8 is the improved search 
tool, which is able to find what you need quickly and easily. This enhanced search 
feature resembles the “auto-complete” function that is a familiar tool in Microsoft 
Word. The moment a user starts to type a word in the search field, Windows-8 will list 
items that match the typed characters. 

5.3 STARTING WINDOWS 8 
When you turn on your computer, Windows starts automatically, but you may have to 

navigate the sign-on screen along the way. To prevent other people from using your computer 
without your authorization, Windows requires you to set up a username and password. You 
supply this information the very first time you start your computer, when Windows takes you 
through a series of configuration steps. Each time you start your computer, Windows presents 
the sign-on screen, and you must enter your username and password to continue. 
To Sign into Windows 8: 

• Turn on your computer. After a few seconds, the Windows Lock screen appears. 
• Click anywhere on the lock screen to unlock the computer. 

OR 

• Click inside the Password box and Type your password  
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5.3.1 Explore the Windows Start Screen 
Before getting to the specifics of working with Windows, take a few seconds to familiarize 

yourself with the basic elements of the Start screen. These elements include the Start screen’s 
app tiles, user tile and live tiles. 

Fig. 5.6 (Windows Start screen)

 I A  Til  E h f h  l      



WINDOWS 5.7

 

• On the Start screen, locate and click the app 
you want to open. 

Fig. 5.8 (Start screen: App to open) 

Fig. 5.9 (Start screen: To close an App) 
• Click, hold, and drag the top of the app all the

way down to the bottom of the screen and then
release. The app will close, and you'll return to the

Start screen.

5.3.2 Working with Start Screen Apps 
Start screen apps are different from the “classic” Windows apps you may be used to. Apps 

fill the entire screen instead of opening in a window. . 
To open an App: 

• The app will open and fill the entire screen. 
To close an App: 

• Hover the mouse at the top of the app. The cursor will change to a hand icon.
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Charms Bar 

 

Fig. 5.12 (Search Charm)

5.4 CHARMS BAR 
The Charms bar is a toolbar that lets you access your computer's settings, along with 

other options. You can access the Charms bar by hovering the mouse in the top- right or 
bottom-right corner. 

Fig. 5.11 (Charms Bar) 
The Charms bar contains several icons, which are called charms, and each one 

contains different options: 
. s Search: The Search charm lets you find apps, files, or settings on your computer. 

However, a simpler way to search is to go to the Start screen and type the name of 
the file or app that you're looking for. 

. m Share: The Share charm is basically a copy and paste feature that is designed to be 
as convenient as possible. It allows you to “copy” information (such as a photo or 
web address) and “paste” it into another app. 
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Start: This switches to the Start screen. If you're already on the Start screen, it
will open the most recent app. 

Fig. 5.14 (Share screen)

1^0 Devices: This shows any hardware devices that are connected to your 
computer, such as printers or monitors. 

E3 Settings: This lets you access general settings for your computer, as well as 
settings for the app you're currently viewing. For example, if you're in Internet 
Explorer, you can go to the Settings charm to access your Internet Options. 

5.5 WORKING WITH APPS 
To perform tasks of any kind in Windows 8, you can use one of the apps installed on 

your computer. The application you use depends on the task you want to perform. For 
example, if you want to surf the World Wide Web, you use a web browser application, such 
as the Internet Explorer app that comes with Windows 8. 

To launch an App: 
There are several ways to open an app in Windows 8: 
• Click the app icon on the taskbar. 

OR 
• Double-click the app shortcut on the Desktop.
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Click the app tile in the Start screen. 

 

 

To search for a File or App: 
• Press the Windows key to switch to the Start screen, and then type what you're 

looking for. Your search results will instantly appear below the search bar. A list I of 
suggested web searches will also appear below the results. 

To view all of your Apps:
• Click the arrow in the bottom-left comer of the Start screen. 
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If the app is not free, tap Buy, instead, and then tap Confirm. 
• Windows 8 installs the app. 

5.6 ICONS 
The small pictures on the desktop are called icons. One type of icon is an object icon. 

Examples of object icons are Computer, Recycle Bin, and Internet Explorer. These icons allow 
us to open files and programs on your computer.
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Shortcut icons allow us to open an application quickly. These icons appear on your1 

desktop and with little arrow in the left corner. Desktop shortcuts or Shortcut icons are links 
to files and programs. You can add or delete shortcuts without affecting the programs on 
your computer. 

Microsoft Word 

Fig. 5.16 (Shortcut 

Icon) To open a program using an icon: 
• Place mouse over the icon. 
• Text appears identifying its name or contents. « 
Then, double-click the icon. 

5.7 CONTROL PANEL 
Control Panel is a part of the Microsoft Windows, which allows users to view and 

manipulate basic system settings and controls, such as adding hardware, adding and 
removing software, controlling user accounts, and changing accessibility options. 

Control Panel is full of specialized tools that are used to change the way Windows looks 
and behaves. Some of these tools help you to adjust settings that make your computer more 
fun to use. For example, Use Mouse to replace standard mouse pointers with animated icons 
that move on your screen, or Use Sounds and Audio Devices to replace standard system 
sounds with sounds you choose. 

To open the Control Panel: 
• From the Desktop view, hover the mouse in the lower-right corner to access the 

Charms bar, then select Settings. 

 

• Locate and select Control Panel from the Settings Pane. 
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• The Control Panel will appear. You can then select the desired setting to change it. 

> Uses of Control Panel 
• Setting display properties such as wallpaper, screensaver and color settings. 
• Setting keyboard properties character repeat rate. 
• Setting mouse properties like speed of movement and double click. 
• Setting multimedia properties like selecting the type of speakers. 
• Adding new hardware to computer. 
• Adding or Removing programs / softwares in windows. 
• Specifying the regional settings like time zone. 
• Managing different user settings. 

5.8 SHUT DOWN WINDOWS 
When you complete your work, you should shut down Windows. However, you do not 

want to just shut off your computer’s power. Instead, you should follow the proper steps to 
avoid damaging files on your system. 

Shutting off the computer’s power without properly exiting Windows can cause two 
problems. First, you may lose unsaved changes in open documents. Second, you could 
damage one or more Windows system files, which could make your system unstable. 

To Shut down Windows: 
• Shut down all your running programs. 
• Position, the mouse pointer in the upper-right or the lower-right corner of the 

screen to display the Charms menu and then click Settings.  
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• The Settings pane appears. 
— ill
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• Click the Power button (fSl). 

eptemher 9 

I “I 

• Click Shut down. Windows shuts down and turns off your computer. 
5.9 RESTART WINDOWS 

You can restart Windows, which means that it shuts down and starts up again 
immediately. This is useful if your computer is running slowly. Sometimes a restart solves 
the problem. 

To Restart Windows: 
• Shut down all your running programs. 
• Position the mouse pointer in the upper-right or the lower-right corner of the 

screen to display the Charms menu and 
then click Settings. 

2:57 
“m2 

• The Settings pane 
appears.  
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Fig. 5.17 (Desktop Tile on Start screen)
• Click the Power button ffl- 
• Click Restart. Windows shuts down and your computer restarts. 

5.10 CUSTOMIZING THE DESKTOP 
The desktop is your work area, where you can access everything you need to operate 

your computer, such as system components, applications, the Internet, etc. 
Although Windows 8 uses the Start screen for launching apps and other tasks, the 

Desktop view is still an important feature that you'll need to know how to use. 
To switch to the Desktop: 
• Click the Desktop tile on the Start screen. 
• . The following Desktop view will appear in Windows 8: 
The Desktop contains: 
• Start button: One of the most important tools you use while working with windows 

operating system. The Start button allows us to open menus and start applications. 
In Windows 8, once you are in desktop view, you may notice the traditional start 
button is a little different. While the button was missing in the original Windows 8, 
it was replaced with 8.1. However, the menu that it brings up is the metro or modem 

start menu and does not resemble the original.
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• Click the File Explorer icon on the taskbar, or double-click any 
folder on your desktop. A File Explorer window will open. 

• Taskbar: It is primarily used to switch between open windows and applications! 
By default, the taskbar is located on the bottom edge of the desktop. You ca click 
the taskbar and drag it to other locations. The Start button, active progra buttons, 
icons for quick access to programs, and the current time are located on| the 
taskbar. 

• Icons: The small graphical pictures on the desktop are called icons. One type < icon 
is an object icon. Examples of object icons are My Computer, Recycle Bin,, and Internet 
Explorer. These icons allow us to open files and programs on you computer. 

5.11 FILES AND FOLDERS 
Files are collections of information. In fact, almost all of the information stored in a 

computer is stored in a file. There are many different types of files, including operati system 
files, program files, and user-defined files. 

Different types of files store different types of information. Each file is given a jilename 
and has a three-letter filename extension that identifies the file type. The| filename and 
filename extension are separated by a period operator (.). 

Some common file name extensions are: 
doc: Word or WordPad document file txt: Notepad text file xls: Excel spreadsheet 
file htm or html: HTML file (web page) ppt: PowerPoint presentation file mdb: 
Access database file 
Windows stores files on your hard drive using special storage areas called folders, k 

folder is a location on your hard drive that contains one or more related files. You can also 
store folders within folders, and these nested folders are known as subfolders. 

In Windows 8, to work with the files and folders on your computer, you'll use the File 
Explorer app. In File Explorer, you can navigate to different folders, open files, delete files, 
and more. 

To view a File:
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Double-click the folder you want to view. Windows displays the contents of the 
folder, including subfolders. 
If the files you want to view are stored in a subfolder, double-click the subfolder. 
Windows displays the contents of the subfolder, rename 
a File: 
Locate the file. 
Right-click the file icon. 
Choose Rename. 
The filename is highlighted in blue, ready to be retyped. 
Type a new name and press Enter. 
The file is renamed, delete a File: 
Select the file which you want to delete. 
Right-click the on the file-icon. 
Choose Delete. 
A Confirm File Delete dialog box appears asking user 
whether he/she surely wants to send the file to the 
Recycle Bin. 
Choose Yes. 
The file is moved to the Recycle Bin. If you change your 
mind, you can move the file back to its original location. If 
you're sure you want to permanently delete the file, you will need to empty the 
Recycle Bin. copy a File: 
Open the folder containing the file you want to copy. 
Select the file. 
Click the Home tab and Click Copy. 

OR 
Right-click the file icon and Choose Copy from the pop-up menu. Windows 
places a copy of the file in a special memory location called the Clipboard. 
Open the location you want to use to store the copied file. 
Click the Home tab and then Click Paste. 

OR 
Right-click the folder icon in which you want to paste the copied file and Choose 
Paste from the pop-up menu, rename a Folder: 
Select the folder. 
Right-click on the folder icon. 
Choose Rename. 
The folder name is highlighted in blue, ready to be retyped. 
Type a new name and press Enter, delete a Folder: 
Select the folder. 
Right-click on the folder icon. 
Choose Delete. 
A Confirm Folder Delete dialog box appears asking user whether he/she 
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5.12 DRIVE 
A drive, or disk drive, is hardware on which user can store files and folders. Di drives 

are assigned a letter. 
• Hard drive (the drive inside your computer) is known as the (C:) drive. 
• Floppy disk drive is known as the (A:) drive. 
• If your computer has a CD ROM drive, it is usually called (D:) drive. 

Note: Every drive in your computer has a root directory or folder, which i: represented by 
a symbol ‘V (Back Slash). 

5.13 MY COMPUTER^ 
My Computer or Computer is a section of Microsoft Windows operating system tb was 

introduced with the release of Microsoft Windows 95 and included with all versio; of 
Windows after that. 

Although the name of “My Computer” has changed to “Computer” in Windows 8, b the 
default icon still acts the same as My Computer. 

 

To Open My computer or Computer: 
• Go to the Windows Desktop. 
• Double-click the My Computer or Computer icon, this icon is almost alwa; located 

on the top-left portion of the desktop and should look similar to the icc shown 
earlier. 

OR 
• You can also access My Computer or Computer through the Start menu, < 

shown below: 

 

Fig. 5.21 (Computer Icon)
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Fig. 5.23 (Exploring Computer)

5.13.1 Uses of My Computer 
• My Computer allow the users to explore the contents of their computer drives, 

whether it is hard drive, floppy drive, CDROM drive or even Pen drive. 
• It is a tool that you can use to manage files and folders. With this tool, you can 

create, rename and move folders and copy, print, move, delete and rename files. 
• It also allows you to gain access to other system tools. 

5.14 RECYCLE BIN 
Sometimes files and folders can litter your computer. Recycle Bin, the desktop icon that 

resembles a wastebasket, is a place where you put a file or folder if you want to delete it. 
Open the Recycle Bin anytime and see what's inside by double-clicking the Recycle Bin 

icon located on the desktop or using Windows Explorer. 
Inside, you will see a listing of deleted items. 

To Open the Recycle Bin window: 
• Double-click the Recycle Bin icon on the desktop. 

 

• Recycle Bin window will open. Fig. 5.24 (Recycle Bin Icon) 
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Fig. 5.26 (Minimize, 
Maxim' and Close 
Button) 

Minimize Close

To Fill the Recycle Bin: 
• Select the folders or files you no longer need, drag their icons to the Recycle B icon 

on the desktop, and drop them in. 
To Rescue stuff from the Recycle Bin: 
• Open the Recycle Bin and then select the icons for the items you want to resto 
• Click the Restore This Item button (if only one item is selected). 

Or 
• Click the Restore the Selected Items button (if multiple items are selected) on th 

Recycle Bin window’s toolbar. 
To Rescue all the stuff from the Recycle Bin: 
• Open the Recycle Bin and click the Restore All Items button on the Recycle B' 

window’s toolbar. 
To Empty the Recycle Bin: 
• Open the Recycle Bin and click the Empty the Recycle Bin button on Recycle B 

window’s toolbar. 
Keep in mind that choosing the Empty Recycle Bin command immediately gets rid 

everything in the Recycle Bin window. Don’t ever empty the Recycle Bin until after yo 
examine the contents and are absolutely sure that you 11 never need to use any of tho- items 
ever again. 

If you hold down the Shift key when pressing the Delete key, Windows displays j Delete 
File dialog box that asks you to confirm the permanent deletion of the select items. If you click 
the Yes button or press Enter, whatever you targeted for deletion do not go to the Recycle Bin; 
rather the item is instantly and permanently removed fro your computer. 

5.15 MINIMIZING, MAXIMIZING, AND 
RESTORING WINDOWS 

Windows allows user to easily enlarge, hide, or shrink a 
window using the Minimize, Maximize, and Restore buttons. 

The Minimize button is among the three buttons at the right 
end of the title bar. This button has a small dash (or minus sign). 
The Minimize button shrinks the window and places it on the 
taskbar while leaving the program running. 

The Maximize button, which looks like a small window, is used 
to enlarge a window to cover the entire desktop. 

After a window is maximized, the Maximize button changes to the Restore button. It 
looks like two windows near one another. If you clic the Restore button, the maximized 

window shrinks to its previous size (the size it 
w1 

before 
you 
maximi
zed it). 



WINDOWS 5.21

 

Fig. 5.28 (Calculator)

open (for example, if you open more than one file in a single program), Windows 
automatically groups open windows from the same program into a single, unlabeled taskbar 
button. You can point to a taskbar button to see a thumbnail preview of the window or 
windows it represents. 

To preview open Windows: 
• Point to a program button on the taskbar. 
• Point to a thumbnail. All other open windows temporarily fade away to reveal the 

selected window. 
• Point to a different thumbnail to preview a different window. 
• To open the window you are previewing, click the thumbnail. 

Note: To restore your desktop view, move your pointer away from the thumbnails. 

5.17 WINDOWS ACCESSORIES 
Windows operating system provides several accessories, or applications, that help you in 

your work. These accessories are not full-featured programs, but they are useful for specific 
jobs in the windows environment. Accessories include a calculator, a painting program 
(MS-Paint), a text editor (Notepad) and a word processor (WordPad). 
> CALCULATOR 

You can use calculator to perform any of the standard 
operations for which you normally use a handheld calculator. 
Calculator performs basic arithmetic operations, such as 
addition and subtraction, as well as functions found on a 
scientific calculator, such as logarithms and factorials. 
To Open Calculator: 
• Click Start All Programs -> Accessories Calculator. 
• For information about using Calculator, click the Help 

menu in Calculator. 
> PAINT 

Paint is a drawing tool that you can use to create black-and-white or color drawings. You 
can also use Paint to send your drawing in e-mail, set the image as a desktop background, 
and save image files using different file formats. 

 

To Open Paint: 
• Click Start -> All Programs -> Accessories -> Paint. 

Fig. 5.29 (Paint Window)
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• For information about using Paint, click the Help menu in Paint. 
> NOTEPAD 

Notepad is a basic text editor that you can use to open and edit text files. In Notepad, 
the File menu provides you the following commands, which are essential for editing 
text files: 
• New: To start a new text file. 
• Open: To open an existing text file for editing. 
• Save and Save As: To save changes to the text file you’re editing. 
• Page Setup: To modify the page settings for printing the text file you’re editing, 

including the paper size, source, 
orientation, margins, and header and 
footer. 

• Print: To print a hard copy of the text 
file you’re editing. 

To Open Notepad: 
• Click Start -> All Programs -> 

Accessories -> Notepad. 
• For information about using Notepad, 

click the Help menu in Notepad. 
> WORDPAD 

The WordPad accessory offers you very 
basic word processing. You can use WordPad to compose and print simple documents such 
as memos, letters etc. It is a word processor that is more advanced than Notepad, but not so 
advanced as Microsoft Word. 

Unlike the text editor accessory, Notepad, Windows 8 WordPad supports basic 
paragraph formatting in the form of indents, bulleted and numbered lists along with text 
enhancement, such as new fonts, font sizes, and text effects (Bold, Italic, Underline, 
Strikethrough, Subscript, and Superscript). The program even supports the addition of 
graphics files such as photos to its text documents. 

To open WordPad: 
• Click Start -> All Programs -> Accessories -> WordPad. 
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6,1 MICROSOFT OFFICE- AN INTRODUCTION 
The Microsoft Office suite is an essential collection of desktop applications that can assist 

user in many projects. It is a complete package includes number of application softwares 
like: Word, Excel, PowerPoint, Access and much more. Each program serves a different 
purpose and is compatible with other programs included in the package. The suite of 
programs is compatible with both the Windows and Macintosh operating system. You can 
write letters, perform numerical and logical calculations, prepare presentations, and 
maintain records etc. with the help of various tools available in Microsoft Office. 

The main components of Microsoft Office suit are Microsoft Word, Microsoft Excel, 
Microsoft PowerPoint, Microsoft Access, Microsoft FrontPage, Microsoft Outlook and 
Microsoft Publisher. 
• Microsoft Word 

Microsoft Word is a word processing program that enable user to create, edit, save and 
print documents. 

• Microsoft Excel 
Microsoft Excel is a spreadsheet program that lets user manipulate the data by using 
number of built-in functions. 

• Microsoft PowerPoint 
Microsoft PowerPoint is a presentation program which helps to create presentations for 
business settings. 

• Microsoft Access 
Microsoft Access is a database management program that lets user to store and organize 
data in a set of tables. 

• Microsoft FrontPage 
Microsoft FrontPage is a website development tool that allows users to create and 
manage web pages. 

• Microsoft Outlook 
Microsoft Outlook is an e-mail software program that allows users to send and receive 
e-mail. 

• Microsoft Publisher 
Microsoft Publisher is used to produce professional looking publications. With the 
layouts and templates in Publisher, you can create brochures, newsletters, invitations, 
business cards and more. 

6.2 MICROSOFT OFFICE 2010 
Microsoft Office 2010 is a version of Microsoft Office developed and published by Microsoft 

on June 15, 2010. It is the successor to Microsoft Office 2007. It is a desktop applications 
suite that allows both home and office users to create professional work. The programs 
included in Office 2010 are designed to work together, making typical office tasks faster and 
easier. 

Office 2010 introduced a new graphical user interface called the Fluent User Interface 
which uses ribbons (a panel that contains a fixed arrangement of command buttons and 





6.2 MS-WORD

 

Element 

icons) and an office start menu instead of menu bars and toolbars. The Ribbon is designed 
to help you quickly find the commands that you need to complete a task. Commands are 
organized in logical groups, which are collected together under tabs. 

Although each Office 2010 program specializes in storing and manipulating different 
types of data, they all work in similar ways. First, you have to enter data into an Office 2010 
program by typing on the keyboard or loading data from an existing file. Second, you have to 
tell Office 2010 how to manipulate your data, such as underlining, enlarging, coloring, or 
deleting it. Third, you have to save your data as a file. 

To help you understand this three-step process of entering, manipulating, and saving 
data, Office 2010 offers similar commands among all its programs so you can quickly jump 
from Word to PowerPoint to Excel without having to learn entirely new commands to use each 
program. 
6.2.1 Common Elements of Office 2010 

The Office 2010 programs consist of windows that have many similar features. Most of 
the elements in Word, Excel and PowerPoint program windows are the same. In fact, all the 
office programs have same elements. Certain information that you provide in one Office 2010 
program is made available to other Office 2010 programs so that you don’t have to provide it 
individually in each program. The following table describes some of the most common 
elements used in Office 2010 programs: 

Quick Access Toolbar Title Bar 
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Microsoft Office 
Backstage View 

Quick Access Toolbar 

Title Bar 

Ribbon 

The Microsoft Office Backstage View: appears in all Office 2010 
programs and isolates common file commands on a single screen so you 
can see all your options at once. It replaces the traditional File menu in 
older versions of Office and the Office Button in Office 2007. 
The Quick Access Toolbar is a customizable toolbar that contains a set 
of commonly used commands, such as Save, Undo, and Repeat. Title Bar 
contains the name of the open file, the program name and the sizing 
buttons. 
Ribbon is a combination of menu bar and tool bar. The Ribbon is designed 
to help you quickly find the commands that you need to complete a 
task. Commands are organized in logical groups, which  
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6.3 WORD PROCESSING 
Word processing enables the users to create and edit documents. To perform word 

processing, we need a computer, a special program called a word processor and a printer. A 
word processor enables us to create a document, store it electronically on a disk, display it on 
a screen, modify it by entering commands and characters from the keyboard, and print it on 
a printer. The most popular examples of word processors are MS-Word, WordPad and 
Notepad. 

The great advantage or benefits of word processing over using a typewriter are that we 
can make changes without retyping the entire document. If we make a typing mistake, we 
simply back up the cursor and correct our mistake. If we want to delete a paragraph, we 
simply remove it, without leaving a trace. It is equally easy to insert a word, sentence, or 
paragraph in the middle of a document. Word processors also make it easy to move sections 
of text from one place to another within a document, or between documents. When we have 
made all the changes we want, we can send the file to a printer to get a hardcopy. 
6.3.1 Features of Word Processing 

Word processing supports the following basic features that enable user to manipulate 
and format documents in more sophisticated ways: 

(a) WYSIWYG (what you see is what you get): With WYSIWYG, a document appears on 
the display screen exactly as it will look when printed 

(b) Insert text: Allows user to insert text anywhere in the document. 
(c) Delete text: Allows user to erase characters, words, lines, or pages as easily as we 

can cross them out on paper. 
(d) Cut and paste: Allows user to remove (cut) a section of text from one place in a 

document and insert (paste) it somewhere else. 
(e) Copy: Allows user to duplicate a section of text. 
(f) Page size and margins: Allows user to define various page sizes and margins, 

and the word processor will automatically readjust the text so that it fits. 
(g) Search and replace: Allows user to direct the word processor to search for a 

particular word or phrase. We can also direct the word processor to replace one 
group of characters with another everywhere that the first group appears. 

(h) Word wrap: The word processor automatically moves to the next line when we 
have filled one line with text, and it will readjust text if we change the margins. 

(i) Print: Allows user to send a document to a printer to get hardcopy. 
(j) Font specifications: Allows user to change fonts within a document. 
(k) Graphics: Allows user to embed illustrations and graphs into a document. 
(l) Headers, footers, and page numbering: Allows user to specify customized 

 are collected together under different tabs. Each tab relates to a 
type of activity, such as writing or laying out a page. 

Microsoft Office Help 
Button 

Opens the Help window for Office program. 

Workspace Displays the file you are working on (Word document, Excel 
workbook, Access database, or PowerPoint slide.) This is the place 
where you perform all of the functions associated with your office 

 program. 
Status Bar Provides information about the program, open file, or current task 

as well as the view shortcuts and zoom controls. 
Zoom Controls Magnify or shrink the contents displayed in the workspace. 
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(m) Spell checker: A utility that allows us to check the spelling of words. It will 
highlight any words that it does not recognize. 

6.3.2 Applications of Word Processing 
Word Processing has a variety of uses and applications within the business world, home, 

and education. 
• Businesses organizations have a tendency to have their own format and style for any 

documents produced. In business, word processing is used for producing business 
letters, applications, memos, reference documents etc. 

• In the home, word processing tends to be educational, planning or business related, 
dealing with assignments or work being completed at home, like- writing short 
stories, letter writing, resume creation and so on. 

• In education, word processing is used in a variety of different ways in the production 
of assignments, notes, exams, and for practicing its uses. 

6.4 MICROSOFT WORD 
Microsoft Word is the powerful word processing application software in the Microsoft 

Office Suite. It allows you to create a variety of professional-looking documents such as 
letters, brochures, and more. It enables you to store a document electronically on a disk, 
display it on a screen, modify it by entering commands and characters from the keyboard, 
and print it on a printer. 

It was initially launched in 1983 under the name Multi-Tool Word and has since been 
revised numerous times. Microsoft Word is available on both Windows and Macintosh 
operating systems. Microsoft Word is often called simply Word or MS Word. 

Microsoft released Word 2010 (included in Office 2010) on June 15, 2010 and this time 
Microsoft has definitely done a massive makeover. Microsoft has redesigned the way you 
interact with the program and has redefined the underlying document format. 

Word 2010 lets you easily create professional-looking documents using various themes, 
visual designs, formatting tools, and sharing features. It allows you to create various types of 
documents such as letters, papers, flyers, and faxes. 
6.4.1 Features of Word 2010 

Word 2010 helps people create professional-looking documents by presenting a 
comprehensive set of writing tools in a new user interface. It supports the following 
important features that enable user to manipulate and format documents in more stylish 
ways: 

• New User Interface: The Microsoft Office Backstage View is a new component of 
Word 2010. It appears in all Office 2010 programs and isolates common file 
commands on a single screen so you can see all your options at once. It replaces the 
traditional File menu in older versions of Office and the Office Button in Office 2007. 

• Create Professional-Looking Documents Effortlessly: Word 2010 provides 
editing and reviewing tools that help you create professional documents more easily 
than ever before. 

• Communicate more effectively with high-impact graphics: New charting and 
diagramming features that include 3-D shapes, transparency, drop shadows, and 
other effects help you create professional-looking graphics that result in more 
effective documents. 

• Built-in Table Styles: Tables are a great way to present information. In Word 
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individual result. The improved Navigation Pane provides you a visual outline of your 
document so you can browse, sort and find what you need. 

• Co-authoring in real-time: Word 2010 redefines the way people can work together 
on a document. With co-authoring, you can edit papers and share ideas with others at 
the same time. SharePoint Foundation Services or a Windows Live account is 
required. 

• Share documents: Word 2010 lets 3rou post your documents online and then access, 
view, and edit them from almost any computer or your Windows phone. 

• Image Editing: New picture-editing tools in Word 2010 enable you to add special 
picture effects without additional photo-editing software. You can easily adjust 
pictures with color saturation and temperature controls. You also get improved tools 
for easier and more precise cropping and image correction. 

• Recover lost draft: After working on that document for awhile, did you accidentally 
close it without saving? Worry not. Word 2010 lets you recover draft versions of 
recently edited files as easily as opening any file, even if you never saved the 
document. 

• Word translation: Word 2010 helps you work and communicate across different 
languages. It translates a word, phrase, or document more easily than before. You can 
set separate language settings for ScreenTips, Help content, and displays. 

6.5 STARTING MICROSOFT WORD 2010 
To start Microsoft Word 2010 from the Start Menu: 
• Click on the Start button, point to All Programs then click on Microsoft Office and 

click on Microsoft Word 2010. 
• This will launch Microsoft Word 2010 application and the first screen that you will see 

a new blank page document. 
Following is the basic window which you get when you start word application:  
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Let us understand the various important elements of this window: 
• File Tab: The File tab replaces the Office button from Word 2007. You can clic it to 

check Backstage view, which is the place to come when you need to open c save files, 
create new documents, print a document, and do other file-relate operations. 

• Quick Access Toolbar: The Quick Access Toolbar you will find just above th File tab 
and its purpose is to provide a convenient place for the Word mos frequently used 
commands. You can customize this toolbar based on you comfort. 

• Ribbon: Ribbon contains commands organized in three components: 
(i) Tabs: Tabs appear across the top of the Ribbon and contain groups ( related 

commands. Home, Insert and Page Layout are the examples ( ribbon tabs. 
(ii) Groups: Groups organize related command. Each group name appear below the 

group on the Ribbon. For example: Group of commands relate to fonts (Font 
group) or group of commands related to alignmer (Paragraph group) etc. 

(iii) Commands: Commands appear within each group as mentioned abov< For 
example: Bold, Italic and Underline are the commands appear unde Font group of 
Home tab. 

• Title bar: Title bar lies at the top of the window. It shows the program an document 
titles. 

• Rulers: Word has two rulers - a horizontal ruler and a vertical ruler. Th horizontal ruler 
appears just beneath the Ribbon and is used to set margins an tab stops. The vertical 
ruler appears on the left edge of the Word window and i used to measure the vertical 
position of the elements on the page. 

• Help: The Help Icon can be used to get word related help anytime you like. Thi provides 
tutorial on various subjects related to word. 

• Zoom Control: Zoom control lets you zoom in for a closer look at your text. Th zoom 
control consists of a slider that you can slide left or right to zoom in or ou + and - buttons 
you can click to increase or decrease the zoom factor. 

• View Buttons: The group of five buttons located to the left of the Zoom contro near the 
bottom of the screen, lets you switch among Word's various documer views. 

(i) Print Layout view: This displays pages exactly as they will appear whe printed. 
(ii) Full Screen Reading view: This gives a full screen look of the document. 

(iii) Web Layout view: This shows how a document appears when viewed by Web 
browser, such as Internet Explorer. 

(iv) Outline view: Outline view divides a document into sections defined b headings 
and text. A heading represents a main idea. Text contains one c more paragraphs 
that are attached to a particular heading. 

(v) Draft view: This displays the document without top or bottom pag margins, 
where page breaks appear as dotted lines. For example, header and footers are 
not shown. 

• Document Area: Document area is the area where you type. The flashin vertical bar is 
called the insertion point and it represents the location where te> will appear when you 
type.
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• Status Bar: This displays document information as well as the insertion point 
location. From left to right, this bar contains the total number of pages and words in 
the document, language etc. 

• Dialog Box Launcher: This appears as very small arrow in the lower-right comer of 
many groups on the Ribbon. Clicking this button opens a dialog box or task pane that 
provides more options about the group. 

6.6 BACKSTAGE VIEW 
One major change in Office 2010 is the Microsoft Office Backstage View, which replaces the 

traditional File menu in older versions of Office and the Office Button in Office 2007. 
The backstage view helps in creating new documents, saving and opening documents, 

printing and sharing documents, and so on. However, instead of just a menu it is a full- page 
view, which makes it easier to work with. 
The backstage view screen works under three panes: 

(i) The left pane of the Backstage View lists common commands for creating, saving, 
or printing your file. 

(ii) The middle pane typically displays additional options you can choose for the 
command selected in the left pane. 

(iii) The right pane displays additional details about your file. 

 

Fig. 6.3 (Backstage View Screen) 

To use the Backstage View, follow these basic steps: 
1. Click the File tab, located in the upper-left comer of the Word Ribbon to display 

the Backstage View. You can also open the Backstage View by pressing Alt+F. 
2. Select a command in the left pane to view your options in the middle pane. 
3. Select an option in the middle pane. 
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The various commands available on the File tab include: 



 

Note: Sometimes when you select a command in the left pane (such as the Save
command), you won’t see any further options in the middle or right panes. Likewise,
sometimes when you select an option in the middle pane, you won’t see any additional
information displayed in the right pane. 

Note: To exit the Backstage View, click the File tab again or press Esc button on the
keyboard. 



 

equivalent to the Save As command. 
• Save As: Save the current file under a new name and/or in a different file format. 
• Open: Loads an existing file. 
• Close: Closes an open file but keeps the Office 2010 program (Word) running. 
• Info: Displays the information about the current file. 
• Recent: Displays a list of files that you recently loaded. 
• New: Creates a new file. 
• Print: Prints the current file.
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• Save & Send: This option will save an opened document and will display options to 
send the document using email etc. 

• Help: ^ 'ou can use this option to get required help about Word 2010. 
• Options: Allows you to set various options related to Word 2010. 
• Exit: Closes any open files (documents) and exits the program (Word). 

6.7 RIBBON SYSTEM 
In Word 2010, menu bar and toolbar have been replaced by the tabbed Ribbon system. 

Ribbon is a combination of menu bar and tool bar. The Ribbon is designed to help you quickly 
find the commands that you need to complete a task. Commands are organized in logical 
groups, which are collected together under tabs. 

 

 

rue HI -tome Insert Page Layout References Mailings Review' E Wev» ©I 

e ;  
Paste .... 

- xjr : 
Calibri (Body) - 11 r •— - - V-- tF =F B I U -afee X. X < » « * ■ 
A* A' A.- A* A’ ': ffl- zl sr 

hi fa 
Quick Change i 
Styles - Styles- j 

(ft j 
Editing 

; Clipboard Font 1 Paragraph . * | Styles fit 
Groups under Tab 4-—1 

 

Fig. 6.6 (Ribbon) 
Let us summarize different groups comes under various tabs of the ribbon: 

> Home Tab 

Fig. 6.7 (Home Tab in the Ribbon) 

Icon Description 
Clipboard 
 

; pf i§ 

Paste 

 Pastes the contents of the clipboard in the cursor’s 
current location. 

   Removes the currently selected item from the 
document and places it on the clipboard. 

 
i 

 Copies the currently selected item to the clipboard 
(while leaving it in the current document also). 

 

/ 
 Copies the formatting of the currently selected item to 

apply to the next selected item. 
0 Shows the clipboard and other options. 

Font 

Calibri (Body) 
Font. 

3 
1 __ 

Font size. 
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 f*i! 
I 

A

 Clear formatting from the selected item. 

 \B 
 Bold. 

EL  Italics. 

 u - 
I 

Underline (the arrow will give you line options). 

 
Am 

 
Strikethrough. j 

 
x, 

 
Subscript. 

 
X 

 Superscript. | 

 
Aa" 

 
Options for changing the case of words. 

   Highlight the selected item (the arrow will give you 
color options). 

[ A" 
 Font color. 

Paragraph 
 » — W &   Bulleted list (the arrow will give you bullet options). 
 * — 2 -  T s— 

 Numbered list (the arrow will give you numbf 
options). 

 i --  
a— 

 Multi-level list (the arrow will give you level 
options). 

 
*§: 

 Decrease indent. 

   Increase indent. 

 ■i  Left align. 

 

W- 
 Center align. 

 ■I  Right align. 

   Justify. 

 Line spacing.  

IN
I i 

  

I 
Paragraph shading (the arrow will give you cok 
options). 

 

ffl' 

 Paragraph border (the arrow will give you bord 
options). 

Q More paragraph formatting options. 
Styles 

 

AaBbCc 
 Applies the quick style to the selected text. 
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> Insert Tab 

 

 

&  
Change 
Styles - 

 Change style set, colors, or fonts. 

 0  More style options. 
Editing 

 Find T Find text in the document. 
 f3C 

Replace 
 Replace text in document. 

 

^ Select - 
 Item selection options (Select All, Select Objects, and 

Select Text with Similar Formatting). 
 

Fig. 6.8 (Insert Tab in the Ribbon) 

Icon Description 
Pages 
 

j Cover Page * 
 

Insert cover page. 
 

j Blank Page 
 

Insert blank page. 
 ►r§j PaQe 

Break 
 Insert page break. 

Tables 
 

Table 

 Insert a table. 

Illustrations 
 

- 
 Insert a picture from a file. 

 MM 

dip 
Art 

 Insert Microsoft clip art. 

 

[jj) Shapes ” 
 

Insert shapes or drawing canvas. 
 SmartArt |  Insert a Smart Art diagram. 

 fib Chart  Insert a chart. 

Links 
 

Hyperlink 
 

Insert a hyperlink to a website. 
 

/fy Bookmark 
 

Insert a bookmark. 

^ Cross-reference Insert a cross-reference. 
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Header & Footer 

Header *• Insert or edit a header.

Footer Insert or edit a footer.

A 
\ 

Text 
Box’ 

 Insert a text box. 

J Quick Parts ’ Insert a document quick part (Author, Abstract, Title, 
etc)  

WordArt '■  Insert Word Art. 

— Drop Cap Changes the first letter of the selected paragraph into a 
large letter while keeping the rest of the text normal 
i d  

Signature Line - Insert a signature line. 

jjj, Date &Time Insert the date and/or time. 

^ Object - | . Insert a range of other types of objects. 
Symbols 

K Equation ’ 
 Insert an equation (the arrow provides built-in 

equations). 
SI Symbol *■  Insert a symbol. 

Page Number Insert a page number. 

Text 

> Page Layout Tab 
WBKM Home Insert Page Layout References Mailings Review View <X> Q 

W’ f] & Orientation ’ ^ 
*=» “=* l3 Size - m* 

Themes .—. Margins _______  
» |0]T . 11 Columns v i>?'» 
rheums 

2 Watermark - Indent Spacing ^ Page Color - it O' C ; 0 pt : 
Arrange 

i!j Page Borders ; gS O' * JJ lOpt * 
Page Background ; Paragraph r; j. 

 

Fig. 6.9 (Page Layout Tab in the Ribbon) 

Icon Description 
Themes 

M 
The
mes 

 Change document theme (only works if using styles). 

S' 

 Change theme colors. 

IAJ’"  Change theme font. 

—~1  Change theme effects. 
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Jj5 Orientation ’ 
 Set page orientation. 

 IJ Size ” 
 Set page size. 

 == Columns T Split the page into columns. 
 ^ Breaks r  Set page & section breaks. 

s j Line Numbers 
 

Show line numbers & line number settings. 

b ?- Hyphenation  Hyphenation settings. 
 rs More page setup options. 

Page Background 
 

J] Watermark T 
 Set watermark. 

 
v*] Page Color - 

 
Set page background color. 

 £2 Page Borders  Set page borders. 

Paragraph 
 

Indent 
w o- : 
t* o- : 

 Change left and right indentation. 

 Spacing 
IS 0 pt : 
:s o pt : 

 Change the spacing before and after the paragraph. 

ED More paragraph options. 
Arrange 
 

1 

Position 

 Set the position of an object in relation to the text. 

H Jj| Bring to 
Frani up- 

Bring selected object to front of all other objects. 

 Send to Back w Send selected object to back of all other objects. 

 Text 
Wrapping •1 Set how the text will wrap around the object. 

 |z? Align *■   Set object alignment. 
 

p 
 Group objects together. 

 Cl Rotate T |  Rotate object. 
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Icon 
Table of Contents

 

Table of 
lontents 

 Create a table of contents. 

[_£j* Add Text Add text that will show in the table of contents. 
 

Update Table 
 Update the table of contents to show the correct page 

numbers. 

Footnotes 
 

AB1 
Insert 
Footnote 

 Add a footnote. 

 

.ji] Insert Endnote 
 Add an endnote. 

   Navigate to the next footnote (the arrow allows you other 
footnote and endnote navigation). 

  

 J Show Notes p  Scroll the document to show the location of footnotes and 
endnotes. 

 

13 More footnote and endnote options. 
Citations & Bibliography 
 

£ insert 
Citation - 

 Add a citation. 

 1 Tin age 
Sources 

 View the list of all sources cited. 

 l| 
Sty e: APA 

 Select the citation format for the document. 

 ^3 Bibliography 
T 

 Create a bibliography. 

Captions 
 j 

aaj^j 

insert 
Caption 

 Add a caption to an image. 

jjJ Insert Table of Figures Insert a table of all figures in the document. 

   Update the table of figures to include all entries. 

 
Cross-reference  Insert a reference to an item in the document. 
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> Mailings Tab 

Fig. 6.11 (Mailings Tab in the Ribbon)
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Insert Merge
Field - 

Rules T

m 
i 
c- 
JI 

Match 
Fields

] Match the source fields to the Word defined fields.

£} Update Labels [

Preview Results 

Preview
Results

^j!| Find 
Recipient |

Auto Check for Errors 

Insert a merge field. 
Create rules to help select recipients. 
Update labels to use information from the recipient 
list. 

Replaces the merge field place holders with actual 

recipient data. 
Navigate through the recipient list in the preview. 

Search for a specific recipient for previewing. 

Specify how to handle errors.

 

Complete the mail 
merge.

 
> Review Tab 

 

■BT '—~ ------------------------------------------------------------------------------------------------------------------------------------------------------------------- f§|—B --------- I -------------- 77R55 
X i i ,  Home Insert Page Layout References Mailings Review View & 

^
5 

% f 
Translate Language 

V V 
language 

a 
a

 

-]>♦ Jj Fin-1 Shj Markup - ^ 
1 Show Markup- ^ § Track _ Accept .... Changes - H 

Reviewing Pane - . 
Tracking Changes 

3 
Compare 

Compare 

k H 
Block Restrict 

Authors Editing 
Protect 

 

Fig. 6.12 (Review Tab in the Ribbon) 

Icon Description 
Proofling 
 

Spelli
ng 8 
Gram
mar 

 Check the document for spelling and grammar errors. 

Si Research 
 Open research task pane (dictionary, encyclopedia, and 

translation service.) 
Thesaurus  Suggest words similar to the highlighted word. 

 ABC 1 
iHI 1 

 Word count. 

Finish 

Finish 
& 
Merge - 
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Set the language used by the spell check. 

Comments 
 □ 

New 
Comme

nt 

 Create a new comment. 

 
•22 1  

Delete comment(s). 
 

tl 
 Navigate to the previous comment. 

   Navigate to the next comment. 

I Tracking 
 

J* 
Track 

Changes - 

 Track all changes made to the document (the arrow gives 
you tracking options and user name change). 

r 

Qa 
Balloons 

 Choose how to show revisions in the document. 

: ‘ §b Final Showing Markup »J Choose how to view the proposed changes to the document. 

 _] Show Markup T Choose the kind of markup to show in the document. 

 
■,Sl Reviewing Pane -1 Show revisions in a separate window (the arrow gives you 

pane options). 
Changes 

 

Accept 

 Accept the current change and move to the next proposed 
change (the arrow gives you acceptance options). 

  5^ 
Reject m§:; 

Reject the current change and move to the next proposed 
change (the arrow gives you rejection options). 

 

 
Previoi JS Navigate to the previous proposed change. 

 
Next  Navigate to the next proposed change. 

Compare 
 

3 
Compare  Compare or combine multiple versions of a document. 

  Choose which source document to show. 
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Home Insert' Page layout References Mailings Review
0 Aj H eg New Window CO HP ' m s Arrange AH j il|. i 

Switch Macros ai 
Windows’* j 

Document Views Show ZoprS Windo
w 

Macro 

Show 

Zoom 

Print 
Layout 

Full Screen 
Reading 

E4 Web Layout 

Outline 

Draft 

•/ Ruler 

Gridlines 

Navigation Pane 

Zoom 

100% 

IB 0lie Page 

jj Two Pages 

Page Width

View the document full screen. 

View the document as it would appear as a web document.

View the document as an outline. 

View the document as a draft to quickly edit text (headers
and footers will not be available in this view). 

Check the box to show the ruler in the document. 

Check the box to show the gridlines in the document. 

Allow you to navigate through the document by heading,
by page etc. 

Open the zoom dialog. 

View the document at actual size. 

Zoom the document to fit one page in the window. 

Zoom the document to fit two pages in the window. 

Zoom the document to fit the page width in the window  

> View Tab 

:?||B|] ^ Web Layout (O Ruler 
3 Outline O Gridlines 

Full Screen _ _ Zoom 100% __ .  ______   
Reading l=iilDraft H Navigation Pane *8 E3 Split 

Fig. 6.13 (View Tab in the Ribbon) 

Icon 
Document Views 

View the document on the screen as it will appear on the 
printed page.  
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5 Arrange All 
 

Tile all open windows side-by-side on the screen. 

 3 Split I 
Split the current window in 2 parts to view 2 sections of the 
document at the same time. 

 

JJ 
 

View 2 documents side by side to compare contents. 

 

X 
 Only available in side-by-side view - scroll the documents at 

the same time. 
  Only available in side-by-side view - reset the window 

positions so each document has an equal amount of the 
screen. 

 g
e

 Switch to a different window. 

Macro 
 

Macros 

 View the list of macros (the arrow gives you the option to 
view, record, or pause macros). 

 

Sample My templates l^lew from 
templates existing 

Print 

Save 3t Send 

6.8 CREATING A NEW DOCUMENT 
Word files are called Documents. When you start a new project in Word, you'll need to 

create a new document, which can either be blank or from a template. 
Each time you create a new document, you have the option of choosing different types of 

templates that are already formatted and designed for specific purposes, such as a calendar, 
newsletter, sales report, or corporate slide show presentation, as shown in Figure 6.14(a). 

To create a new document, follow these steps: 
1. Click the File tab. 

The Backstage View appears. 
2. Click New. 

A list of templates appears (see Figure 6.14(a)). 
3. Double-click the template you want to use. 

Word 2010 creates a new document based on your chosen template. 
llgl; ?bs| ~ $3 j,~ Document! - Microsoft Ward e=i ED 22 

Home Insert Page Layout References Mattings Review View 

Avatfiaifeie 

Templates •+" Home 

Jlk 

Fig. 6.14 (a) (Creating a New Document - Using Templates) 

OR

H 





 

Fig. 6.14 (b) (Creating a New Document - Using New Button) 

OR 
5. Press Ctrl + N key combination from the keyboard. 

6.9.1 Inserting File 
If you want to insert text from another file or 

document into the document that you are working on, then 
you have to perform the following steps: 

1. First of all, open the file or document in which 
you want to insert the text. 

2. Now, move the insertion point at that position 
where you want to insert the text. 

3. On the Insert tab, in the Text group, click the arrow next to Object, and then 
click Text from File. 

A 3 111 ’ H Signature
Line » 

Word Art - OH Date
& Time 

H Dfep Cap Object! ” 1 

Text
Box'*

Object... 
A, KjJ Text from

fHe;..

Fig. 6.15 (Inserting Text from File)

Insert File dialog box will appear. 

Fig. 6.16 (Insert File Dialog box)

6.9 INSERING TEXT 
Once you have created a new word document, you can type or insert the text that you 

want to appear in your document. The insertion point (also called a cursor) is the blinking 
line that indicates where text will be inserted when you begin typing. 

To move the insertion point: 
• Use your mouse to move your insertion point anywhere within the file. Move your 

mouse until the I-beam is where you want your insertion point and click. 
• Use your keyboard's arrow keys to move your insertion point up, down, left, or right. 

These movements will move your insertion point one space or line at a time. This 
method is especially useful if you only need to move a few spaces or line back in a 
file to make a correction. 

• Hold the Ctrl key (Control key) and press up or down arrow keys to jump up or 
down a paragraph at a time. 

• Press Pg Up/Pg Down to jump up/down the document one page at a time.
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4. In the Insert File dialog box, locate the file that you want, and then doubleclick 
it. 

5. Now the contents of the selected file would be inserted at that point in your 
currently opened document. 

Note: If you want to insert the header and footer also, be sure to insert the text from the 
file in a new section so that the header and footer are applied to only those pages. 

6.10 OPENING AN EXISTING DOCUMENT 
There may be a situation when you open an existing document and edit it partially or 

completely. 
To open an existing document, follow these steps: 

1. Click the File tab. 
The Backstage View appears. 

2. Click Open. 
An Open dialog box appears, as shown in Figure 6.17 

3. Finally locate and select a file which you want to open, and then click Open. Your 
chosen file appears, ready for editing. 

 

6.10.1 Opening a recently used document 
As a shortcut, Word 2010 keeps track of your most recently opened documents and 

stores them in a list so you can find them again. If you need to open a document that you 
opened earlier, you may find it much faster by locating it through this list of recently opened 
files. 

To open a recently used document, follow these steps: 
1. Click the File tab. 

The Backstage View appears. 
2. Click Recent. 

Fig. 6.17 (Open Dialog box)
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HOME 
END 
Ctrl + HOME 
Ctrl + END 

Document! - Microsoft Word Page Layout

 References Mailings 

Fig. 6.18 (Opening a Recent used Document) 

Note: The list of recently opened documents changes each time you open a different I file. 
If you want to keep a particular filename always displayed on this list, click the I Pin icon 
that appears to the right of the filename. 

6.11 EDITING DOCUMENTS 
Editing a document refers to changing or modifying the contents of an existing file. I In 
simple terms, editing deals with: 

1. Adding additional contents into an existing document. 
2. Deleting some contents from an existing document. 
3. Modifying contents by replacing them with some other contents. 
To enter text just starts typing. The text will appear where the blinking cursor is 

located. Move the cursor by using the arrow buttons on the keyboard or positioning the 
mouse and clicking the left button. The keyboard shortcuts listed below are also helpful 
when moving through the text of a document: 

Move 
Actio
n 

Beginning of the file 
End of the file Top of 
the document End of 
the document 

6.11.1 Adding additional contents into an existing document 
To add a particular word at a particular location, you have to set the cursor at the I 

desired location. This can be done either by using the keyboard arrow keys or through | 
mouse. Arrows keys alternatively referred to as cursor keys are used to move the cursor j on 
the screen. Mouse can also be used for specifying the location of the cursor. Simply, I move 
the mouse cursor to the desired location and click there. 

Text can be inserted in a document at any point using any of the following methods: I 
• Type Text: Put your cursor where you want to add the text and start typing. 
• Copy and Paste Text: Highlight the text you wish to copy and right click and click 

Copy, put your cursor where you want the text in the document and right click and 
li k P  
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6.11.3 Modifying contents by replacing them with some other contents 
While working on editing a document you come across a situation very frequently when you
want to search a particular word in your document and will be willing to replace this word
with another word at few or all the places throughout of the document. This can be done by
using Find and Replace option in Word 2010. 

 

To delete or erase text in your document, use the Backspace and Delete keys on your 
keyboard. The Backspace key erases the text to the left of the insertion point one character 
at a time, whereas the Delete key erases the text to the right of the insertion point. 

To delete a large selection of text, highlight it using any of the methods outlined above 
and press the DELETE key. 

Once you are done with typing in your new word document, it is time to save your 
document to avoid losing work you have done on a Word document. 

Saving a file stores all your data permanently on a hard disk or other storage device. 
Following are the steps to save a word document: 

1. Click the File tab and select Save As option. 
File tab Save As 

jortion of the text: 
Selection Technique 

Whole word Double-click within the word. 
Whole paragraph Triple-click within the paragraph. 
Several words or lines Drag the mouse over the words, or hold down SHIFT while 

using the arrow keys. 
Entire document Choose Editing -> Select -> Select All from the Ribbon 

OR Press Ctrl + A. 

6.11.2 Deleting some contents from an existing document
To delete seme content from an existing document, it must be selected or highlighted 

first. Select the text by dragging the mouse over the desired text while keeping the left 
mouse button depressed, or hold down the SHIFT key on the keyboard while using the 
arrow buttons to highlight the text. The following table contains shortcuts for selecting a 





 

2. A Save As dialog box appears, as shown in Figure 6.20.

Fig. 6.20 (Save As Dialog box} 

which you want to give to your document and click on Save button. 

6.24 ____________________________________________  MS-WO 
6.12.1 Saving New Changes 

There may be a situation when you open an existing document and edit it partially or 
completely, or even you would like to save the changes in between editing of the document. 
If you want to save this document with the same name then you can use either of the 
following simple options: 

(a) Press Ctrl + S keys to save the changes. 
(b) Click on the floppy icon available at the top left comer and just above the File tab. 
(c) Use the Save option available just above the Save As option under File tab. 

If your document is new and it was never saved so far, then with any of the three 
options, word would display you a dialogue box to let you select a folder, and enter 
document name as explained earlier. ________________  __________   ________________ i 
Note: 
♦ Choose Save As to rename a document. Be careful not to overwrite your original 

file. 
♦ _ Save periodically when you are working in an application. Losing information is 

 ____ never fun. You can quickly save by using the quick- key combination Ctrl + S. 
6.12.2 Saving a document for older versions 

In Word 2010, by default the document file will be saved with extension .docx. If you 
need to share your document files with people using older versions of Microsoft Word, then 
you need to save your files in a different file format known as 97-2003, such as Word 97-2003 
document This special 97-2003 file format saves Office 2010 files so that previous versions of 
Microsoft Office 97/2000/XP/2003 can open and edit your files. 

When you save your files in the 97-2003 format, Word 2010 saves your files with a 
three-letter file extension, like .doc. 

When you save your files in the Word 2010 format, it saves your files with a fo letter file 
extension, such as .docx. 

To save your Word 2010 files in the 97-2003 format: 
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The Save As dialog box appears. 

Fig. 6.22 (Save As Dialog box)

Click Save & Send. 
The middle pane displays different options. 
Click Change File Type under the File Types category. 
A list of different formats appears, as shown in Figure 6.21. 

Click the 97-2003 format option, such as Word 97-2003 document. 
Fig. 6.21 (Saving a File: Word 97-2003 Format) 

5. Select a folder where you would like to save the document, Enter file name which 
you want to give to your document and click on Save button. 

Note: To save document file as a PDF, select PDF option from the Save as type drop 
down menu. 
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To close a file, follow these steps: 
1. Click the File tab. 

The Backstage View appears. 
2. Click Close. 

If you haven’t saved your file, a dialog box appears asking whether you want tor 
save your changes. 
For a faster way to choose the Close Command, press Ctrl+F4. 

3. Click Yes to save your changes, No to discard any changes, or Cancel to keep! 
your file open. If you click either Yes or No, Word 2010 closes your file. 

6.14 FORMATTING A DOCUMENT 
To create and design effective documents, you need to know how to format text. In j 

addition to making your document more appealing, formatted text can draw the reader's | 
attention to specific parts of the document and help communicate your message. 

To Format Font Size: 
• Select the text you wish to modify. 
• Left-click the drop-down arrow next to the font size box on the Home tab. The 

font size drop-down menu appears. 
• Move your cursor over the various font sizes. A live preview of the font size will 

appear in the document. 
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Fig. 6.23 (Font Size Box in Home Tab) 
• Left-click the font style you wish to use. The font style will change in the document.
To Format Font Color: 
• Select the text you wish to modify. 
• Left-click the drop-down arrow next to the font color box on the Home tab. The 
font color menu appears. 
• Move your cursor over the various font colors. A live preview of the color will appear
in the document. 
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Fig. 6.25 (Font Group: Bold, Italic and Underline) 

To 

Fig. 6.26 (Change Case in Font Group on 

Home Tab) 

• Left-click the font color you wish to use. The font color will change in the document. 
To Use the Bold, Italic, and Underline Commands: 
• Select the text you wish to modify. 

• Click the Bold, Italic, or Underline command in the Font group on the 
Home tab. 

Change the Text Case: 
Select the text you wish to modify. 
Click the Change Case command in the Font group on the Home tab. Select 
one of the case options from the list. 

To Change Text Alignment: 
• Select the text you wish to modify. 
• Select one of the four alignment options from the Paragraph group on the Home tab. 

o Align Text Left: Aligns all the selected text to the left margin, o Center: Aligns text 
an equal distance from the left and right margins, o Align Text Right: Aligns all the 
selected text to the right margin, o Justify: Justified text is equal on both sides and 
lines up equally to the right and left margins. Traditionally many books, newsletters, 
and newspapers use full-justification. 
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You can also use keyboard shortcuts. 
Ctrl+L= Left Align 
Ctrl+R= Right 
Align Ctrl+E= 
Center Ctrl+J= 
Justify 

Below you will view examples of paragraph that are aligned using the left, center right, 
and justified alignment buttons. 

Left-aligned 

Left-align tests Left-align is the default in word. All selected items (text, numbers 
and inline objects) are aligned to the left hand margin with a ragged right edge. 
This text is left-aligned. Notice hew each line is a different length. In most cases your 
documents will be left-aligned. 

Center- aligned 

Center test: All selected items (text , numbers and inline objects) the 
aligned in the center, leaving space on both sides. 

This text is centered. Each line of text is centered between the margins. 
Centered of text is very useful for aligning text in document titles, 

advertisements, or flyers. 
Right-aligned 

Right-align text: All selected items (text, numbers and inline objects) are aligned to 
the right hand margin with a ragged left edge. This text is right- aligned. Notice how 

each line is a different length. 
Right-aligned text can be useful in some situations, such as cdumns or numbers, but 

it can also be very distracting to use for text. 

Justified 
Justified text: All selected items (test, numbers and inline 
objects) are aligned to both the left and right margins. Justifying 
text gives the selected items a straight edge margin on both the 
right and left sides. 
The text is justified. Although justified text looks neat and tidy, 
the extra spaces between words can get distracting in long 
paragraphs. Books, however always used justified margins, _____  

6.15 FIND AND REPLACE 
Word 2010 allows you to search for specific words in your document as well as fonts, 

special characters and formats. The Find and Replace tool can really save your time and 
effort in your word processing goals. 

To find a particular word or phrase in a document: 
• To find and replace a word or phrase in the document, click Find or Replace on the 

Editing Group of the Ribbon. 
Jft Find - 

Hffteptace 
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• Find and Replace dialog box appears. 

Fig 6.29 (Find and Replace Dialog Box) 

• Type a word, phrase or format in the Find what: box. 
• Click Find Next to start the search. 
• Word will jump to the first instance of that word and will highlight the word. 
• Continue Clicking the Find Next button to find all other instances of that word. 

Using Replace: 
• Type the word, phrase or format in the Replace With: box that will replace what is 

in the Find what: box. 
• Click Replace. 
• Click Replace All to replace every occurrence of the selected text with the 

replacement text. 
• Click Find Next to bypass it and find the next. 
• Click Cancel to quit. 

Note: You can perform a more detailed search by clicking the More button on the Find 
and Replace dialog box. __________________________________________________________  

6.16 TEMPLATES 
A template is a pre-designed document that you can use to create new documents with 

the same formatting. With a template, many of the big document design decisions such as 
margin size, font style and size, and spacing are predetermined. 
6.16.1 Create a New Document with a Template 

To Insert a Template: 
1. Click the File tab to go to Backstage view. 
2. Select New. The New Document pane appears. 
3. Click Sample templates to choose a built-in template, or select an OfIice.com 

template category to download a template. ____________________   
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4. Select the desired template, and then Click Create. A new document appear 
using the template you have selected- 

6.16.2 Entering information into a Template 
Templates include placeholder text that is surrounded by brackets. To personal your 

document, you'll need to replace the placeholder text with your own text. 
To insert text into a template: 

1. Click the text you want to replace. The text will appear highlighted, am template 
tag will appear. 

 

2. Enter some text. It will replace the placeholder text. 
S For some fields, there's a drop-down arrow you can use to select informat rather 

than type it. For example, a date field will show a calendar so you choose the 
date more easily. 

 

To change pre-filled information: 
In some templates, your name or initials will be automatically added. This is kno as 

pre-filled information. If your name or initials are incorrect, you'll need to change th in Word 
Options. 

1. Click the File tab to go to Backstage view. 
2. Click the Options button. The Word Options dialog box appears. 
3. Enter the user name and/or initials in the General section, and then cl OK.

 [Type your phone number] 

[Type your e-fnaif address] [Type 
your website address] 
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6.17 TABLES 
A table is a grid of cells arranged in rows and columns. Tables allow large amounts of 

text or numbers to be presented in an organized and easy to read manner. Student roll 
books, sport statistics, address books, math formulas, menus and many other documents 
often incorporate tables to share information. 

A few important terms to know before you begin creating tables are: 
Row - A row runs horizontal in a table and is divided by borders. 

 

6.17.1 Insert a Table 
There are three ways to insert a table in Word 2010 document: 

1. Clicking the Table button creates a table with the number of columns and 
rows you select from the grid, with all the cells of equal size. < 

2. You can use the Insert Table dialog box, where you can specify the number of 
rows and columns as well as their sizes. 

3. You can also create a table by drawing cells the size you want. 
4. When table was created, you can then enter text, numbers, and graphics into the 

table's cells, which are the boxes at the intersections of a row and a column. 
To Insert a Table (method 1): 
• Click the Insert tab of the Ribbon. 
• In the Table group, click the Table icon. Word displays a drop-down list. 

Row direction 

 

Fig. 6.32 (Table) 
Column - A column runs perpendicular in a table and is divided by borders. 
Borders - Separating lines in the table. 
Cell - A cell is the box that is created when your rows and your columns intersect each 
other. The cell contains your data or information. 

Insert • Page Layout References M 

~ j| 
‘a<je 
reak Table 

,L^ 1 2. 1 Picture Clip Shapes 
SmartA Art 

 5x5 Table  

    nnnnnnn  

□□□□□□  
nnnnnn  

     □□□□□□  
rannnnn  

 □□□□BnDDDD 
□□□□□□□□□□ 
□□□□□□□□□□ 

 

 ~3 insert Table...  

 Elf f Draw Table-  

  I € mwe rt Text 1© fable,..  

SB  



MS-WORD 6.33

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Drag the intended table columns and rows from the table grid. 
For example, 5X5 tables. The table will

automatically insert into the document. 
To Insert a Table (method 2) 
• Click the Insert tab of the Ribbon. 
• In the Table group, click the 

Table icon. 
• From the drop-down list displayed,

click the Insert Table command. 

Insert .
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Fig. 6.34 (Insert a Table: Insert Table Command)

• Insert Table dialog box appears. 
Insert Table 

Table size 

Number of columns: $ 

Number of rows: 2 

AutoFit behavior # Fixed column width: 

|AU1 © AuteFit to contents AutoRt to window 

IF1 Remember dimensions for new tables 

. :: 

Cancel 

Fig. 6.35 (Insert a Table: Insert Table Dialog Box) 

• From the Insert Table dialog box 
displayed, in the Table size 
section, specify the Number of 
columns and Number of rows of 
the table. 

• Click OK. 
To Draw a Table (method 3) 
• Click the Insert tab of the Ribbop. 
• In the Table group, click the Table 

icon. Word displays a dropdown list.
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Home Insert I Page layout Ref erences 

□□□□□□□□□□ 
□□□□□□□□□□ 

m Insert Table... 

Fig. 6.37 (Convert Text to Table)

Table sise 
Number of columns: [# ________ £ 

AutoFit 
behavior 

Olabs ©Other: Q 

• Click on Draw Table from the list of options. Word changes to Print Layout view 
(if you are not already in that view) and changes the mouse pointer so it looks like a 
pencil. 

• Use the mouse pointer to define the outside borders of your table, much as you 
would draw in a drawing program. 

• Use the pencil to draw the columns and rows into the table. 
• Press Esc when you are done. 

6.17.2 To Convert Existing Text to a Table 
• Select the text you wish to convert. 
• Select the Insert tab. 
• Click the Table command. 
• Select Convert Text to Table from the menu. 

• A Convert Text to Table dialog box appears. 
• Choose one of the options in the Separate text at: section. This is how Word 

knows what text to put in each 
column. 
□ 

0 Fixed column width: | Auto £ O 

AutoFit to contents Q AutoFit to 

window 

Separate text at O 
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• Click OK. The text appears in a table. 
6.17.3 To Add a Row Above an Existing Row 

• Place the insertion point in a row below the location you wish to add a row. 

 

Fig. 6.39 (Table: Adding a New Row) 

• Right-click the mouse. A menu appears. 
• Select Insert -> Insert Rows Above. 

 

• A new row appears above the insertion point. 
6.17.4 To Add a Column 

• Place the insertion point in a column adjacent to the location you wish the new 
column to appear. 

• Right-click the mouse. A menu appears. 
• Select Insert -> Insert Columns to the Left or Insert Columns to the Right. 

A 
new column appears. 

6.17.5 To Delete a Row or Column 
• Select the row or column. 
• Right-click your mouse and a menu appears. 
• Select Delete Columns or Delete Rows. 

6.18 SPELL AND GRAMMAR CHECK 
To make your document appear professional, you'll want to make sure it is free from 

spelling and grammar errors. 
Green wavy lines are placed underneath possible grammar mistakes and a red wavy 

line under possible spelling mistakes. 
Just because Word underlines a word doesn’t necessarily mean that the word is 

spelled wrong. It could be a proper name, a foreign word, or just a word that Word isn’t 

if Salesperson insertion point H in fiRST 
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Fig. 6.40 (Table: Insert Rows above an existing row) 
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> Check Spelling As You Type 
Word puts a red wavy line under possible spelling mistakes. If you right-click on the 

suspected misspelling, Word gives you one or more suggested corrections. 
To Use Spell Check as You Type: 
• Place your I-Beam over the misspelled word and right-click. 
• A menu list displays the following options: boldfaced suggested spellings, Ignore, Add 

to Dictionary, AutoCorrect, Language or Spelling. 

Arial -jlZ - A" A’ A' <f 

B I * - A - ;= - 
Have a nebfi 

nice 

niece 

nee 

neck 

nicer 

Ignore 

Ignore AH 

Add to Dictionary 

AutoCorrect ► 

Language ► 

V Spelling... 

SX Lookup... 

& 04 
fit! copy I 

Paste | 

Fig. 6.41 (Spell Check) 

• Select the boldfaced suggestion to replace the incorrectly spelled word in the document. 
• Select Ignore and Word ignores all future instances of this spelling in this document. 
• Select Add to Dictionary and Word adds the underlined word to the dictionary so it 

won't be flagged as an error in any other document you create. 
• Select AutoCorrect to add the correct spelling to your list of words that Word 

automatically corrects as you type. 
• Select Language to specify a word as part of another language, preventing Word 

from seeing this word as a mistake. 
• If you select spelling, the Spelling and Grammar dialog box appears. 

> Check Grammar As You Type 
Word puts a green wavy line under possible grammar mistakes. 

To Work on Suspected Grammatical Mistakes: 
• Place your I-beam over the grammatical mistake and right-click. 
• A menu list displays the following options: boldfaced grammar suggestion, Ignore Once, 

Grammar,-About This Sentence. 
• Select Ignore Once and Word ignore the grammatical mistake it believes to exist. 
• Select Grammar, and the Grammar dialog box appears. 
• Select About This Sentence and the Office Assistant will offer you reasons as to why 

Word believes this to be a grammatical error. 
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> Check Spelling and Grammar using Review tab 
Here is the simple procedure to find out wrong spelling mistakes and fixing them: 

1. Click the Review tab and then click Spelling & Grammar button. 
2. A Spelling and Grammar dialog box will appear and will display wrong 

spellings or grammar and correct suggestions as shown below: 

 

To Use the Spelling and Grammar Dialog box: 
You have following options to fix the spelling mistake: 
• Click Ignore Once to ignore this one instance of the grammatical error in your 

document. 
• Click Ignore Rule to ignore this grammatical error and all other grammatical errors 

of this type in the document. 
• Click Next Sentence to take you to the next grammatical error listed in your 

document. 
• Click Change to replace the error with what is in the Suggestion box. 
•  Click Explain to open the Office Assistant, which will offer you reasons for this 

error. 
6 19 HEADER AND FOOTER

Fig. 6.43 (Spelling and Grammar Dialog box) 
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one of the built-in options. 
• The Design tab will appear on the Ribbon, and the header or footer will appear in the 

document. 
• Type the desired information into the header or footer. 
• When you're finished, click Close Header and Footer in the Design tab, or hit the Esc 

key. 

 

Note: Once you closed the header or footer, it will still be visible, but it will be locked. To 
edit it again, just double-click anywhere on the header or footer, and it will 
become unlocked. _______________________________  ________________________________  

To insert the date or time into a header or footer: 
• Double-click anywhere on the header or footer to unlock it. The Design tab will 

appear. 
• From the Design tab, click the Date & Time command.

Fig. 6.44 (Header and Footer: Drop down Menu)



6.40 MS-W

Fig. 6.46 (Date & Time Dialog box) 
• Place a check mark in the Update 
Automatically box if you would like it t always 
reflect the current date. Otherwise, it will not change
when the documei is opened at a later date. 
• Click OK. The date and time now appears in 
the document. 
To add page numbers to an existing header or
footer: 
• Select the header or footer. The Design tab 
will appear. 

Fig. 6.45 (Design Tab: Date & Time Command) 
• Select a date format in the dialog box that appears. 
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Fig. 6.49 (Header and Footer:
Format Page Numbers)

• From the dialog box, 
select the desired 
Number format. 

• Place the insertion point where you want the page number to be. You can place it 
anywhere except inside a content control field. 

• From the Design tab, select the Page Number command. 
• Click Current Position, and then select the desired style. The page number will 

appear in the document. 
To hide the page number on the first page: 
• Select the header or footer that contains the page number. 
• From the Design tab, place a check mark next to Different First Page. The header 

and footer will disappear from the first page. If you want, you can type something new 
in the header or footer, and it will only affect the first page. 

Fig. 6.48 (Header and Footer: Hiding 

Page Number on First Page) To 
format page numbers: 
• Select the header or footer
that contains the page
number. 
• From the Design tab,
select the Page Number
command. 
• Click Format Page
Numbers. 
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• Next to Start at, enter the 
number you want the page 
numbers to start with. 

Fig. 6.51 (Header and Footer: Start at option) To edit header and footer: 

Click the Insert tab, and click either Header button or Footer button whatever you want 
to edit. Assume you are going to edit Header, so when you click Header button it will 
display a list of options including Edit Header option.  
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Fig. 6.53 (Header and Footer: Editable Header) 
• Now you can edit your document header and once you are done, click Close I Header 

and Footer to come out of header edit mode. 
Note: You can follow a similar procedure to edit footer in your document. __________  

6.20 CREATING LISTS AND NUMBERING 
Microsoft word provides bullets and numbers to put a list of items in a nice order. 

Bulleted and numbered lists help to simplify steps or items to the reader. Teachers often 
use bulleted lists to highlight important pieces of their lessons. Manuals often include 
numbered lists to assist the reader in step-by-step instruction. 

A Bullet is usually a black circle but it can be any other symbol used to highlight items in 
a list. Use bullets to list items that do not have to be in any particular order. Numbers (or 
letters) are used when information has to be in a certain order. 

To create a list: 

• Just click on it and word will display editable header 
for you as shown in Figure 6.53. 
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Select the text you want to format as a list. 
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• Select the bullet or numbering style you want to use, and it will appear in 
document. 

• Position your cursor at the end of a list item, then press the Enter key to add item 
to the list. 

• To remove numbers or bullets from a list, select the list, then click the Bullets 
Numbering commands. 

Multilevel lists are hierarchical lists which can be applied to paragraphs or headin To 
create a multilevel list: 
• Select the text you want to format as a multilevel list. 
• Click the Multilevel List command on the Home tab. 

 

Note: Press Tab or Shift Tab to change levels (or click the Decrease Indent =r_ and 

Increase Indent =£" buttons).  _______________________  

6.21 FORMAT PAINTER 
The format painter in Microsoft word is a handy feature for formatting text. It allows you 

to copy formatting that is applied to one piece of text and apply it to others. 
For example, if you have formatting a paragraph heading with a certain font face size, 

and style and you want to format another heading the same way, you do not need to 
manually add each attribute to the new headline. Instead, use the Format Painter by 
following these steps: 

• Place the cursor within the text that contains the formatting you want to copy. 
• Click on Home Tab -> Clipboard -> Format Painter. Notice that your pointer 

now has a paintbrush beside it. 

 

Fig. 6.55 (Multilevel List) 
• Click the bullet or 
numbering style you want to use.
• Position your cursor at 
the end of a list item, then press 
the Enter key to add an item to 
the list. 
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The format painter brush will then follow your cursor around, letting you know that 
it’s active. To apply the formatting, select the second line of text. When you release 
the mouse, the formatting is applied and the format painter tool is turned off again. 

Note: 
/ 

/ 

Double click on the format painter button to apply the same formatting to multiple 
pieces of text in the document. 
To turn off the format painter, press escape key or click the format painter button 
again. 

 
 

Fig. 6 .57 (Record Macro dialog box) 

2. Give the macro a name in the Macro
Name: field. 
3. Click the Keyboard button to assign a
keyboard shortcut to the macro. 
Type a keyboard shortcut combination and
Click on Assign button and then click Close
button. 
You're now recording a macro in Word.
Everything you do is recorded, from typing text
to choosing commands and setting options. 

6.22 MACRO 
In Microsoft Word, you can automate frequently used tasks by creating and running I 

macros. A macro is a series of commands and instructions that you group together as a 
single command to accomplish a task automatically. By creating a macro based on a 
repetitive task, you have the ability to perform the task in one button click or a keyboard 
shortcut. 

Typical uses for macros are: 
1. To speed up your workflow. 
2. To reduce the chance of making mistakes when performing the steps. 
3. To simplify your tasks. 
4. To speed up routine editing and formatting. 
5. To combine multiple commands — for example, to insert a table with a specific size 

and borders, and with a specific number of rows and columns. 
6. To automate a complex series of tasks. 

6.22.1 Record a Macro: 
1. In the View tab, choose Macros -^Record Macro. 

The Record Macro dialog box appears.
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4. To stop recording, choose Macros->Stop Recording. 
The macro is saved. 

5. To play back the macro, press the keyboard shortcut you assigned. 
Word repeats all actions taken while the macro was being recorded, playing them 
back as though you just issued the commands or typed the text yourself. 

6.23 MAIL MERGE 
The Mail Merge feature in Microsoft Word allows you to merge an address file with a 

form letter in order to generate multiple copies of the same letter, with one copy for each 
address in your file. This automates the task of generating the same letter for multiple 
recipients. 

It is a process of combining generic information (such as a form letter or mass email) 
with specific information (such as a specific recipient’s address, name, or title). 

In Word 2010, this process is completed using two components: 
1. A Main document (For example: A form letter). 
2. A Data source (A list of recipients that includes names, addresses, phone 

numbers, titles, etc.). 
This data source could be an E-mail address book, a Microsoft excel spreadsheet, a 

database, or various other files. The main document contains standard text that all final 
letters will contain, but it also contains variable placeholders, such as the “Address Book” or 
the “Greeting Line”. These generic placeholders are replaced with the specific information 
for each recipient obtained from the data source records. 

Word 2010 provides easy access to all the commands necessary for creating a mail 
merge. These commands are available in the Mailings tab on the Ribbon. You can merge a 
mailing list to letters, e-mail messages, envelopes, and labels. The following will show you 
the overall process of creating mail merge in Microsoft Word 2010. 
Step 1: Accessing Word 2010 Mail Merge commands 

• Open a blank Word 2010 document. 
• From the Mailings tab, in the Start Mail Merge group, click on Start Mail 

Merge icon and from the menu appear, select the desired options to create your 
mail merge. 

 

Step 2: Choosing a Document Type 
• Your options for selecting a document type include the following: 

■ Letters: allows you to alter one letter and sent it to multiple people (assume we 

Fig. 6.58 (Start Mail Merge) 
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instructions on how to perform this type of merge, refer to Creating Mail Merge 
Labels. 

■ Directory: allows you to gather varied but related information into a list such 
as a collection of lists regarding department directory, can includes list names, 
phone numbers, etc. 

Step 3: Choosing the Recipients 
• From the Mailings tab, in the Start Mail Merge group, click on Select Recipients 

icon and from the menu appear, select the desired options to select recipients: 

 

Step 4: Write and Insert Fields 
• Place the insertion pointer where you want a field to appear. 
• From the Mailings tab, in the Write & Insert Fields group, click the desired 

options to add text and variable information to your document. Frequently used 
options include: 
■ Address Block: to specify the format of your recipients' names, whether to 

insert the company name and postal address, and the format of the postal 
address. 

* Greeting Line: to format how the greeting line will appear (e.g., Dear Mr. 
Rahul,) and choose which format to use for unknown names (e.g., Dear Sir or 
Madam,). 

■ Insert Merge Field: to insert fields for a variety of common options (such as 

Fig. 6.59 (Select Recipients) 
■ Type New List: Unless you 
already have a list created for mail
merging, you have to build a new one
by typing each recipient. 
■ Use Existing List: When you 
have a database list you want to use,
this option makes the most sense. After
choosing the list from the Select Data
Source dialog box, where you can 
choose the file you want to use. 
■ Select from Outlook
Contacts: Uses your existing Outlook
contacts as recipients. Unless your PC
is on a network with the proper kind of
Microsoft Server software installed,
you can forget this option. 
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• You can browse through the documents for the other entries by clicking the 
Previous or Next button. 

Step 6: Completing the Mail Merge 
The last step to complete the merge is to accept the preview of how the merge will look 

and direct Word to perform the merge. You can print the merged documents or, prior to 
printing, you can edit individual documents. 

6.24 CHANGE CASE 
Have you ever realized after typing a long paragraph that you accidentally left the Caps 

Lock on and all your letters are in Upper Case? 
Fortunately, you will not have to re-type the text to correct this mistake. Microsoft 

Word offers a quick solution to change the case of your text i.e. the use of Change Case option. 
Changing the case of text in a Microsoft Word 2010 document is a breeze. 
To change the case of a text: 
• Select the text you want to change. 
• Click Home Tab -> Font -> Change Case. 

 

Five options are available: 
• Sentence case - A sentence case is the case where first character of every sentence 

is capitalized. 
• Lowercase - A lowercase is the case where every word of a sentence is in lowercase. 
• UPPERCASE - An uppercase is the case where every word of a sentence is in 

uppercase. 
• Capitalize Each Word: A capitalize case is the case where every first character of 

every selected word is in capital. 
• Toggle Case - Toggle operation will change the case of every character in reverse 

way. A capital character will become lower case and lower case character will 
become upper case. 

6.25 UNDO AND REDO 
> UNDO-Ctrl+ Z 

The Undo command lets you “undo” or delete the last ■ change made to your document. 
If you make a change or mistake that you do not want or did not mean to do, you can 
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Fig. 6.60 (Change Case) 
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To undo an action, do one or more of the following: 
• Click Undo on the Quick Access Toolbar. 

 

Redo Typing (Ctrl +Y) 

Fig. 6.61 (Undo and Redo Buttons on Quick Access Toolbar) 

OR 
• Press keyboard shortcut CTRL+Z. 
If you undo an action in the middle of the list, you will also undo all the actions above 

the one you select. For example, if you undo the 15th action in your list, you will also be 
undoing the 14 actions that came before the one you select. 
> REDO (Repeat) - Ctrl + Y 

The Redo feature allows you to repeat the last action and can help to save a lot of time 
as you create your document. 

To redo an action, do one or more of the following: 
• Click Redo on the Quick Access Toolbar. 

OR 
• Press keyboard shortcut CTRL+Y. 

6.26 BOOKMARK 
In Microsoft word, a bookmark identifies a location or important text in your document. 

It provides the reader with a quick way to navigate through long documents. You might 
bookmark text for a variety of reasons: 

• To quickly navigate to the text. 
• To mark text out for your own purposes. For example, you might want to bookmark 

content you think you should revise later. 
• To link to from other locations in your document. You can add a hyperlink to a 

bookmark. 
To add a Bookmark: 
• To create a bookmark in a specific area of a Word 2010 document, simply place the 

cursor where you want the bookmark. 
• On the Insert tab, in the Links section, click on Bookmark. 
• A Bookmark dialog box comes up. 

Undo Typing (Ctrl + Z) 
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• Set the Bookmark name. After you name it click the Add button. 

6.27 SYMBOLS AND DATES 
9 

Microsoft word allows you to insert special characters or symbols in your document that 
are not on your keyboard such as copyright symbols, trademark symbols etc. The types of 
symbols and characters that you can insert depend on the font that you choose. To insert a 
symbol: 

• Click where you want to insert the symbol. 
• On the Insert tab, in the Symbols group, click Symbol. 

 

• Do one of the following: 
o Click the symbol that you want in the drop-down list. 
o If the symbol that you want to insert is not in the list, click More Symbols. In the 
Font box, click the font that you want, click the symbol that you want to insert, and 
then click Insert, o Click Close. 

. To insert a special character: 
Click where you want to insert the special character. 
On the Insert tab, in the Symbols group, click Symbol, and then click More 
Symbols. 
Click the Special Characters tab. 

£> Sjmbo' * 

e £ ¥ © % 

TM ± * < 
> 

* X CD M- a 

3 n Q y 
i—t © 

O Mere Symbols...  

Fig. 6.63 (Adding 
Symbols) 
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• Date and Time dialog box appears. Select the 
required format from the available formats in the 
list. 

Fig. 6.66 (Date and Time dialog box)

• Click the checkbox “Update automatically”. 
• Press OK. 

• Click the character that you want to insert, and then click Insert. 
• Click Close. 

To insert Date and Time: 
 

6.28 PRINTING A DOCUMENT 
To print a document, your computer needs to be connected to a printer. Although print is 

not necessary in order to use Word, but if you want to send a letter in the post or print out a 
poster, then you will need to have access to a printer. 

To print a document from Microsoft word 2010: 
• Open an existing Word document or start a new document and type your text. 

Once you have completed your document and are ready to print, click File tab in the 
top left corner of your document. 

8 Quick Parts - Signature Line v fl Equation y 
<41 WordArt ’ ||| Date & Time O Spnbolv 

— Prop Cap * Object -  

Text  Symbols 
• numocr insert Date anrf Tims  

 Insert the current date or time Into the 
current document. 

• On the Insert tab, in the Text group, click Date and Time. 
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Save

Printer

Jkr-.jVl No Printers Installed

Settings 

Pages:

:;i 3|;j J-j Collated

Printer Properties

P rint All Pages
Print the entire document

Fig. 6.68 (Print dialog box) 
Choose how many copies of your document you need. 

Move down and click Print in the menu. This will bring up the Print dialog box. 
jwl ’ 1 ' , UfNflTjS [Compatibility Mo.de.) - .Microsoft... o i 

Insert Page layout References Mas rings Review View i 

Print 

Depending on your printer options, you can choose other printing features suet as 
whether you want to print all pages or only certain pages. You can alsc change the 
orientation of the print from portrait to landscape and tell youi computer and 
printer whether you’re printing on a certain size of paper. You! also see, on the right, 
a preview of your printed document will look like. 
When you are satisfied with your settings, then click Print. The document wil now 
start printing on your printer. 

6.29 SHORT CUT KEYS 
A i l k  bi ti  th t   ifi  d t  b  t d  T i ll  
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Ctrl + C Ctrl + D Ctrl + 
E Ctrl + F Ctrl + G Ctrl 
+ H Ctrl + I Ctrl + J 
Ctrl + K Ctrl + L Ctrl + 
M Ctrl + N Ctrl + O 
Ctrl + P Ctrl + R Ctrl + 
S Ctrl + T Ctrl + U Ctrl 
+ V Ctrl + W Ctrl + X 
Ctrl + Y Ctrl + Z Ctrl + 
Shift + L Ctrl + Shift + 
F Ctrl + ] 
Ctrl + [ 
Ctrl + Del 
Ctrl + Backspace 
Ctrl + End 
Ctrl + Home 
Ctrl + Spacebar 
Ctrl + 1 
Ctrl + 2 
Ctrl + 5 
Ctrl + F2 
FI 
F5 
F7 

Copy selected text. 
Open the font preferences window. 
Aligns the line or selected text to the center of the screen. Open 
Find box. 
Open Go To box. 
Open Replace box. 
Italic highlighted selection. 
Aligns the selected text or line to justify the screen. 
Insert Hyperlink. 
Aligns the line or selected text to the left of the screen Indent the 
paragraph. 
Open a new blank document. 
To open an existing file. 
Open the print window. 
Aligns the line or selected text to the right of the screen. 
To Save a document. 
Create a hanging indent. 
Underline highlighted selection. 
Paste. 
Close a document. 
Cut selected text. 
Redo the last action performed. 
Undo last action. 
Quickly create a bullet point. 
Change the font. 
Increase selected font +lpts. 
Decrease selected font -lpts. 
Deletes word to right of cursor. 
Deletes word to left of cursor. 
Moves the cursor to the end of the document. 
Moves the cursor to the beginning of the document. 
Reset highlighted text to the default font. 
Single-space lines. 
Double-space lines. 
1.5-line spacing. 
Display the print preview. 
Open Help. 
Open the find, replace, and go to window in Microsoft Word. 
Spell check and grammar check on selected text or document  
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7.1 SPREADSHEET - AN OVERVIEW 
A spreadsheet is a document that stores data in a grid of horizontal rows and vertical 

columns. Rows are typically labeled using numbers (1, 2, 3, etc.), while columns are labeled 
with letters (A, B, C, etc). Individual row/column locations, such as C3 or B12, are referred to 
as cells. In a spreadsheet application, each value sits in a cell. The relationships between cells 
are called formulas, and the names of the cells are called labels. 

- Once you have defined the cells and the formulas for linking them together, you can enter 
your data. You can then modify selected values to see how all the other values change 
accordingly. 

Most spreadsheet applications are multidimensional, meaning that you can link one 
spreadsheet to another. A three-dimensional spreadsheet, for example, is like a stack of 
spreadsheets all connected by formulas. A change made in one spreadsheet automatically 
affects other spreadsheets. The most popular examples of this type of software are Lotus, 
MS-Excel. 

Note: A spreadsheet document is often called a worksheet. 

7.1.1 Features of Spreadsheet 
Spreadsheet software provides all the features you need to create a professional looking 

spreadsheet. Some of the main features of a spreadsheet program are: 
• It provides a standard grid, which piay be scrolled and zoomed. Text, numeric or 

date values or formulas may be entered into the selected cell through the formula 
bar at the top of the screen. 

• Cells may be formatted using the format pages, which let you specify the font style, 
borders, text and background colors, the size of cells and text alignment within the 
cells. 

• Spreadsheet provides support for multiple sheets within a workbook. When you 
press the worksheet button, worksheets are presented in a horizontally scrollable 
page, allowing you to quickly flick between all the worksheets in the workbook. 

• A worksheet may be selected simply by tapping on it. You can create new 
worksheets and delete or rename existing worksheets. 

• Spreadsheet provides the ability to search the worksheet for any phrase, number or 
other text, letting you easily scroll between search results. It is also possible to sort a 
range of cells by any row or column. 

• Spreadsheet supports a variety of functions used to perform basic calculations based 
on parameters set by the user. 

• Spreadsheets can be integrated for use with other software programs. One example 
is a mail merge. A spreadsheet can be created with the names and addresses of 
various individuals, and a mail merge can be used to fill in text boxes into form 
letters. 

• Data in spreadsheets can be displayed in a graphic form. Spreadsheets allow the 
numerical data in the cells to be displayed as a graph or chart.  
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7.1.2 Applications of Spreadsheet 
Some of the applications of a spreadsheet program are as under: 
1. A spreadsheet allows users to enter and calculate numerical data. 
2. Using a spreadsheet greatly increases productivity for anyone who needs to 

manage receipts, create budgets, generate financial reports or even keep track of 
inventories. 

3. A spreadsheet is a useful tool for sorting and analyzing data. 
4. Complex calculations can be performed very quickly. 
5. Professional looking graphs and charts can be created very quickly from a range of 

data which allows you to view the data pictorially. 
6. Easy to make changes and corrections to data on the worksheet. Calculation is 

always accurate, provided that data and formulae entered are correct. 

7.2 MICROSOFT EXCEL 
Microsoft Excel is spreadsheet software in the Microsoft Office Suite widely used to 

perform mathematical calculations. The data is spread in a tabular form consisting of rows 
and columns. It provides built-in features and tools such as formulas, functions and data 
analysis tools that make it easier to work with large amount of data. 

Spreadsheets are primarily used to work with numbers and text. A file of MS-Excel is 
called a workbook and it contains multiple worksheets or spreadsheets. A worksheet is 
divided into a series of rows and columns to store the information. 

MS-Excel helps us to: 
• Arrange data in an organized way. 
• Perform calculations. 
• Compare data through charts. 
• Sort data for better analysis. 
• Compare two workbooks side by side. 
MS-Excel allows you to store, organize, and analyze numerical and text data. You can 

use this robust application to enter numerical values or data into the rows or columns of a 
spreadsheet, and to use these numerical entries for calculations, charts, formulas, statistical 
analysis, etc. 

7.3 EXCEL 2010 
Excel 2010 is the spreadsheet software in the Microsoft 2010 Office Suite. It allows you 

to store, organize, and analyze numerical and text data. You can use this robust application 
to enter numerical values or data into the rows or columns of a spreadsheet, and to use these 
numerical entries for calculations, charts, formulas, statistical analysis, etc. 
7.3.1 Features of Excel 2010 

Excel 2010 is a powerful tool for analyzing, sharing, and managing information to help 
you make more informed decisions. 

Some of the important features of Excel 2010 are as under: 
• Results-oriented user interface: Excel 2010 provides results-oriented user 

interface. Based on the job you need to accomplish, whether it is creating a table or 
writing a formula, Excel 2010 presents you with the appropriate commands. 
O i  d l  i  d t  t  ithi  i ifi tl  d d 
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Quick Access toolbar Title bar
Ribbon Help

Name box 

3^ * rm* * smct ■ 

Column bar Formula bar

J , Sheet Area Status bar

View Buttons zoom Controls

• Improved and powerful support for working with tables: Excel 2010 has 
improved support for tables allowing you to create, format, expand, and refer to 
tables within formulae. 

• Save as XPS or PDF for easier sharing: Convert your spreadsheet to XML Paper 
Specification (XPS) or Portable Document Format file (PDF) to create a fixed version 
of your file for easier sharing. 

• Share Spreadsheets and Business Information with Others: Excel 2010 
makes sharing spreadsheets and business information easier. 

• Communicate your analysis in professional-looking charts: Build 
professional-looking charts faster with fewer clicks using charting tools in the Excel 
2010 user interface. 

• Importing data from external sources: In Excel 2010, data can be imported from 
external sources such as a database. Data can also be imported from formatted 
tables and reports, which do not have a regular grid structure. 

• Formula Auto complete: Excel 2010 automatically suggests function names, 
arguments and named ranges, and automatically completing them if desired, based 
on the characters entered. 

• Pivot tables: Pivot tables are used to create analysis reports out of sets of data, can 
now support hierarchical data by displaying a row in the table with a "+" icon, which, 
when clicked, shows more rows regarding it, which can also be hierarchical. 

7.4 STARTING EXCEL 2010 
To Start Excel 2010 from the Start Menu: 
• Click on the Start button, point to All Programs then Microsoft Office and click on 

Microsoft Excel 2010. 
The first screen that you will see a new blank worksheet that contains grid of cells. 
This grid is the most important part of the Excel window. It's where you will perform 
all your work, such as entering data, writing formulas, and reviewing the results. 

sjm/t “ smwf ▼ ■ fcay#s»- 'fwmm* uszts £ ttfbo -is ' * ^ s*m*m 

J <b- » / B - A- * K * M * - % 

** / _ • > ■ A ’ ‘4,5 
| Row bar 
I 9 
} io Sheet Tabs 
In- *» 
112 

J
 U 
h u IIHZIH: 

Fig. 7.1 (Microsoft Excel Window or Screen Layout)
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Excel 2010 Screen Elements: 
• File Tab: The File tab replaces the Office button from Excel 2007. You can click it [ 

to check Backstage view, which is the place to come when you need to open or | 
save files, create new sheets, print a sheet, and do other file-related operations, j 

• Quick Access Toolbar: A small toolbar you will find just above the File tab I 
contains shortcuts for some of the most common commands such as Sane, I Undo, 
and Redo buttons. 

• Ribbon: A combination of old versions menu bar and toolbar, arranged into a 
series of tabs. Ribbon contains commands organized in three components: 

• Tabs: Tabs appear across the top of the Ribbon and contain groups of related | 
commands. Home, Insert and Page Layout are the examples of ribbon tabs. 

1. Groups: Groups organize related command. Each group name appears 
below the group on the Ribbon. For example: Group of commands related to 
fonts (Font group) or group of commands related to alignment (Paragraph 
group) etc. 

2. Commands: Commands appear within each group as mentioned above. | 
For example: Bold, Italic and Underline are the commands appear under Font 
group of Home tab. 

• Title Bar: Title bar lies at the top of the window. It shows the program and 
document titles. 

• Name Box: Displays the address of the current active cell where you work in the 
worksheet. 

• Formula Bar: Displays the address of the active cell on the left edge, and it also 
shows you the current cell's contents. 

• Sheet Tabs: Excel 2010 contains 3 blank worksheet tabs by default. Click on the 
intended tab will go to the particular worksheet. 

• Status Bar: This displays sheet information as well as the insertion point 
location. From left to right, this bar can contains the total number of pages and 
words in the document, language etc. 

•  Zoom Control: Use to zoom the Excel screen in or out by dragging the slider. 
•  View Buttons: The group of three buttons located to the left of the Zoom control, 

lets you switch among Excel’s various sheet views. 
o Normal Layout view: This displays page in normal view, o Page Layout view: 
This displays pages exactly as they will appear when printed. This gives a full 
screen look of the document, o Page Break view: This shows a preview of where 
pages will break when printed. 

• Sheet Area: The area where you enter data. The flashing vertical bar is called 
the insertion point and it represents the location where text will appear when you 
type. 

• Row Bar: Rows are numbered from 1 onwards and keeps on increasing as you 
keep entering data. 

• Column Bar: Columns are numbered from A onwards and keeps on increasing as 
you keep entering data. After Z, it will start series of AA, AB and so on. 

7.5 MENUS AND TOOL BARS 
In Excel 2010, menus and toolbars have been replaced by the tabbed Ribbon system. 
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You should remember following three features as you work within Excel 2010: 
(i) Ribbon (ii) Quick Access Toolbar (iii) Backstage View These three features contain 

many of the functions that were in the menus bar of earlier versions of Excel. The functions 
of these three features will be outlined below: 

(i) Ribbon 
The Ribbon is the panel at the top portion of the workbook. It has eight tabs: File, 

Home, Insert, Page Layout, Formulas, Data, Review, and View that contain many new and 
existing features of Excel. Each tab is divided into groups. The groups are logical collections 
of features designed to perform functions that you will utilize in developing or editing your 
Excel workbook. Commonly used features are displayed on the Ribbon, to view additional 
features within each group, click on the arrow at the bottom right of each group. 

 

Fig. 7.2 (Ribbon) 
Each of the tabs contains the following tools: 
• File: Use this tab to check the Backstage view, which is the place to come when you 

need to open or save files, create new sheets, print a sheet, and do other file- related 
operations. 

• Home: Use this tab when creating, formatting, and editing a spreadsheet. 
• Insert: Use this tab when adding particular elements (including graphics, 

PivotTables, charts, hyperlinks, and headers and footers) to a spreadsheet. 
• Page Layout: Use this tab when preparing a spreadsheet for printing or reordering 

graphics on the sheet. 
• Formulas: Use this tab when adding formulas and functions to a spreadsheet or 

checking a worksheet for formula errors. 
• Data: Use this tab when importing, querying, outlining, and subtotaling the data 

placed into a worksheet's data list. 
• Review: Use this tab when proofing, protecting, and marking up a spreadsheet for 

review by others. 
• View: Use this tab when changing the display of the Worksheet area and the data it 

contains. 
(ii) Quick Access Toolbar 

The Quick Access Toolbar is a customizable toolbar that contains commands you may 
want to use. You will find the Quick Access Toolbar just above the File tab. It contains 
shortcuts for some of the most common commands such as Save, Undo, and Redo buttons. 
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(iii) Backstage View 

 

7.6 WORKSHEET AND WORKBOOK 
A worksheet is the grid of cells where you can type the data. The grid divides your 

worksheet into rows and columns. 
Columns are identified with letters (A, B, C ....), while rows are identified with numbers 

(1, 2, 3 ....). 
A cell is identified by column and row. For example, A7 is the address of a cell in column A 

(the first column), and row 7 (the seventh row). 
The worksheets in turn are grouped together into a workbook. By default each workbook 

in Excel 2010 contains 3 blank worksheets, which are identified by tabs displaying along the 
bottom of your screen. The first worksheet is called Sheetl, the next is Sheet2 and so on as 
shown below: 

Fig. 7.4 (Backstage View) 
Backstage view gives you various options for saving, opening a file,
printing, and sharing your document. It is similar to the Microsoft
Office button menu from Excel 2007 and the File menu from
earlier versions of Excel. 
Click the File Tab on the Ribbon to check the Backstage view. 
The backstage view screen works under three panes: 
(i) The left pane of the Backstage View lists common 
commands for creating, saving, or printing your file. 
(ii) The middle pane typically displays additional options you 
can choose for the command selected in the left pane. 
(iii) The right pane displays additional details about your file. 

 A B C D E F T 
1   

2    
3    
4    
5    

6   
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Fig. 7.6 (Creating a Workbook)

• The worksheets are labeled Sheetl, Sheet2, and Sheet3. 
• Each Excel worksheet is made up of columns and rows. 
• In order to access a worksheet, click on the tab that says Sheet#. 

7.7 CREATING A WORKBOOK 
Excel files are called workbooks. Each workbook holds one or more worksheets (also 

known as spreadsheets). 
To create a new workbook: 
• Click the File tab to move on Backstage view. 
• Select New. 
• Select Blank workbook under Available Templates. 

(It will be highlighted by default.) 
• Click Create. A new blank workbook appears in the Excel window. 

7.8 OPENING A WORKBOOK 
There may be a situation when you open an existing workbook and edit it partially or 

completely. 
To open an existing workbook: 
• Click the File tab to move on Backstage view. 
• Select Open. The Open dialog box appears. 1 
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Note: You can also make changes to and delete text from the formula bar. Just 
select the cell and place your insertion point in the formula bar. 

7.9 ENTERING AND EDITING TEXT 
To Insert Text: 
• Left click a cell to select it. Each rectangle in the 

worksheet is called a cell. As you select a cell, the cell 

address appears in the Name Box. 

 

Fig. 7.8 (Selecting a Cell to Insert Text) 
Enter text into the cell using your keyboard. The text appears in the cell and in the 
formula bar. 

 

To Edit or Delete Text: 
• Select the cell. 
•  Press the Backspace key on your keyboard to delete text and make a correction. 

•  Press the Delete key to delete the entire contents of a cell. 
7.10 MOVING AROUND THE WORKSHEET 

Excel provides a number of ways to move around a sheet using the mouse and the 
keyboard. 

To Move through a Worksheet Using the Mouse: 
• You can easily move the insertion point by clicking in your text anywhere on the 

screen. Sometime if sheet is big then you can not see a place where you want to 
move. In such situation you would have to use the scroll bars. 

• You can also scroll your worksheet by rolling your mouse wheel, which is . '' 
equivalent to clicking the up-arrow or down-arrow buttons in the scroll bar. 

To Move through a Worksheet Using the Keyboard: 
• Press the Tab key to move to the right of the selected cell. 
• Press the Shift key and then the Tab key to move to the left of the selected cell. 
• Use the Page Up and Page Down keys to navigate the worksheet. 
• Use the arrow keys. 

7.11 SAVING A WORKBOOK 
Once you are done with typing in your new excel sheet, it is time to save your 

sheet/workbook to avoid losing work you have done on an Excel sheet. 
To Save the Workbook: 

Name Box
3 ! Selected  

; Cell 4  
 

At , y X. v( .i*.\ Monthl 
:A 8 C D / E F 

1 Month! 1 text Appears in Formula Bar  

2 
-and Cell  

Fig. 7.9 (Insert text into Cell) 
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o Select Save if the file has already been named. File tab Save As 

Fig. 7.10 (Save a workbook)
• Select a folder where you would like to save the sheet, Enter file name which you

want to give to your sheet and Select a Save as type, by default it is .docx format.

By default each workbook in Excel 2010 contains 3 
blank worksheets named as, Sheet 1, Sheet2 and Sheet3. 

• Finally, click on Save button and your sheet will be saved with the entered name in 
the selected folder. 

7.12 CREATING A NEW WORKSHEET 

But suppose that you want to start another new worksheet while you are working on 
another worksheet, or you closed already opened worksheet and want to start a new 
worksheet. 

To Create a new Worksheet: 
• Right Click the Sheet Name and select Insert option.  
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Fig. 7.12 (Create a new worksheet)
• Now you will see the Insert dialog box with select Worksheet option
as selected from the General tab. Click Ok button. 

Fig. 7.13 (Create a new worksheet: Insert dialog box)

• A new blank sheet will be displayed and you can start 
typing your text. 
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4p CC<J& 
% grated 
Sheets 

Tab&idr
 t 



MS-EXCEL 7.11

 

7.13 CLOSING A WORKBOOK 
Closing a workbook simply removes the file from your screen but keeps your Excel 2010 

program running so you can edit or open another file. If you have not saved your file, closing 
a file will prompt you to save your changes. 

To Close a Workbook: 
• Click the File tab. 

The Backstage View appears. 
• Click Close. 

If you have not saved your file, a dialog box appears asking whether you want to 
save your changes. 

• Click Yes to save your changes, No to discard any changes, or Cancel to keep your 
file open. 
If you click either Yes or No, Excel 2010 closes your file. 

OR 
Click the Close Button as shown below: 

 

7.14 FORMATTING WORKSHEETS 
Once you have entered information into a worksheet, you will need to be able to format 

it. 
T  F t T t i  B ld  It li  

Fig. 7.15 (Closing a Workbook)
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Note: You can select entire columns and rows, or specific cells. To select the entire 
column, just left-click the column heading and the entire column will appear as 
selected. To select specific cells, just left-click a cell and drag your mouse to select the 
other cells. Then, release the mouse button. _______________________________________  

To 
 

Format Text as Underlined: 
Select the cell or cells you want to format. 
Click the drop-down arrow next to the Underline command. 
Select the Single Underline or Double Underline option. 

A- A'; i 
--I 1 
Underline 

E [\goubje Underline fj 

Fig. 7.17 (Formatting Text in a Worksheet: Single Underline or Double Underline) 

To Change the Font Style 
• Select the cell or cells you want to format. 
• Left-click the drop-down arrow next to the Font Style box on the Home tab. 
• Select a font style from the list. 

'* Agency fB E 

1 S Albertus MT t 
2 & Albertus MT Lt 

if .......... % ALfiEBIAtf 

*   & Antique Olive Compact 

j .....  .... : & Antique Olive Roman 
Fig. 7.18 (Formatting Text in a Worksheet: Change Font Style) 

Note: As you move over the font list, the Live Preview feature previews the font for you in 
the spreadsheet. _______________________________________________________________  _  

To Change the Font Size: 
• Select the cell or cells you want to format. 
• Left-click the drop-down arrow next to the Font Size box on the Home tab. 
• Select a font size from the list.  

J A Calibri ^ 11 
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Fig. 7.16 (Formatting Text in a Worksheet: Bold or Italic)
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To Change the Text Color: 
' Select the cell or cells you want to format. 
' Left-click the drop-down arrow next to the Text Color command. A color palette will 

appear. 
» Select a color from the palette. 

 

 

Fig. 7.20 (Formatting Text in a Worksheet: 

Change Text Color) 

OR 
> Select More Colors. A dialog box 
will appear. 
> Select a color. 
• Click OK. 
ro Add a Border: 
> Select the cell or cells you want to 
format. 
> Click the drop-down arrow 
next to the Borders command on the 
Home tab. A menu will appear with 
border options. 



iXCEL 7.14

 

 

Fig. 7.21 (Formatting Text in a Worksheet: Add a 

Border for the cell(s)) 

• Left-click an option from the list to 
select it. 
To add a Fill Color: 
» Select the cell or cells you want to 
format. 
• Click the Fill command. A color 
palette will appear. 
• Select a color. 





 

!

1. 
2. 

OR 
• Select More Colors. A dialog box will appear. 
• Select a color. 
• Click OK. 

7.15 DATA VALIDATION 
In many worksheets that you create, users will enter data to get the desired calculations 

and results. Ensuring valid data entiy is an important task. You may want to restrict data 
entry to a certain range of dates, limit choices by using a list, or make sure that only positive 
whole numbers are entered. Providing immediate help to instruct users and clear messages 
when invalid data is entered is also essential to make the data entry experience go smoothly. 

To Restrict Data Entries: 

Select one or more cells to validate. 
On the Data tab, in the Data Tools group, click Data Validation. The Data 
Validation dialog box is displayed. 

Text to Remove ™ 
Columns Duplicates '-'Vhat-If «nalj5!S ■ 

 ____________________________ Data Tools ______________  

Fig. 7.23 (Data Validation in Data Tools 
Group under Data Tab) 

Data Validation 

11 Settngsj Input Message Error Alert 

j Validation criteria | Allow: 

| Any value ^|| ' : A 

: eye V. 
: ■   ..  ........... : 

I 

j dear j fOK .............  j [ Cancel ];
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3. Click the Settings tab. 
4. To specify the type of validation that you want, do one of the following: 

(i) Allow values from a list: 
• In the Allow box, select List. 
• Click the Source box and then type the list values separated by the Microsoft 

Windows list separator character (commas by default). 

• Make sure that the In-cell dropdown check box is selected. 
(ii) Allow a whole number within limits: 

• In the Allow box, select Whole Number. 
• In the Data box, select the type of restriction that you want. For example, to set 

upper and lower limits, select between. 
• Enter the minimum, maximum, or specific value to allow. You can also enter a 

formula that returns a number value. 

(iii) Allow a decimal number within limits: 
• In the Allow box, select Decimal. 
• In the Data box, select the type of restriction that you want. For example, to set 

upper and lower limits, select between. 
• Enter the minimum, maximum, or specific value to allow. You can also enter a 

formula that returns a number value. 

(iv) Allow a date within a timeframe: 
• In the Allow box, select Date. 
• In the Data box, select the type of restriction that you want. For example, to allow 

dates after a certain day, select greater than. 
• Enter the start, end, or specific date to allow. You can also enter a formula that 

returns a date. 

(v) Allow a time within a timeframe: 
• In the Allow box, select Time. 
• In the Data box, select the type of restriction that you want. For example, to allow 

times before a certain time of day, select less than. 
• Enter the start, end, or specific time to allow. You can also enter a formula that 

returns a time value. 

(vi) Allow text of a specified length: 
• In the Allow box, select Text Length. 
• In the Data box, select the type of restriction that you want. For example, to allow 

up to a certain number of characters, select less than or equal to. 
• Enter the minimum, maximum, or specific length for the text. You can also enter a 

formula that returns a number value. 

(vii) Calculate what's allowed based on the content of another cell: 
• In the Allow box, select the type of data that you want. 
• In the Data box, select the type of restriction that you want. 
• In the box or boxes below the Data box, click the cell that you want to use to specify 

what's allowed. 

(viii) Use a formula to calculate what's allowed:
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• In the Formula box, enter a formula that calculates a logical value (TRUE for valid 
or FALSE for invalid entries). 

1. To specify how you want to handle blank (null) values, select or clear the 
Ignore blank check box. 

2. Optionally, display an input message when the cell is clicked. To do that, 
• Click the Input Message tab. 
• Make sure the Show input message when cell is selected check box 

is selected. 
• Fill in the title and text for the message. 

3. Specify how you want Microsoft Office Excel to respond when invalid data is 
entered. To do that, 
• Click the Error Alert tab, and make sure that the Show error alert 

after invalid data is entered check box is selected. 
• Select one of the following options for the Style box: 

(i) To display an information message that does not prevent entry of 
invalid data, select Information. 

(ii) To display a warning message that does not prevent entry of invalid 
data, select Warning. 

(iii) To prevent entry of invalid data, select Stop. 
• Fill in the title and text for the message (up to 225 characters). 

4. Test the data validation to make sure that it's working correctly. Try entering 
both valid and invalid data in the cells to make sure that your settings are 
working as you intended and your messages are appearing when you expect. 

7.16 FORMULAS 
A formula is an equation that performs operations or calculations on worksheet data. 
You can use an Excel 2010 formula to perform mathematical operations, such as 

addition and multiplication, or they can compare worksheet values, join text, averaging a 
student's test results, etc. 

Formulas can refer to other cells on the same worksheet, cells on other sheets in the 
same workbook, or cells on sheets in other workbooks. In addition, if you change the data in 
your spreadsheet, Excel will automatically recalculate the answer without you having to 
re-enter the formula. 

A basic formula format will start with an equals sign (=) followed by one or more 
operands, separated by one or more operators. Operands can be values, text, cell 
references, ranges, defined names, or function names. Operators are symbols used to 
represent the various arithmetic and comparison 
operations you can perform on the operands. 

To Enter a Formula: 
• Place the cursor in the cell where the formula 

will appear (E5 in this case). 
• Enter an = sign. All Excel formulas start with 

the 'equal' sign. 
• Enter the expression that will produce the 

result you want. This can consist of operands, 
values, variables, and symbols which represent 



MS-EXCEL 7.17

 

• When the formula is complete, 
press Enter. The result of the 
formula will be calculated and 
displayed in the cell (E5). 
 E5 -  jy =A5-KT5 

i 
: A 

8 
■ C P  

2      

3      

4      

5 4  7  11 
 mistakes: 

Error Meaning 
##### The contents of the cell cannot be displayed correctly as the cell 
 column is too narrow. 
#REF! Indicates that a cell references is invalid. Often displayed when you 
 delete cells which involved a formula.) 
#NAME? Excel does not recognise text contained within a formula. 

 

Fig. 7.26 (Formula: Result of a Formula) 
• You can see the formula in the Formula bar at the top of the screen by placing the 

cell pointer on the cell (E5). 

Note: If there is an error in a formula, an error message is displayed which will begin 
with a # sign.  __________________  

To know the Excel 2010 Formula Error Messages: 
When writing formulas it is easy to make a mistake. Here are some common 

7.16.1 Filling Formulas To Other Cells 
Sometimes, you will write a formula that gets used a lot in different places of a 

worksheet. For example, a spreadsheet may contain several columns of numbers. Each 
column will contain a formula that adds all the numbers in it. You could write the formula 
several times, once in each column. Or you could copy-and-paste it into each column. The 
fill formula method allows you to copy a formula and fill it into many different consecutive 
cells at the same time. 

The mouse pointer changes to a black crosshair when passed over the fill handle, or the 
square box in the lower right corner of the cell.

 

 

 

 

 

 

 

 

 

 

Fig. 7.27 (Fill formula method) 

To Use the Fill Handle to Copy a
Formula to a Surrounding Cell: 
• Click on the cell that contains the
formula to be copied. 
• Position the mouse pointer over the fill
handle. 
• Click and hold the left mouse 
button, and then drag the contents to the 
cell that's to receive the fill formula. 



 

Copy the formula in cell B5 and fill it into cells C5, D5 and E5. 

Fig. 7.28 (Copy and Fill the formula)

Select the Copy Cells option in the fill formula drop-down menu. 

• The cell references in a formula are automatically updated when the formula is 
copied to other cells in the spreadsheet. 

7.16.2 Copy and Paste Formulas 
The process to copy and paste a formula is identical to that process used to copy and 

paste text. 
To Copy and Paste a Formula: 
• Select the cell that contains the formula to be copied. 

Click the 

 

• Select the cell where the copied formula is to be pasted. 
• Press the Enter key. The formula is copied to the new location. 

7.17 FUNCTIONS 
A function is a pre-defined formula that helps perform common mathematical 

functions. Functions save you the time of writing lengthy formulas. You could use an Excel 
function called Average, for example, to quickly find the average of range of numbers. Or you 
could use the Sum function to find the sum of a cell range. 

Excel 2010 contains a build-in list of worksheet functions, which are categorized to 
make it easy to search for the ones you need. Excel has over 300 built-in functions divided 
into various function categories, including: 

• Financial 
• Logical 
• Text 
• Date & Time 

Copy button. Marching “ants” 
appear around the copied 
cell(s). 
MBIWIOT^-T 
Arial * 10 - 8 I H ’ IE H 
 B4 f* =SUM(B2-B3) 

A B- . C | D ' i 
1    

2 Sales 34567  

f 
Expenses 

1234 
r'33'^33] 

 

marching ants appear during fhe copy process 
Fig. 7.29 (Copy and Paste a formula) 
 



 

 

Here are some commonly used functions: 
AVERAGE: Used to determine the average value of the selected cells contents. 
COLUMNS: Used to return the number of columns within a reference. 
COUNT: Used to count how many numbers are in the list. 
MAX: Used to return the maximum number from a list. 
MIN: Used to return the minimum number from a list. 
ROUND: Used to round off numbers to a specified number of decimal points. 
SUM: Used to add the contents of selected cells. 
Each function has a specific order, called syntax, which must be strictly followed for 

the function to work correctly. 
Syntax Order: 

1. All functions begin with the = sign. 
2. After the = sign define the function name (e.g., Sum). 
3. One or more arguments-numbers, text or cell references-enclosed by parentheses. 

If there is more than one argument, separate each by a comma. 
An example of a function with one argument that adds a range of cells, B3 through BIO: 

=SUM(B3:B10) 
/ I \ 

equal sign function name argument 
Fig. 7.30 (Function with one argument) 

An example of a function with more than one argument that calculates the average of 
numbers in a range of cells, B3 through BIO, and C3 through CIO: 

=AVG(B3:B10, C3:C10) 
/ \ 1 

equal sign function name argument 
Fig. 7.31 (Function with more than one argument) 

To display all the available functions in Excel 2010: 
• Open a blank Excel workbook. 
• Click on the Formulas tab and within the Function Library group click on the 

Insert Function icon.
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• Engineering 
• Cube 
 

Search for a function:

Type a brief descrip tion of what you want to do and then click Go

Or select a category :: 

Select a function: 

Text 

So 

CHAR 
CLEAN 
CODE 
CONCATENATE 
DOLLAR 
EXACT 

Most Recently Used Ail
Financial 
Date St.Time 
Math &Trig 
Statistical 
Lookup St Reference 

-«ase 

mm .....~ ■ ....
Logical 

BAHTTEXT(reu«lbet| Informafion Engineering
Converts a number to
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ai

non

• From the Insert Function dialog box displayed, under Or select a catego section, 
select a particular category function, the related functions will displaye 

7.18 RANGE OR CELL RANGE 
A range is a group or block of cells in a worksheet that have been selected o highlighted. 

When cells have been selected they are surrounded by an outline or border 
Normally there is only one cell in the worksheet with a black outline. This is th Active 

cell. Whatever command is executed by Excel affects the active cell. 
Using the mouse, keyboard or Name Box, more than one cell can be selected ti create a 

range, and commands executed by Excel will affect the entire range. 
Ranges can be made up of adjacent or non-adjacent cells. Adjacent cells are 

together. There are no gaps in the range. Non-adjacent cell ranges consist of two or 
more separate blocks of cells. These blocks can be separated by rows or columns. For 
adjacent ranges, a block of cells can be of any size - from one to several hundred or eve a 
thousand or more. 

A range consisting of adjacent cells can be created by dragging with the mouse. 
Ranges consisting of non-adjacent cells can be created by using the mouse an, 

keyboard. 
To Create a Range consisting of non-adjacent cells by using the mouse and 

keyboard: 
• Click on the first cell you want to select with the mouse pointer to make it th' active 

cell. 
• Release the mouse button. 
• Press and hold down the Ctrl key on the keyboard. 
• Click on the rest of the cells you want to select them without releasing the Ctrl key. 
• Once all the desired cells are selected, release the Ctrl key. 
• Do Not click anywhere else with the mouse pointer once you release the Ctrl key or 

you will clear the highlight from the selected cells. 
• If you release the Ctrl key too soon and wish to highlight more cells, simply press 

and hold down the Ctrl key again and then click on the additional cell(s). 
Ranges are identified by the cell references or addresses of the cells in the upper left 

and lower right comers of the range. These two references are separated by a colon (:) which 
tells Excel to include all the cells between these start and end points. 
Example: A range of adjacent cells as seen in the Figure 7.33 would be B1:B9. 
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A5 
 A B 
1 Am it  

2 Rahul  

3 Rajan  

4 Dharam  

5 Par as  

6 Punit  

7 Priyanka  
S Raman  

 

Fig. 7.35 (Sorting: Sort &
Filter in Editing Group

under Home Tab)

A5 

E3L A B 
i Am it  

 

with an enormous amount of data. To most effectively use this data, you may need to 
manipulate this data in different ways. Sometimes you may find that you need to reorder or 
sort that information to be able to use it most effectively. 

Sorting or Data Sorting is a common spreadsheet task that allows you to easily 
reorder your data. The most common type of sorting is alphabetical ordering, which you can 
do in ascending or descending order. 

To Sort in Alphabetical Order: 
• Select a cell in the column you want to sort (In Figure 7.34, we choose a cell in 

column A). 
Fig. 7.34 (Sorting: Select a Cell from the Column) 

• Click the Sort & Filter command in the Editing group on the Home tab. 
• Select Sort A to Z. 

 

Fig. 7.36 (Sorting: Sort A to Z) 
• Now the information in the Category column is organized in alphabetical order.

Sort & 
Fitter 

cfit 
Find &L Select ^ 

Z i Sort A to Z j 
il Sort Z to A 
 Custom Sort... 

v= Fitter 
yk Clear 
 Reapply 
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A4 ▼ 
 , .A . .1, .... ft ..... j 
i : 3 
2 | 41 
3 | 5 
* j -44| 
5 1 0 
51 22 
Zi 101: 

 

jifi 
r! Find &:
Sele
ct- 

zl Sort Smallest to Largest 

■ |1 Sort Largest to Smallest a: 
Custom: Sort... 

Y= Filter 

j| am 
$*■ '' spjjrtK 

i Sort & I Find &
~2V 'Filter H Select-

Sort Smallest to Largest Sort

Largest to Smallest Custom:

Sort... 

A4 •* 
 A 8 
1 -44  

2 0  

3 3  
4 4  

5 5  

6 22  
7 101  

 

Note: You can sort in reverse alphabetical order by choosing Sort Z to A in the list. 
To Sort from Smallest to Largest: 
• Select a cell in the column you want to sort (a column with numbers). 

Fig. 7.38 (Sorting: Select a Ceil from the Column) 

Click the Sort 8s Filter command in the Editing group on the Home tab. 
Fig. 7.39 (Sorting: Sort & Filter in Editing Group under Home Tab) 

Select Sort Smallest to Largest. 
Fig. 7.40 (Sorting: Sort Smallest to Largest) 

Now the information is organized from the smallest to largest amount. 
Fig. 7.41 (Sorted List) 

Note: You can sort in reverse numerical order by choosing From Largest to Smallest 
in the list.  
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Select Filter command in Sort
& Filter group under Data 
tab. 

7.20 FILTERING 
Filtering is a convenient and reliable way to locate and manage spreadsheet data. This 

allows you to focus on specific spreadsheet entries. Filtered data can be copied, 
manipulated, and printed without having to move it to a new spreadsheet. 

Filtering in Excel 2010: 
In Excel 2010, filtering, or temporarily hiding data in a spreadsheet is very easy. You 

can filter data using the AutoFilter feature in Excel 2010 to display only the data that 
meets specified criteria. 

• Open the spreadsheet in which you want to filter data. 

 

Fig. 7.42 (Filtering: Spreadsheet for Filtering) 
• Prepare your data for an Excel 2010 AutoFilter. Excel can filter the data in all 

selected cells within a range, as long as there are no completely blank rows or 
columns within the selected range. Once a blank row or column is encountered, 
filtering stops. If the data in the range you wish to filter is separated by blank rows 
or columns, remove them before proceeding with the AutoFilter. 

• Conversely, if there is data on the worksheet that you do not want to be part of the 
filtered data, separate that data using one or more blank rows or blank columns. If 
the data you don't want to filter is located beneath the data to be filtered, use at 
least one completely blank row to end filtering. If the data you don't want to filter is 
located to the right of data to be filtered, use a completely blank column. 

 1 8...... . ■ : \ .;J. . . P . . . .  .  £  f   
1  Last First Day Worker Amount Hours  
2 Goel Amit Monday |Staff 250 22 
3 Kumar j Prem Monday ■  Student 400; 32 
4 Sharma Puneet Wednesday Staff 340 23 
5 Singh ■ Gerry Wednesday j Student 530! 25 
6 ! Mittal Arvind Thursday Volunteer 400 30 
7;i|Verma ; Anita Thursday Student 300; 34 
8 IDevgan Vipirs Friday :Staff 550! 40 
9 Kaaoo- Anil Saturday Volunteer 500| 35 
lOjBabbar ; Raj Saturday ; Volunteer 6601 20 

 

Select any cell within the range that you 
would like to filter. 
iBL:. i 

C D Day Worker 
Monday Staff Monday 
Student Wednesday Staff 

£ f, _______  
Amount Hours 
250 22 400; 32 340: 
23 

I !Last First 
2jGoei Amit 
3 1 Kumar Prem 
4 iSharma |Puneet 
5 j Singh Gerry Wednesday Student 530! 25 
6 | Mittal Arvind Thursday Volunteer 400 30 
?Jverma Anita Thursday Student 300! 34 
S 1 Devgan ; Vipin Friday Staff 550! 40 
9 | Kapoor ;Ansi Saturday Volunteer 500' 35 
lOjBabbar Raj Saturday Volunteer 660! 20 
Fig. 7.43 (Filtering: Select any Cell within the 
Range for Filtering) 
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• Drop-down arrows will appear at the top of each column range. If the range of cells 
contains column headings, the drop-down arrows will appear in the headings. 

 

Fig. 7.45 (Filtering: Drop-down arrows at the top of each column) 
• Click the drop-down arrow of the column containing the desired criteria to be filtered. 

Do the following tasks: 

(a) To filter the data by criteria, click to clear the “(Select All)” check box. All 
other check boxes will be cleared. Click to select the check boxes of the 
criteria that you want to appear in the filtered list. 

 

Fig. 7.46 (Filtering: Filter Data by Criteria) 
(b) Click "OK" to filter the range by the selected criteria. The filtered result will be 

look like this: 

 

Fig. 7.47 (Filtering: Filtered Data) 

7 21 CHARTS

   .t~, , 0 . .  

 Last i .First Day ' Worker Amotin » Hours * 
2 |Goei Amit Mond Staff 250 2
3 Kuma Prem Mond i ■ 400 3
4 i 

Shar i Ipune Iwednesday! 340; 2
5 Singh i Wednesday 339 2
6 Mittal ;ArvinThurs i 400 3
7 Verna Anita Thurs ;Stude 300 3
8 jjDevg 1 j Staff 550 4
9 IKapo Anil Satur Volunte 500 3
10 Baooa Raj Satur Volunt 660 2

 

 A 3 . ; -C 0 £ ...f-  
i Last r First * Dav v Worker T Amour* r ] Hours ■. 
n Sort A to Z  I Staff 250  22 
u Sort Z to A  1 Student 400  32 
 Sort by Color  > 1 Staff 340  23 
"'f-   I Student 530  25 

400 30 
r 1 

| Student 300' 34 
I Staff 550 40 

 g§ (Select All)  I Volunteer 500  35 
 

g| Amit 
fJArel D 
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QArv'nd g 
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□Brian 
°uneet QRaj 

 I Volunteer 
1 
; 
f 
i; 

660  20 

 □ Vipin  
I 

   

 l OK ] [ Cancel 3    

       
 

  3 C  E ft -  

I (Last 
| 

*j First Boay (§ Worker ’ Amoun/. Hours | 
 2 Goel Amit 1; Staff 250j 2

4 .Shar ;Puneet 3 Staff 340; 2
5 1 Gerry 3 530 2
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the cells in an Excel worksheet. Normally, the data that a chart uses can be resides in a 
single worksheet, or use data that is stored in other worksheets. 

7.21.1 Creating a Chart 
When you insert a chart in Excel, it appears in the selected worksheet with the source 

data, by default. 
To Create a Chart: 
• Select the worksheet you want to work with. 

OR 
• Open Excel 2010 and create a worksheet as illustrated below: 

 

Fig. 7.48 (Chart: Worksheet) 
• Select the cells that you want to chart, including the column titles and the row 

labels or highlight the exact data area that you wish to display as a chart. 
• On the Insert menu, in the Charts group, click the chart type you require. A 

gallery of thumbnail images for the related chart subtypes will appear. 

a & • 5 2 fck O 
Column Line Pie Ear Area Scatter Other 

r »' ' ' » -■ r Charts' 
' ________________ Charts • ■ ' ' ________ b: 

Fig. 7.49 (Chart: Chart Subtypes) 
• Click the required chart subtype to create the chart. In this example, suppose you 

choose a 2-D Clustered Column chart type under Column chart option. 

A ... B C D 
1 1 Marks  

2 Math English Scienc
3d Ricky sal 90 78 
4 | Vikas ss\ 56 S7 
5 .Mohit 
6 JPrana

87 73 58 55 72 
66 
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• When you have selected a subtype, a chart will be created as an object in the 
worksheet. 

 

Ricky Vikas Mohit Pranav 
Fig. 7.51 (Chart: 2-D Clustered Column Chart)

Once you insert a chart, a new set of Chart Tools,
arranged into 3 tabs, will appear above the Ribbon.
These are only visible when the chart is selected. 

Fig. 7.52 (Chart: Chart Tools)

To Change the Chart Type: 
• Select the Design tab. 
• Click the Change Chart Type command. A dialog box 
appears. • 

  

It 4 

......-««« 

Ef IP 
lid. "“Uaj 

i Change Save As Switch Select 
Chart Type Template ; Row/Coiumn Data 

Type Data 
Fig. 7.53 (Chart: Change Chart Type) 
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Book! - Microsoft Ek€6f Chart Tools 

. Formulas Data . Review . . : 'Mw ■ ■ , Design ; lay-out I 

■ Sift® I 
ni a 

!.iiL:; i h In h. J

Fig. 7.55 (Chart: Change Chart Styles)

 

• Left-click a layout to select it. 
To Change Chart Style: 
•  Select the Design tab. 
•  Locate the Chart Style group. 
• Click the More arrow to view all your style options. 
• Left-click a style to select it. 

7.22 CELL REFERENCING 
Cell referencing identifies a cell or a range of cells on a worksheet and tells Microsoft 

Excel where to look for the values or data you want to use in a formula. With cell references, 
you can use data contained in different parts of a worksheet in one formula or use the value 
from one cell in several formulas. You can also refer to cells on other sheets in the same 
workbook, and to other workbooks. References to cells in other workbooks are called links. 

7.22.1 Types of Cell Referencing 
(i) Relative cell referencing 
(ii) Absolute cell referencing 

(iii) Mixed cell referencing 
Calling cells by just their column and row labels (such as “Al”) is called Relative cell 

referencing. When a formula contains relative referencing and it is copied from one cell to 
another, Excel does not create an exact copy of the formula. It will change cell addresses 
relative to the row and column they are moved to. For example, if a simple addition formula 
in cell Cl “=(A1+B1)” is copied to cell C2, the formula would change to “=(A2+B2)” to reflect 
the new row. To prevent this change, cells must be called by Absolute cell referencing and 
this is accomplished by placing dollar signs "$" within the cell addresses in the formula. 
Continuing the previous example, the formula in cell

Chart Layouts 
 

More 
Changs the overall Iayout of th e 1 
£h3rt‘ . f D E F ■' 1........... 

Fig. 7.54 (Chart: Change Chart Layout)
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Cl would read “=($A$1+$B$1)” if the value of cell C2 should be the sum of cells A1 and Bl. 
Both the column and row of both cells are absolute and will not change when copied. Mixed 
cell referencing can also be used where only the row OR column fixed. For example, in the 
formula “=(A$1+$B2)”, the row of cell A1 is fixed and the column of cell B2 is fixed. 

To Create an Absolute Reference: 
• Enter the numbers you want to calculate (e.g., 34,567 in cell B2 and 1,234 in cell 

B3). 

• Then, create a simple formula (=B2+B3). 

 

Fig. 7.56 (Simple formula) 

• To create an absolute reference in the formula just created, insert a $ value before the 
B (column reference) and 2 (row reference) in the reference to B2 so the new formula 
reads, (=$B$2+B3). 

 

Fig. 7.57 (Absolute Reference: Create an absolute reference) 
• Copy and Paste the formula to another adjacent cell. The formula now includes an 

absolute reference to B2, (=$B$2+D3). 

| B5 T f* -B2+B3 
 A B - C 1 D E 
1    

2 Sales 34,567.00 45,234.00  
3 Expenses 1,234.0

0 21,543 00  
4    

 I 35.801.00   

6     

7     

8     

9     
 

SUM - X v! f* =$B$2+B3 . 
 ---------------- —*— ----- 1 --- ———  -  

A B c D E 
1     

2 Sales [ 34.567.00'  45,234.0
0 

 

3 Expenses [ 1.234.00  21,543.0
0 

 

4   r 
5 
- =$B$2+B3  .............  
6 \|   

7     

8 Insert a S value before the B and 2 to 
9 and absolute row reference ($2) 
10 i   

 

D5 4 fx =$B$2+D3 
 A B C rr o iE 
1    \ 
2 Sales 34,567 00  \ 45,234.00 
3 Expenses 1,234 00  \ 21,543 00 
4    \ 
  35,801 00  | 56,110.001 
S     

7     

8 The pasted cell retains the absolute 
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7.23 MACROS 
A macro is a recording of each command and action you perform to complete a task. 

Then, whenever you need to carry out that task in a spreadsheet, you just run the macro 
instead. 

Macros are advanced features that can speed up editing or formatting you may 
perform often in an Excel worksheet. They record sequences of menu selections that you 
choose so that a series of actions can be completed in one step. 

To Record a Macro in Excel 2010: 
• Click the View tab on the Ribbon. 
• Click Macros. 
• Click Record Macro. 
• Enter Macro name (without spaces). 
• Enter a Shortcut key. 
• Enter a Description about the macro (optional). 
• Click OK. 

 

• Perform the Macro. 
• Click Macros. 
• Click Stop Recording. 
To Run a Macro in Excel 2010: 
To run a macro from the keyboard shortcut, simply press the keys that you have 

programmed to run the macro. 
OR 

You can view all macros and run by: 

Fig. 7.59 (Macro: Record a Macro)
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Fig. 7.60 (Macro: Run a Macro)

□□□□□ 





 

A presentation is a good way to convey pieces of information, usually in the form of an 
outline, to a large audience. Generally, computerized presentations are appealing to users 
because these are easy to create, edit and generally small enough to fit onto a CD or a USB 
Drive. 

Presentations consist of a number of individual pages called "slides". Slides may contain 
text, graphics, movies, and other objects, which may be arranged freely. So, a presentation is a 
combination of slides, handouts, notes, and outlines all in one file. You can add text, graphics, 
photos, clip art, sound and video to your slides. 

A presentation is any kind of interaction between a speaker and audience, but it usually 
involves one or more of the following visual aids: LCD projectors, computer- based slides, 
handouts, and speaker notes. 

The presentation can be printed or even displayed live on a computer. For larger 
audiences the computer display is often projected using a video projector. 

8.2 MICROSOFT POWERPOINT 
Microsoft PowerPoint, usually just called PowerPoint, is a closed source commercial 

presentation program developed by Microsoft. It is part of the Microsoft office suite, and runs on 
Microsoft windows operating system. 

In the Microsoft office suite, PowerPoint is the presentation graphics software used to 
design dynamic and easy to use presentation. Today, PowerPoint presentations in many 
forms, styles and custom layouts are used by working professionals, academics, students, 
medical practitioners and others to display data and information in a visual manner. 

Microsoft PowerPoint is a professional presentation program that allows the user to create 
"presentation slides" that can be displayed on the computer screen or through a projector that 
is plugged in to the computer. 

As a part of the Microsoft Office Suite, PowerPoint has become the world's most widely 
used presentation program used for making visual aids for presentations. The primary users 
of this software are sales and business staff, teachers, and trainers. This software is relatively 
easy to use and is designed to provide a novice user with a professional presentation tool at a 
minimal cost. 

There are three main functions within PowerPoint presentation software: creation, editing, 
and presentation. The functionality provided in this tool interacts seamlessly with all other 
Microsoft Office applications. This gives the user the ability to copy and paste text and images 
from other documents and quickly incorporates them into a presentation. 

Microsoft release PowerPoint 2010 (included in Office 2010) on June 15, 2010. It has been 
redesigned with a much more features, user-friendly and intuitive layout than its 
predecessors. PowerPoint 2010 provides a variety of professionally designed templates, 
themes, and style galleries to help you create great-looking presentations. 
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resolution, less information fits on your screen, but the size of your text and images are 
larger. If you use a high resolution, more information fits on your screen, but the size of the 
text and images are smaller. 
8.2.1 Features of PowerPoint 2010 

Microsoft PowerPoint 2010 enables you to quickly create high-impact, dynamic 
presentations. Some of the important features of PowerPoint 2010 are: 

• Intuitive User interface: PowerPoint 2010 has a new, intuitive user interface called 
the Ribbon that helps you create better presentations much more quickly than you 
could in earlier versions of PowerPoint. 

• Create Dynamic presentations: PowerPoint 2010 quickly create dynamic and 
great-looking presentations using the redesigned user interface and new graphics 
capabilities. 

• Video Capabilities: One of the attractive features of Microsoft PowerPoint is that it 
allows you to use video in your presentations. With this software, you can embed a 
video clip into one of your slides and use it during the slide show. When you embed 
the video, you can also perform a number of editing functions which will allow you to 
alter the video to your needs for the presentation. For example, you can trim the 
videos, bookmark specific scenes, and add fades and more. 

• Live Preview: PowerPoint 2010 takes advantage of the live preview feature to review 
your formatting choices before you apply them. 

• Apply a consistent look and feel in one click: PowerPoint 2010 themes help you 
change the look and feel of your entire presentation with just one click. Changing the 
theme of your presentation not only changes the background color but the color of a 
diagram, table, chart, or font, and even the style of any bullet points within a 
presentation. 

• Sharing: Another feature of Microsoft PowerPoint 2010 is the ability to share 
presentations with other individuals in different locations. For example, you can 
create a video of your slideshow and then send the video to other individuals. 

• Special Effects: When creating a presentation, one of your jobs as a presenter is to 
keep the attention of your audience. If you create a plain presentation without any 
flair, your subjects may not pay attention for long. With Microsoft PowerPoint 2010, 
you can use a number of special effects to enhance the quality of your presentation. 
For instance, you can use animations and transition effects when changing slides. 

• Dramatically modify shapes, text, and graphics with new tools and effects: 
You can now manipulate and work with your text, tables, charts, and other 
presentation elements in much richer ways than ever before. 

• Reduce your document sizes and improve damaged file recovery at the 
same time: The new, compressed Microsoft PowerPoint XML Format offers a 
dramatic reduction in file size, while offering an improvement in data recovery for 
damaged files. 

• Help protect the private information in your documents: Detect and remove 
unwanted comments, hidden text, or personally identifiable information using the 
Document Inspector, preparing your presentation to be shared with others. 

• Support other File formats: PowerPoint 2010 enable support for other file formats, 
such as PDF (Portable Document Format) and XPS (XML Paper specification). 

* • Themes and Quick Styles: PowerPoint 2010 comes with new themes, 
layouts and Quick Styles that offer you a wide range of options when you are 
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8.3 STARTING MICROSOFT POWERPOINT 2010 | 

To start PowerPoint 2010 from the Start Menu: 
• Click on the Start button, point to All Programs then Microsoft Office and click on 

Microsoft PowerPoint 2010. 

• The first screen that you will see a new blank presentation begins automatically with 
one slide. 

 

Let us understand the various important elements of this window: 
• File Tab: The File tab replaces the Office button from PowerPoint 2007. You can click 

it to check Backstage view, which is the place to come when you need to open or save 
files, create new presentations, print a presentation, and do other file-related 
operations. 

• Quick Access Toolbar: The Quick Access Toolbar you will find just above the File tab 
and its purpose is to provide a convenient place for the PowerPoint most frequently 
used commands. You can customize this toolbar based on your comfort. 

• Ribbon: Ribbon contains commands organized in three components: 
1. Tabs: Tabs appear across the top of the Ribbon and contain groups of related 

d  H  I  d P  L   th  l  f ibb  t b  

Fig. 8.1 (Microsoft PowerPoint Window or Screen Layout)



 

example: Bold, Italic and Underline are the commands appear under Font 
group of Home tab. 

• Title Bar: This is the top section of the window. It shows the name of the file 
followed by the name of the program which in this case is Microsoft PowerPoint. 

• Slide Area: This is the area where the actual slide is created and edited. You can 
add, edit and delete text, images, shapes and multimedia in this section. 

• Help: The Help Icon can be used to get PowerPoint related help anytime you need. 
Clicking on the "?" opens the PowerPoint Help window where you have a list of 
common topics to browse from. You can also search for specific topics from the 
search bar at the top. 

• Zoom Options: Zoom control lets you zoom in for a closer look at your text. The 
zoom control consists of a slider that you can slide left or right to zoom in or out, 
- and + buttons you can click to increase or decrease the zoom factor. The 
maximum zoom supported by PowerPoint is 400% and the 100% is indicated by 
the mark in the middle. 

• Slide Views: The group of four buttons located to the left of the Zoom control, near 
the bottom of the screen, lets you switch between PowerPoint views, o Normal 
Layout view: This displays page in normal view with the slide on the 

right and a list of thumbnails to the left. This view allows you to edit individual 
slides and also rearrange them, o Slide Sorter view: This displays all the slides as a 
matrix. This view only allows you to rearrange the slides but not edit contents of each 
slide, o Reading View: This view is like a slide show with access to the Windows task 
bar in case you need to switch windows. However, like the slide show you cannot edit 
anything in this view and clicking will progress the presentation to the next slide. 

• Notes Section: This section allows you to add notes for the presentation. These 
notes will not be displayed on the screen during the presentation; these are just 
quick reference for the presenter. 

• Slide Tab: This section is available only in the Normal view. It displays all the 
slides in sequence. You can add, delete and reorder slides from this section. 

8.4 BACKSTAGE VIEW I 
One major change in Office 2010 is the Microsoft Office Backstage View, which replaces 

the traditional File menu in older versions of Office and. the Office Button in Office 2007. 
The backstage view helps in creating new presentations, saving and opening 

presentations, printing and sharing presentations, and so on. However, instead of just a 
menu it is a full-page view, which makes it easier to work with. 
The backstage view screen works under three panes: 

(i) The left pane of the Backstage View lists common commands for creating, saving, or 
printing your file. 

(ii) The middle pane typically displays additional options you can choose for the 
command selected in the left pane. 

(iii) The right pane displays additional details about your file.
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Fig. 8.2 (Backstage View Screen)
To use the Backstage View, follow these basic steps: 

1. Click the File tab, located in the upper-left corner of the Word Ribbon to
You can also open the Backstage View by

Inse
rt 

Animations Slide StiOw View 

last Printed 

display the Backstage View, 
pressing Alt+F. 

2. Select a command in the left pane to view your options in the middle pane. 
3. Select an option in the middle pane. 
4. View the information in the right pane. 

If you already do not have any opened presentation then you will see a window listing 
down all the recently opened presentations as follows: 

PROJECT REPORT ARCHANA 

Desktops 

Info 

New 

Print 

Fig. 8.3 (Backstage View Screen - Recent Opened presentations)
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The various commands available on the File tab include: 
• Save: Saves your file. If you haven’t named your file yet, the Save command is 

equivalent to the Save As command. 
• Save As: Save the current file under a new name and/or in a different file format. 
• Open: Loads an existing file. 
• Close: Closes an open file but keeps the Office 2010 program (PowerPoint) running. 
• Info: Displays the information about the current file. 

• Recent: Displays a list of files that you recently loaded. 

• New: Creates a new file. 
• Print: Prints the current file. 
• Save & Send: Allows you to share your presentation with larger audience via 

emails, web, cloud services, etc. 
• Help: You can use this option to get required help about PowerPoint 2010. 

• Options: Allows you to set various options related to PowerPoint 2010. 

• Exit: Closes any open files (presentations) and exits the program (PowerPoint). 
8.5 CREATING NEW PRESENTATION 

PowerPoint files are called presentations. When you start a new project in PowerPoint, 
you'll need to create a new presentation. 

If you already have an opened presentation then it will display a window showing detail 
about the opened presentation as shown below: 
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When you first start PowerPoint, the program loads a blank presentation that you can 
modify later on. 

To Create a New Presentation: 
1. Click the File tab. 

The Backstage View appears. 
2. Click New. 

PowerPoint displays different templates you can choose. 
3. Click Blank Presentation and then click Create. 

PowerPoint displays a blank slide with a title and subtitle box, as shown in 
Figure 8.5. 

 

To Enter Title and Subtitle: 
• Click on "Click to add title" section of the slide and enter the slide title. 
• Click on "Click to add subtitle" section of the slide and enter the desired text. 

8.6 WORKING WITH SLIDES 
(i) To Insert a New Slide Using the Keyboard: 

• Press Ctrl + M 
(ii) To Insert a New Slide Using the Mouse: 

• On the Home tab, in the Slides group, click the upper portion of the New 
Slide button. This will add a new slide with bullet point in it. 

(iii) To Insert a New Slide with different layouts: 
• On the Home tab  in the Slides group  click the lower portion of the New 

Fig. 8.5 (A new presentation consisting of a single blank slide)
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• Click on the intended layout will insert the slide to your presentation. 
(iv) To Change the Layout of an Existing Slide: 

• Select the slide you wish to change. 
• Click the Layout command in the Slides group on the Home tab. A menu 

appears with your options. 

 

Fig. 8.6 (Several Slide Layouts)

Fig. 8.7 (Changing the Layout of Existing Slide) 

• Click an option to select it. The slide will change in the presentation. 
(v) To Copy and Paste a Slide: 
• On the Slides tab in the left pane, select the slide you want to copy. 
• Click the Copy command on the Home tab. You can also right-click your selection 
and choose Copy. 



 

our 

Fig. 8.10 (Paste a Slide) 

Fig. 8.9 (Copying a Slide: Insertion Point) 

Click the Paste command on the Home tab. The copied slide will appear. 
(vi) To Delete a Slide: 

• Select the slide you wish to delete. 



 

• Select the slide you want to duplicate. 
• On the Home tab, in the Slides group, click the lower portion of the New Slide 

button. 
• Choose Duplicate Selected Slides from the drop-down menu.
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8.7 ADDING TEXT TO SLIDES 
PowerPoint allows users to add text to the slide in a well-defined manner to ensure the 

content is well distributed and easy to read. The procedure to add the text in a PowerPoint 
slide is always the same - just click in the text box and start typing. The text will follow the 
default formatting set for the text box, although this formatting can be changed later as 
required. 

To add text to your slide, you can either use the placeholders provided when you choose 
a layout or create a text box on a blank slide. 
Adding Text to a Placeholder: 

If you have selected a layout for your slide, you will see boxes that contain dummy text 
which read something like "Click to Add Title" or "Click to Add Text". When you click in 
the box, the dummy text will disappear, the cursor will become a blinking line ( | ), and you 
can begin to type your text. These boxes or containers are called “Placeholders 

Some of the commonly found placeholders are: 
• Title Box 

This is typically found on slides with title layout and in all the slides that have a title 
box in them. This box is indicated by "Click to add title". 

• Subtitle Box 
This is found only in slides with Title layout. This is indicated by "Click to add 
subtitle". 

Fig. 8.11 (Duplicate a Slide) 
• A copy of the selected slide appears 
underneath the original. 

Title Box 
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Fig. 8.14 (Text Only Box) 

• Content Box 
This is found in most of the slides that have a placeholder for adding content. This is 
indicated by "Click to add text". As you can see, this box allows you to add text as well 
as non-text content. To add text to such a box, click anywhere on the box, except on one 
of the content icons in the center and start typing. 

 

• Text Only Box 
This is not a default content box available in PowerPoint, but you can create it using 
Slide Master, if required. This is also indicated by "Click to add text". 

To Create a Text Box: 
• To create a text box in a blank slide, go to the Insert tab on the Ribbon and click on 

the Text Box button. 

 

To Resize a Text Box: 
• If you wish to resize your text box after it is created, hover your mouse over the 

circles or squares around the border of the box. The circles will resize both the 
width and the height of the box, the squares on the top and bottom will resize the 
b  ti ll  d th    th  id  ill i  it h i t ll  

Click to add title 

« Click to add text 

ill m 
i 

Non-Text Content Icons 
Fig. 8.13 (Content Box) 

• Your mouse pointer will change to an insertion point. Left click and drag your 
cursor across the screen to choose the size and location of your text box. 

 

Fig. 8.15 (inserting a Text Box) 
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• To rotate the text box, left click on the green circle above the box and drag your mouse. Se 

To simply move the box, click on the border and drag your mouse. 

Note: If you want to move the box in a straight line, hold down the Shift key before
clicking and dragging the mouse. ___________________________________________________ / 

To Delete a Text Box: 
To delete a text box, click on the border of the box. Once the border is highlighted, press 

the [Delete] key on your keyboard. 

/ Note: If you can't see the border of the box, first click on the text. This will make the border
visible. ] 

8.8 ADDING GRAPHICS 
Graphics such as drawings, pictures, clip art or graphs are frequently used in PowerPoint 

presentation. 

8.8.1 Adding Picture To 
Add a Picture: 

• Click the Insert Tab. 

• Click the Picture Button. 

• Insert Picture Dialog box appears: 

Desktop 

My Documents 

My Computer 

My Netvvork 
Pisces 

File name: 
Files of Svpe: iA||plctur<: 

Fig. 8.16 (Insert Picture Dialog Box) 

• Browse to the picture from your files. 
• Click the name of the picture. 

• Click insert. 

• Search for tl • 

Click the clip • To 

move the g

8.8.3 Adding a Shap< 
To Add Shapes: Click 
the Insei Click the 
Shap Click the shap 
Click the Slide Drag 
the cur Shape. 
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8.8.3 Adding a Shape 
To Add Shapes: 
• Click the Insert Tab. 
• Click the Shapes Button. 
• Click the shape you choose. 
• Click the Slide. 
• Drag the cursor to expand the 

Shape. 

Insert De ,<gn Ammotions SUde Show 

I|i m phis ii.fi 
 

' Clip- 1 Phots Shapes-SmartArt Chart : Hyperlink Action  
Art Album ^ v 1  

 SK'JSt
t Recently Used Shapes  

AJT S W D O Q A T T ^ ' O ’ G   

 . . T ;  i  li A .  X >  ☆   

J .  |  
■ :   Lines  

i  1 1     

jm  Rectangles  

  □O Q Q Q O a Q a  

  Basic Shapes  

  E3 O A tL£7"dO O Q © ®  i >  
®  C b  G >  o  n  r  O  f G >  O  0  o   

  □ □ ©^ n o  c i > 
Block Arrows 

: ’ : : :■ v V .  c . - 2f _j % ,u^ O Lr^ '■£] 
■ : & 

Equation Shapes . • T ■ 
Flowchart 

=30 . ' 
o o s a m @ ©  I  §  i ^ S D  Q . S C D © 

 

• Search Clip Art Dialog box appears.

• Search for the clip art using the Search Clip Art dialog box. 
• Click the clip art. 
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To Add SmartArt: 
• Click the Insert Tab. 
• Click the SmartArt Button. 

• Choose a SmartArt Graphic dialog box appears. 

Fig. 8.19 (Choose a SmartArt Graphic dialog box) 

• Click the SmartArt you want to choose. 
• Click the OK. 
• Drag it to the desired location in the slide. 
8.8.5 Adding a Photo Album 
The Photo Album feature allows you to easily create a photo album to share
pictures. To Create a Photo Album: 
• Click the Photo Album button on the Insert tab. 
• Click New Photo Album. 
• Photo Album dialog box appears. 
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Fig. 8.21 (Save As dialog box) 

• In the Save As dialog, type in the file name and click
"Save". 

8.9 SAVING A PRESENTATION 
One of the most basic tasks in PowerPoint is being able to 

save your work; this is probably the most important task as 
well. Here are the basic steps to save a presentation. 

• Click on the File tab to launch the Backstage view and select 
Save. Save As dialog box appears. 

8.10 OPENING A PRESENTATION 
There may be a situation when you open an existing 

presentation and edit it partially or completely. 
To open an existing document: 
• Click the File tab. This takes you to Backstage view. 
• Select Open. The Open dialog box appears. 
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• Select your desired presentation, and then click Open. 
8.11 MULTIMEDIA 

Adding multimedia such as audio and video to your 
presentation can be a great way to catch audience's attention. 

PowerPoint 2010 provides some videos and sound clips that 
are free to use in the Clip Manager. You can also use clips from 
other sources, such as the Web, a CD of sound effects, or 
sounds you create yourself. 
8.11.1 Inserting Sounds 

PowerPoint allows you to add sound to your presentation, 
which opens up many possibilities. Perhaps you want to add 
background music to one slide, a sound effect to another and 
some narration or commentary to a few slides. You can either 
add an audio file from your computer or browse PowerPoint's 
collection of clip art audio. 

To insert audio from a file on your computer: 
• From the Insert tab, click the Audio drop-down arrow and 

select Audio from File. 
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Symbol Video i Audio  

 .........................................................................................MS 'B  * udio from File... 

C Art Audio.., 

Record Audio... 
Fig. 8.23 (Insert Audio from a File) 
 

• Locate and select the desired audio file, then click 
Insert. 
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 Fig. 8.25 (Insert Clip Art Audio) 

Enter keywords in the 
Search for: field, then 
click Go. 

Fig. 8.26 (Insert Clip Art Audio: Search for Audio)
The results will appear in the
Clip Art pane. To preview an
audio file, right-click the file
and select Preview/Properties. 

Fig. 8.27 (Insert Clip Art Audio: Search for Audio)

A dialog box will appear, and the audio file will 
start playing automatically (it 
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• When you're finished previewing the file, click Close. 
8.11.2 Inserting Videos 

Adding videos to a PowerPoint presentation is very similar 
to adding sound. PowerPoint 2010 provides some videos and 
sound clips that are free to use in the Clip Manager. You can 
also use video clips from other sources, such as the Web, a CD 
of video effects, or videos you create yourself. 

To insert a video from a file on your compute: 
• From the Insert tab, click the Video drop-down arrow and 

select Video from File. 

 

 

• The video will be added to the slide. 
8.12 PRESENTATION VIEWS 

There are many views in PowerPoint that can help you to 
create a professional presentation. The views in Microsoft 
PowerPoint 2010 that you can use to edit, print, and deliver 
your presentation are as follows: 

1. Normal view 
lid i

£
2

£ 

Vid  
4 

  T 
bols mideo from File... 

 iWeo from Web Site... i 
 

Clip Art Video,,. 
Fig. 8.29 (Insert Video from a file) 
 

• Locate and select the desired video file, then click Insert.

 

Fig. 8.30 (Insert Video from a file: Locate and select the Video)
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PowerPoint and this is primarily used to create  
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and edit slides. You can create/ delete/ edit/ rearrange slides,
add/ remove/ modify content and manipulate sections from
this view. 

2. Slide Sorter view 
This view is primarily used to sort slides and rearrange them. 

Slide Sorter view gives you a view of your slides in thumbnail 
form. This view makes it easy for you to sort and organize the 
sequence of your slides as you create your presentation, and 
then also as you prepare your presentation for printing. 

You can add sections in Slide Sorter view as well, and sort 

slides into different categories or sections.
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Slide#2

* Sample Text 2
* Only text box content 

3. Reading view 
This view is new to PowerPoint 2010 and it was created 

mainly to review the slide show without losing access to rest of 
the Windows applications. Typically when you run the slide 
show, the presentation takes up the entire screen so other 

applications cannot be accessed from the taskbar. In the 
reading view the taskbar is still available while viewing the slide 
show which is convenient. You can always switch from Reading 
view to one of the other views if you want to change the 
presentation. 

 

 

4. Slide Show view 
Use Slide Show view to deliver your presentation to your 

audience. Slide Show view occupies the full computer screen, 
exactly the way your presentation will look on a big screen 
when your audience sees it. You can see how your graphics, 
timings, movies, animated effects, and transition effects will 
look during the actual presentation. 

To exit Slide Show view, press ESC. 

 

Windows Taskbar visible PowerPoint bottom bar visible 

Fig. 8.33 (Reading View) 
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8.13 TRANSITION EFFECTS 
Transition effects or Transitions are the movements you 

see when one slide changes to another in slide show view. 
Transition effects are different from animation effects. The 

Fig. 8.34 (Slide Show View)



MS-POWERPOINT 8.23

 

Fig. 8.35 (Applying Transition Effects) 

• Click the More drop-down arrow to display all 
the transition effects. 

Fig. 8.36 (Transition Effects) 

• Click a slide transition effect to apply it to
the selected slide. 
Note: Hover over a slide transition effect to 
see a live preview of the effect on the 

term animation in PowerPoint refers to the movements of 
text and objects on the slide, while transitions refer to the 
movement of the slide as it changes to another slide. 

To Apply a Transition to One Slide: 
• Select the slide you wish to modify. 
• Select the Animations tab. 
• Locate the Transition to This Slide group. By default, No 

Transition is applied to each slide.  
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• Click Apply To All to apply the transition to all the slides in
the presentation. 

Fig. 8.37 (Transition Effects: Apply To All)

Fig. 8.39 (Transition Effects: Set Transition Sound)

Note: Click Apply To All if you wish to 
apply the transition effect and
transition 
sound to all slides. ________________________
To Remove a Slide Transition Effect: 
• Select the slide you wish to modify. 
• Select the Animations tab. 
• Click No Transition in the Transition to 
This Slide group. 

8.13.1 Modifying a Transition 
To Set Slide Transition Speed: 
• Apply a slide transition effect to a slide. 
• Click the Transition Speed drop-down menu in the Transition to 
This Slide 

group on the Animations tab. 
• Select a menu option to apply the transition speed to the 
selected slide. 

 

To Set Slide Transition Sound: 
• Apply a slide transition effect to a slide. 
• Click the Transition Sound drop-down menu in the Transition to 
This Slide 

group on the Animations tab. 
• Select a sound to apply it to the selected slide. 

Fig. 8.38 (Transition Effects: Set Transition Speed) 
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® Repeat this process for each slide you want to modify. 
OR 

• Click Apply To All to remove the slide transition effect from 
each slide in the presentation. 

To Set Timing for Slides: 
• View the slides in slide sorter view. 
• Select a slide. 
• Select the Animations tab. 
• Locate the Advance Slide section of the Transition to This 

Slide group. 
• Enter the time in the 

Automatically After field. Use the 
arrows or type the number. 

Advance Slide jlj On Mouse 

Click ftp] Automatically 

After; 

; Automatically After 

Move to the next slide after a 
certain number of seconds. 

Fig. 8.41 (Transition Effects: Set Timing for Slides) 
• Select another slide and repeat the process until all the 

desired slides have the timing set. 
Note: If you want to apply the same transition effect and 
timing for each slide, just set the transition effect timing for 
one slide and click Apply to All. 

8.14 ANIMATION EFFECTS 
In PowerPoint you can animate text and objects such as clip 

art, shapes, and pictures on the slide. Animation, or 
movement, on the slide can be used to draw the audience's 
attention to specific content or to make the slide easier to 
read. 

To Apply Animation Effect: 
• Select the text or object on the slide you wish to animate. 
• Select the Animations tab. 
• Click the Animate drop-down menu in the Animations 

group to see the animation options for the selection. The 
options change based on the selected item. 
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Fig. 8.43 (Applying Custom Animation Effects) 

9 

9 

▼  X 

• Move your cursor over each option to see a live preview of 
the animation on the slide. 

• Click an option to select it. 
To Apply a Custom Animation Effect: 
• Select the text or object on the slide you wish to animate. 
• Select the Animations tab. 
• Click Custom Animation in the Animations group. The Custom 

Animation task pane will appear on the right. 

Click Add Effect in the task pane to add an animation effect to 
the selected text or object. 
Select Entrance, Emphasis, Exit, or Motion Path to display a sub 
menu of animation effects 
for the category. 

I Custom Animation 

 

(a) Entrance animation effects: Changes how the selected item 
appears on the page 

(b) Emphasis animation effects: Draws attention to the 
selected item while the slide is displayed 

(c) Exit animation effects: Changes the way the selected item 
disappears from the slide 

(d) Motion Path animation effect: Animates the selected item 
h i ifi l h
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& Emphasis ► % 2. Box 
 Exit ►  3, Checkerboard 

& Motion Paths ► Wt 4, Diamond 
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; Add Effect ▼ j*V, Remove ;■ 

Fig. 8.44 (Animation Effects: Add Effect in the Task Pane)
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To Modify Animation Effect: 
• After you apply an animation effect, drop-down menus will 

appear at the top of the Custom Animation task pane. The 
menus vary based on the animation effect. 

• Select an option from a drop-down menu to change the 
default setting. 
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• Select the text or object on the slide you wish to modify. 
• Select the Animations tab. 
• Click Custom Animation in the Animations group. The Custom 

Animation task pane will appear on the right. 
• Select the animation in the Custom Animation task pane 

list, if it is not already selected. 

 

□□□□□

• Click Remove. The animation label will disappear from 
the slide and from the Custom Animation task pane list. 

 

Fig. 8.47 (Removing Animation Effects)
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■  9.1 INTERNET 
Computer network is a group of computers 

linked together, so that they can share I 
information and resources. Internet is a global 
“network of networks". It can also be I 
described as information highway. It is the 
world’s largest network of computers. The I 
networks are related to academics, research, 
government and include users of all types I of 
profiles i.e., corporate, individuals, professionals, 
children, schools, institutes etc. It I may be 
remembered that computer is not located at a 
single site, not controlled by any I central 
authority. The networking in the internet are not 
directly connected but interconnected. The ability 
to graphically access internet resources 
throughout the web is the primary reason for the 
phenomenal growth of the internet. 

The internet can be known as a kind of global 
meeting place where people from all parts of the 
world can come together. It is a service available 
on the computer, through which everything 
under the sun is now at the fingertips of anyone 
who has access to the internet. 

To get ‘online’, meaning to connect to the 
Internet, you need to have: 

• A Computer: A computer is also called a 
“Data Processor” because it can store, 
process, and retrieve data whenever 
desired. Computer equipment is a sizeable 
investment and thus you should select a 
computer carefully. Before buying a 
computer, understand your needs and then 
choose one accordingly. 

• Internet Sermce Provider: This is the 
software that you will require to get online. 
You can now choose from a dial-up service 
or 24-hour broadband services. This is the 
service that will help you to connect to the 
Internet and start your surfing experiences. 

In the early days most people just used the



 

9.2 INTERNET SERVICES 
Internet is helpful to each and every one in some or many 

ways. Whether it is a business house or a small company, an 
institution or a hospital, a doctor or an engineer, a student or a 
house wife, it serves the need of every one. Internet applications 
are interactive services that are used to perform tasks over the 
internet. Some of the major services provided on internet are: 

• Communication: Internet is used for sending and receiving 
message. E-mail is an online correspondence system. With 
e-mail you can send and receive instant electronic 
messages, which work like writing letters. Your messages 
are delivered instantly to people anywhere in the world, 
unlike traditional mail that takes a lot of time. Some of 
the popular web sites providing this service are: 
www.yahoomail.com,www.gmail.com etc. 

• Access Information: The internet is a virtual treasure of 
information. Any kind of information on any topic under 
the sun is available on the internet. The ‘search engines’ 
on the internet can help you to find data on any subject 
that you need.
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• Shopping: Along with getting information on the internet, 
you can also shop online. There are many online stores 
and sites that can be used to look for products as well as 
buy them using your credit card. You do not need to leave 
your house and can do all your shopping from the 
convenience of your home. 

• Online Chat: There are many ‘chat rooms’ on the web that can be 
accessed to meet new people, make new friends, as well as 
to stay in touch with old friends. 

• Searching Information: Internet is widely used to find 
information about a specific topic. Manufacturers can 
search for suppliers of raw materials, students can search 
for good books, doctors can search information about 
treating a new disease, and an engineer can use it to find 
details about some engineering project and so on. Special 
sites called Search Engines are used to help user in 

, finding the particular information of his interest. Due to 
this feature, it is called information hotspot. You can 
search images, text, animation, movies, songs and many 
more. 

• Sharing of Information: Large corporate houses like banks and 
money transfer companies use internet to share global 
information among various branches situated all over the 
world. 

• Downloading Software: This is one of the most happening and 
fun things to do via the internet. You can download 
innumerable, games, music, videos, movies, and a host of 
other entertainment software from the internet, most of 
which are free. 

9.3 E-MAIL 
E-mail or Electronic mail is one of the most widely used 

services of the internet. E- mail service allows a user to send 
messages (text, pictures, sound, files, program files or animated 
movies) over the internet to another user in any part of the 
world. With E-mail, sending and receiving messages has become 
an easy task. It simply involves opening of connection for 
communication, sending data and finally closing down the 
connection. It eliminates time delays and other problems 
associated with physically delivered e-mails. All the users who 
send e-mail must have an e-mail address (E-mail Id). Internet 
e-mail address looks like this: 

way2punit@yahoo.co.in 
way2punit is the account name assigned to user by the 

administrator of yahoo e- mail server, yahoo is the e-mail 
service provider and .co represents that yahoo is a commercial 
e-mail service provider and .in represents the country to which 
the user belongs. No two users on the same server can have 
same account name. Some of the popular e-mail service 
providers are
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the mail is called sender and one, who receives the mail is called 
recipient. In e-mail compose box, cc stands for carbon copy and bcc 
stands for blind carbon copy. 

• To send an e-mail, the user opens the e-mail client 
software. 

• Sender writes the message along with e-mail address of 
the recipient in appropriate box. 

• When the user presses the send button, the message is 
transferred to a special computer called Mail Server owned by 
Internet Service Providers to manage e- mails.
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The mail server analyses the recipient 
address and identifies the route to send the 
message. 
The message reaches the mail server of the 
recipient. 
The receiver mail server transfers the 
message to the account of the recipient. 
The recipient logs on to the account and 
accesses the message. 

[5,3.2 Advantages of E-Mail 
The advantages of E-mail are: 
• Messages can be sent anywhere around the 

world in an instantly. 
• Transmission usually costs nothing, or at the 

most, very little. 
• Easy to use, after initial setup. 
• Sending to a group can be done in one step. 
• Pictures, Audio, Video or other files can be 

sent. 
• Email is effective in finding the right person 

in an organization or company to answer 
your question. 

• Email is good to make appointments for 
busy people. 

• Email can distribute information quickly to 
many people for the time it takes to email 
one person. 

• You can access your email anywhere at any 
time. You can access it from any computer 
or mobile device that an internet 
connection. 

9.3.3 Disadvantages of E-Mail 
• Emails may carry viruses. These are small 

programs that harm your computer system. 
They can read out your email address book 
and send themselves to a number of people 
around the world. 

• Many people send unwanted emails to 
others. Theke are called spam mails. It takes 
a lot of time to filter out the unwanted 
emails from those that are really important. 

• Your mailbox may get flooded with emails 
after a certain time so you have to empty it 
from time to time. 



 

9.3.4 Snail Mail Vs. E-Mail 

 

9.4 WORLD WIDE WEB (WWW) 
When most people think of the internet, the first thing they 

think about is the World Wide Web. Nowadays, the terms 
“Internet” and “World Wide Web” are often used 
interchangeably, but they're actually not the same thing.

Snail Mail E-Mail 
Address 

Puneet Kumar #1020 
Ranjit Nagar Khanna - 
141401 

way2 punit@gmail .com 

Delivery • Your envelop or 
package is delivered by 
a mail carrier. 

• Received in a home mail 
box or post office box. 

Your digital message is 
delivered electronically 
across the internet through 
various servers. 

Received online in the inbox 
of your e-mail service 
provider (Gmail YahooTime • Average of 2 days for 

letters  

Instantly or within a few 
minutes if servers are busy. 

Contents May include packets with 
documents or packages 
with larger items. 

May include attachments 
for digital documents, files, 
images, audio, video and 

Costs The price of stamps or 
shipping for larger items. Free with internet 

connection   
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The World Wide Web, abbreviated as WWW and commonly known as the 
Web, is a system of interlinked hypertext documents accessed via the 
nternet. World Wide Web is a set of programs, standards and 

protocols that allows the text, images, animations, sounds, and 
videos to be stored and accessed and linked together in the form 
of websites. Basically, WWW is a collection of millions of web 
pages stored in thousands of computers all over the world. It is a 
safe house for storing information on the internet. They are very 
helpful in searching all the information present on the internet. 
With a web browser, one can view web pages that may contain 
text, images, videos, and other multimedia and navigate between 
them by using hyperlinks. 

There are basically three components which together form the 
World Wide Web. They are the Internet, the Information Servers which contain 
and distribute information, and the Web Browser which the individual 
uses to obtain information and pages from the web. 
9.4.1 Features of WWW 

• The amount of information available on the internet has 
become so large that it is difficult to search for specific 
information. The World Wide Web (WWW) makes retrieval 
easy and quick. 

• The WWW is a search tool that helps you find and retrieve 
information from a website using links to other sites and 
documents. The WWW was built on the technology called 
Hypertext. This technology increases accessibility to linked 
documents on the internet and helps user to navigate 
between documents very easily. 

• A major advantage of the WWW is that it also supports 
TCP/IP services, such as Gopher, FTP, and Archie in addition to 
HTTP. 

• Hypertext is identified by underlined text and a different 
color usually. Hypertext can make links within the same 
document or to other documents. 

• Each time you access a new document by choosing a link, 
there is a connection made with the web server that the 
document is on. Once the appropriate document is retrieved 
the connection is broken. There is no point in maintaining 
the link while you are viewing it. This is one reason why the 
WWW is so efficient. 

• WWW lets you search, traverse, and use many types of 
information at numerous sites and in multiple forms. This 
interface is called a browser. Some people refer to a browser as 
a 'web browser'. 

• The WWW is intended to help people share information 
resources, and services with the widest possible community 
of users. Thus a user can access the WWW on Apple, UNIX, 
Macintosh, DOS, Windows, and other operating systems. 

• Just like the Internet, the WWW has a protocol, which is 
known as HyperText Transfer Protocol (HTTP). 

9.4.2 Internet Vs. WWW 

■ ■ The concept of internet starts in late  The graphical interface 
of internet is 1960s. Initially, it was purely a text- known as 
WWW developed in 1989. based system. __  __________________  
 ___________________  

9.5 ISP (INTERNET SERVICE PROVIDER) 

 

The Internet is the physical 
network of computers all over 
the world. 

The World Wide Web is a virtual 
network of web sites 
connected by hyperlinks (or 
"links"). Web sites are stored 
on servers on the internet, so 
th W ld Wid W b i tternet is a worldwide network 

of networks. It connects 
millions of computers 
together globally, forming a 
network in which any 
computer can communicate 
with any other computer as 
long as they are both

he Web is a bunch of "pages" of 
information connected to each 
other around the globe. Each 
page can be a combination of 
text, pictures, audio clips, video 
clips, animations, and other 
stuff. 
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etc. 
ISPs have special computers called Internet Servers which are

connected to the internet from one end and to several users from
the other end. These servers work 24 X 7 to provide services to
their customers. 

In addition to serving individuals, ISPs also serve large
companies, providing a direct connection from the company's
networks to the Internet. 
9.5.1 Types of Internet Connections 

The connection to service provider can be temporary as well as
permanent, depending upon the choice of the customer. Different
types of internet connections are: 

(i) Dial-up Connection 
• It is the analog form of internet connection. 
• In this type of connection, user creates a temporary 

connection with the ISP, uses the internet services and then 
disconnects the connection. 

• The user is charged a fixed amount depending upon the time 
period for which the connection was active. 

• Dialup connection was the most popular and cheapest way to
use the internet in the beginning days of the internet. 

• To establish a dial-up connection, you only need a computer
equipped with a device called Modem and a telephone
connection to connect your computer to ISP. 

• In this type of connection, users are billed as per duration of 
connection and not on the amount of data transfer. 

• The speed of data transfer in this type of connection is very
slow. 

(ii) Broadband Internet access 
• Broadband Internet access, often shortened to just 

broadband, is high-speed internet access method. 
• Broadband is often called high-speed internet, because it 

usually has a high rate of data transmission. 
• In general, any connection to the customer of 256kbps or 

more is considered broadband internet. 
(iii) Integrated Services Digital Network (ISDN) 
• The ISDN connection is the digital form of internet 

connection in which the user permanently stays connected 
with the ISP. 

• In this connection, the billing is done on the basis of data 
transmitted through the link and not on the basis of time of 
connection. 

• This type of connection is very high speed connection that 
supports audio, video and animations on the web. 

• There are many types of ISDN services. ADSL (Asymmetric 
Digital Subscriber line/loop) or simply DSL is the type of 
service that is all time connected. 

• This type of internet connection works on the conventional 
phone line and you can operate phone without disturbing 
the internet. 

(iv) Cable Connection 
• It is one of the upcoming types of internet connections that 

deliver very high data transfer speed i.e. up to 20Mbps. 
• You can use such connection through a cable modem. The 

cable TV wire will provide support for the internet also. 
(v) Wireless Internet Connection 
• This is the latest type of internet connection in which you can

access the internet without using any wire. 
• The receiver is placed at your premises to receive the internet

signal. 
• This type of connection also provides very high data 

transmission but it is costly and not much available. 
9.6 WEB BROWSERS 

Web Browser is a software program that allows you to explore
the internet in an easy to use way. It is used to locate, retrieve and
display content on the World Wide Web, including web pages
images, video and other files. 

As a client/server model web browser is the client side program



9.6 INTERNET & BROWSINGare free, and except for Internet Explorer, which is Windows-based 
only, they run on both Windows and Macintosh platform. 

□□□□□

Following table depicts a brief description of some popular 
web browsers: 

Web 
Browser 

Graphic
al 
Symbol/ 

Icon 

. 
Description 

Internet 

Explorer 0 

Internet Explorer (IE) is a Microsoft’s 
product. IE is one of the first 
graphical-based Web browsers. This was 
introduced in 1995 along with Windows 95Netscape 

Navigator 0 

Netscape Navigator was the first 
commercially successful Web browser 
introduced in 1994  Mozilla 

FireFox i® 

Mozilla Firefox is a free and open-source 
web browser developed by the Mozilla 
Corporation. It was released in 2004 and has 
grown to be the second most popular 
browser on the Internet  Safari //

&• 

 Safari is a web browser developed by 
Apple Inc. and included with the OS X and 
iOS operating systems. It was first released 
in January 2003. Safari has very good 
support for latest technologies like XHTMLOpera  

0 

Opera is a web browser developed by 
Opera Software in 1995. Opera is smaller 
and faster than most other web browsers. 

Google 
Chrome wr, • 

Google Chrome is a freeware web browser 
developed by Google in 2008. It combines a 
minimal design with sophisticated 
technology to make the Web faster safer 
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communication. ;r, they differ in the way they present 
nformation to the user. The information in ipaper is presented 

as a combination of text, image, and graphics. This has a it 
mpact on the user than the information presented on the 

television as a lation of image, photo, video, sound and music. 
Similarly, talking over a telephone sound) has a different 
mpact on the user, than, talking using the Internet >ne with a 

web camera (sound and photo) attached to it. In other words, 
the same ation when presented using different media has a 
different impact on the user, can say that the media used for 
presenting the information affects the way the :rceives and 
understands the information. ultimedia is the combination of 
two or more media, media in multimedia comes in different 
forms: ics, photography, text, audio, video, and animation, i be 
defined as a combination of graphics, audio, mimation, and 
video using the computer. 

order to work with multimedia, a personal rter typically 
requires a powerful microprocessor, memory and storage 
capabilities, a high quality or, external speakers or head phones 
and >M/DVDROM drive as well as special softwares to : many 
of these devices. 
ultimedia may be broadly divided into linear and near 
categories. Linear active content progresses t any navigation 
control for the viewer such as a cinema presentation. 
Non-linear t offers user interactivity to control progress as 
used with a computer game or n self-paced computer based 
training. Non-linear content is also known as ledia content. 
timedia presentations can be live or recorded. A recorded 

presentation may allow tivity via a navigation system. A live 
multimedia presentation may allow tivity via interaction with 
the presenter or performer. 
Characteristics of Multimedia 
rultimedia system has following characteristics or features: 
) A multimedia system must be computerized. 
) Multimedia systems must be integrated i.e. collaboration of 

various multimedia tools like: text, graphics, audio, video, 
animation etc. 

) The information handled by a multimedia system must be 
represented digitally. ) Multimedia presentations may be 
viewed by person on stage, projected, transmitted, or played 
ocally with a media player. 

) Multimedia games and simulations may be used in a 
physical environment with special effects, with multiple 
users in an online network, or locally with an offline 
computer, game system, or simulator.
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(vi) Multimedia system is interactive. The user is active and can
manipulate whatever is being communicated. Multimedia
allows two-way communication. The user can use devices
like keyboard, trackball or joystick to interact with the
multimedia system. 

(vii) Multimedia system gains and holds more attention
among people. People are more interested in multimedia
messages rather than simple text messages. 

10.2 APPLICATION OF MULTIMEDIA 
Multimedia finds its application in various areas including

education, entertainment, engineering, medicine, business and
scientific research. A few application areas of multimedia are listed
below: 
• Entertainment 

Multimedia is heavily used in the entertainment industry
especially to develop special effects in movies and animations
The entertainment industry has used this technology the most
to create real life like games. Several developers have used
graphics, sound, animation of multimedia to create variety of
games. The special technologies such as virtual reality have
made these games just like experiences of real life. Many
multimedia games are now available on computers. The
children can enjoy these experiences, for example, they can
drive cars of different variety, fly aircraft, play any musica
instrument, play golf etc. 

• Education 
In Education, multimedia is used to produce computer-based
training courses (popularly called CBTs). A CBT lets the user go
through a series of presentations, text about a particular topic
and associated illustrations in various information formats
Edutainment is an informal term used to describe combining
education with entertainment, especially multimedia
entertainment. Many computer games with focus on education
are now available. A simple example in this case is an
educational game which plays various rhymes for little kids. In
addition to playing rhymes, the child can paint the pictures
increase reduce size of various objects etc. Similarly many other
edutainment packages which provide a lot of detailed
information to kids are available. 

• Communication 
Multimedia provides better communication between remote
workers and the office through video conferencing. Video
conferencing is expected to provide better communication
between persons separated by space and time who need to
work together on common projects. 

• Engineering 
Software engineers may use multimedia in Computer
Simulations for anything from entertainment to training such as
military or industrial training. Multimedia for software
interfaces are often done as collaboration between creative
professionals and software engineers. 

• Industry 
In the Industrial sector, multimedia is used as a way to help
present information to shareholders and co-workers
Multimedia is also helpful for providing employee training
advertising and selling products all over the world via virtually
unlimited web-based technologies. 

• Medicine 
In Medicine, doctors can get trained by looking at a virtua
surgery or they can 
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viruses and bacteria and then develop techniques to prevent it. 
In hospitals, multimedia can also be used to diagnose an illness 
with CDs/DVDs full of multimedia-based information about 
various diseases and their treatments. Some hospitals 
extensively use the multimedia presentation in training their 
junior staff of doctors and nurses. 
Business Communications 
Multimedia is a very powerful tool for enhancing the quality of 
business communications. The business communications such as 
employee related communications, product promotions, 
customer information and reports for investors can be 
presented in multimedia form. The multimedia technology 
along with communication technology has opened the door for 
formation of global work groups. Today, the team members 
may be working anywhere, and can work for various companies. 
Thus, the work place for business has become global. A 
multimedia can make a business man come live. 
Multimedia in Public Places 
Bus stands and Railway stations are public places where people 
spend a lot of time in waiting for their desire conveyance. Such 
waiting become boring for people sometimes. Multimedia 
presentations can be used to entertain people in such situations. 
For example: On a Bus stand, multimedia monitors continuously 
showing cartoon films or tourist places films of short durations. 
In hotels, shopping malls, museums, and grocery stores, 
multimedia will become available at stand-alone terminals to 
provide information and help. 

10.3 MULTIMEDIA BUILDING BLOCKS / COMPONENTS OF MULTIMEDIA 
Multimedia is mainly concerned with the computer-controlled 

ntegration of text, graphics, drawings, still or moving images 
(video), animation and audio where every type of information can 
be represented, stored, transmitted and processed digitally. Any 
multimedia application consists any or all of the following 
components: 

> Text: Text plays an important role in almost all multimedia 
applications. The design and content of multimedia texts are 
so different from other type of texts such as newspaper texts, 
magazine texts and book text. With the recent explosion of 
the Internet and World Wide Web, text has become more 
important than ever. With multimedia technology, text can 
be combined with other media in a powerful and meaningful 
way to present information and express moods. 

> Images/Graphics: Images whether represented analog or digital 
plays a vital role in a multimedia. It is expressed in the form 
of still picture, painting or a photograph taken through a 
digital camera. In order to make a multimedia presentation 
look graceful and complete, it is necessary to spend sufficient 
amount of time to design the graphics and the layouts. 

> Sound/Audio: Sound or Audio is one of the important elements 
of any exciting and successful multimedia presentation. It 
comprises the spoken word, voice, music and even noise. The 
main reason for using digital audio in computer is to be able 
to use multimedia in its full potential. The most common 
requirement is to be able to input sound such as a spoken 
commentary on an image or a document. The microphone 
(which is normally used for recording) converts the voice into 
electrical signal or analog signal. Then, the analog signal is 
passed into the audio input of sound card of the computer, 
which converts the analog audio signal into digital form and 
stores it as computer data file. Playing back a digital audio 
data file is just the reverse process of converting analog to 
digital. 

> Video: Video is the most powerful tool of multimedia. It brings 
computer users closer to the real world. Video makes use of 
all of the elements of multimedia, bringing your products 
and services alive, but at a high cost. Video in multimedia is 
used to show real time moving pictures in a multimedia
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project. 
> Animation: Animation is the rapid display of a sequence of

images of 2D artwork or model positions in order to create
an illusion of movement. It is an optical illusion of motion
due to the phenomenon of persistence of vision, and can be
created and demonstrated in a number of ways. Animation
plays a huge role in entertainment and education industry. It
simply adds visual impact to the multimedia project. 
In computer animation, an animator's job is to take a static
image or object and literally bring it to life by giving it
movement and personality. 

 

10.4 MULTIMEDIA GRAPHICS 
Visualization is an important part of communications process

and graphical images can be used to add emphasis, direct
attention, illustrate concepts, and provide a background for the
content. For use in the computer, an image must be translated into
a digital form, so that computer can store, process and transmit it
This means computer images are often known as Digital images
The process of analyzing and manipulating digital images with a
computer is called Digital image processing. 

Graphics may include a photograph, drawings, cartoons
diagrams or graphs. 

Graphics are the important element of a multimedia project. In
order to make a multimedia presentation look graceful and
complete, it is necessary to spend sufficient amount of time to
design the graphics and the layouts. Graphics such as drawings and
photographs are integral to multimedia titles. 

In multimedia applications, there are mainly two types of
graphics: 

(i) Vector Graphics/Draw-type Graphics 
(ii) Bitmap Graphics /Raster Graphics 

(i) Vector Graphics 
Vector graphics, also called Draw-type graphics, represent an

image as a geometric shape made up of straight lines, ovals
curves, and arcs. When a line is drawn, a set of instructions is
written to describe its size, position, and shape. If more than one
line is drawn, it has a precise relationship to the other parts. In
simple terms, vector graphics  

Fig. 10.2 (Building Blocks of Multimedia) 
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Fig. 10.3 (Vector Graphic)

Fig. 10.4 (Vector Graphic - 
Reduced in Size)

Fig. 10.5 (Vector Graphic at different levels of 
magnification) 

e based on drawing elements or objects such as lines, rectangles, 
circles etc. to create image. Such drawing elements or objects 
are called vectors. 
Vector-based graphics have a wide scope in line art. 

Vector-based images are omewhat similar to geometric diagrams 
and use points and lines. The editing of vector- ased images is 
also very easy. The main reason of this easiness in editing is that 
only the properties of the lines and objects have to be changed. 

Vector-based graphics are easily scalable to any size. A 
vector-based image is made up of lines and mathematical 
statements which make it easy to scale images up and down 
without losing quality. Hence, vector-based images are great for 
the web since they can be resized to any proportion without 
loosing the quality of the original image. Vector graphics are the 
best choice for representing bold graphics that must retain crisp 
lines when scaled to various 
sizes-for example, logos. 

Fig. 10.3 shows a vector 
graphic, a pie chart, made up 
of a circle and lines. The 
instructions that create the 
circle and lines establish the 
relationship between them. If 
a change is made, say, in the 
size of the circle, the 
relationship between the 
circle and the lines stays the 
same. 

Fig. 10.4 shows a graphic 
reduced in sized and rotated. 
The reduced graphic keeps 
the same relationship as the 
original graphic. 

Example: A bicycle tire in a 
vector graphic is made up of 
a mathematical definition of 
a circle drawn with a certain 
radius, set at a specific 
location, and filled with a 
specific color. You can move, 
resize, or change the color of 
the tire without losing the 
quality of the graphic. 

Advantages of Vector Graphics: 
• Vector Graphics are 

resolution independent. 
You can make them 
larger or smaller without 
a loss of image quality.  
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Fig. 10.7 (Bitmap Image)

• Vector graphic files sizes are usually much smaller than raster
files making them easier to store and share. 

• Since most data, e.g. hard copy maps, is in vector form no 
data conversion is required. 

Disadvantages of Vector Graphics: 
• One of the disadvantage of vector graphics is that the more 

complex they are, the larger the file size and the longer they 
take to appear on the screen. 

• The location of each vertex or pixel needs to be stored
explicitly. 

• Another disadvantage is that they cannot display
photorealistic quality. 
(ii) Bitmap Graphics 

Bitmap graphics are also called Raster graphics. A bitmap
represents the image as an array of dots, called pixels. It is the
most common and comprehensive form of storage for images on a
computer. 

Most images you see on your computer screen are raster
graphics. Pictures found on the Web and photos you import from
your digital camera are raster graphics. They are made up of grid
of pixels, commonly referred to as a bitmap. The larger the image
the more disk space the image file will take up. For example, a 640
x 480 image requires information to be stored for 307,200 pixels
while a 3072 x 2048 image needs to store information for
6,291,456 pixels. 

Bitmap graphics are resolution-dependent and generate large
file sizes. Scaling simply makes the viewed pixels larger or smaller
This results in image quality problems. You can make a bitmap
smaller without too much loss, but you cannot make it larger
without loosing quality. 

 

Bitmap programs are ideal 
to retouch photographs, 
editing images and video files 
and creating original artwork. 
Variety of changes to 
photographs can be made, 
such as adjusting the lighting, 
removing scratches, people, 
and things, swapping details 
between images, adding text 
and objects, adjusting color, 
and applying combinations of 
special effects.

Fig. 10.6 (Bitmap Graphic - Original and Scaled Up Size) 
A bitmap is technically characterized
by the width and height of the image
in pixels and by the number of bits
per pixel (a color depth, which
determines the number of colors it
can represent).
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Fig. 10.8 (Bitmap image at different levels of magnification)
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In Fig. 10.8, 
to the left 
you see an 
mage and 

to the right 
the top of 
one of the 
ountains 

when 
zoomed in. 
As you can 
see, the 
mage 

consists of 
hundreds of 
rows and 
olumns of 
small 
elements 
(pixels) that 
all have 
their own 
colon ________________________________________________________________  
Note: When 
working 
with bitmap 
mages, you 

edit pixels 
rather than 
objects or 
shapes. ________  _____________________________________________   

Example: A 
bicycle tire 
n a bitmap 
mage is 

made up of 
a blend of 
pixels in 
that 
ocation. 

Advantages of 
Bitmap/Raster 
Graphics: 

• Bitmap
s 
graphic
s are 
very 
easy to 
create. 
Take a 
picture 

i h



 
you have got a bitmap image. 

• They are very cost effective. You can take a picture or scan in a
drawing, and easily show it on the Internet or send in an
email. 

• A bitmap image uses solid color pixels, which can be
identified and recolored easily. 

• Raster files are easy to use and can be edited by using
common photo-editing programs like- Photoshop. 

)isadvantages of Bitmap/Raster Graphics: 
• The most common and obvious disadvantage of bitmap image

format is that they are not upward scalable. You can make a
bitmap smaller without too much loss, but you cannot make it
larger without loosing quality. 

• Raster files can be very large if there is a large amount of
detail and pixels in an image which can make storing and
sharing them more difficult. 

• Another disadvantage of bitmap images is that they require
higher resolutions and anti-aliasing for a smooth appearance.

0.4.1 Vector Vs. Bitmap Graphics  ___________  
Vector Graphics Bitmap Graphics 

Vector graphics are based on 
drawing elements or objects 
such as lines, rectangles, 
circles etc to create an image

Bitmap graphics are based on 
an array of dots, called pixels 
to create an image. 

Vector graphics are also called 
Draw-type graphics. 

Bitmap graphics are also called 
Raster graphics. 

Images stored as vectors look 
better on devices (monitors 
and printers) with higher 
resolution  

Bit-mapped or raster images 
always appear the same 
regardless of a device's 
resol tionVector graphics files are small 

in size. 
Bitmap graphics files are larger 
than vector graphics. 
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10.5 MULTIMEDIA AUDIO 
Sound or Audio is one of the most appealing elements of any

exciting and successful multimedia presentation. It comprises the
spoken word, voice, music and even noise. It is a meaningfu
“speech” in any language. It can provide the listening pleasure of
music. Some feel-good music powerfully fills the heart, generating
emotions of love etc. Sound establishes the aural (hearing)
dimension, setting the mood, establishing the environment of your
presentation. When introducing the element of sound into your
application, be aware that there is a fine line between good
supportive sound and excessive, annoying sound. 

Sound is actually created due to the vibration of material
Sound is transmitted through the air, or some other elastic
medium, as pressure waves that are formed around the vibrating
material. 
10.5.1 Digital Audio / Waveform Audio 

If you have ever heard the sounds that greet you when you
start a Windows computer then you have heard waveform audio
Waveform audio is digitized sound stored as a data file on a
secondary storage device (like-hard disk). The sound is played
through an audio/sound card built into the computer. Some of the
important features of digital or waveform audio are: 

• Digital audio is created when you represent the
characteristics of a sound wave using numbers. This process
is called digitizing. 

• Digital audio systems for multimedia computer are based on
external components such as microphones, audio players
and recorders and speakers. 

• The digital audio system is responsible for converting the
audio signal from a microphone or other audio source into a
digital signal via a special component, called an analog to
digital converter. The process of converting an analog
audio signal into computerized digital form is called
Digitization. 

• The microphone which is normally used for recording
converts the voice into electrical/analog audio signal
Thereafter, this analog audio signal is passed into the audio
input of sound card, which converts it into digital form. 

• Once the digital sound is captured, it is then stored on the
secondary storage (hard disk, CDROM, DVD etc.) in the form
of audio file(s), which can be edited later on. 

• Most of the latest multimedia systems are coming with
inbuilt sound processor and speakers (like- Laptop)
However, external speakers provide high sound clarity and
volume. 

• Digital audio is said to be device independent. The quality
of your audio is based on the quality of your recording and
not the device on which your end user will play the audio. 

10.5.2 MIDI (Musical Instrument Digital Interface) 
MIDI (Musical Instrument Digital Interface) is a

communications standard developed in the early 1980s for
electronic musical instruments and computers. The electronic
music industry adopted this standard for controlling musica
devices, such as

Easy to store and share. Difficult to store and share. 
Vector graphics are resolution 
independent. Vector-based 
graphics are easily scalable to 
any size. You can make them 
larger or smaller without a loss 
of image quality. 

Bitmap graphics are resolution 
dependent. Bitmap graphics 
are not upward scalable. You 
can make a bitmap smaller 
without too much loss, but you 
cannot make it larger without 
loosing quality   
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nthesizers and sound cards that produce music. Some of the 
important features of UDI are: 

MIDI allows multiple instruments to be played from a 
single controller, which makes stage setups much more 
portable. 
It allows a wide variety of electronic musical instruments, 
computers and other related devices from different 
manufacturers to connect and communicate with one 
another by sending messages along cables connected to 
the devices. 
A MIDI file is a list of time-stamped commands that are 
recordings of musical actions, like- the pressing down of a 
piano key. When MIDI file sent to a MIDI playback device, 
this results in sound. 
The MIDI standard is supported by many synthesizers, so 
sounds created on one synthesizer can be played and 
manipulated on another synthesizer. 
Composing your own original score can be one of the 
most creative and rewarding aspects of building a 
multimedia project, and MIDI is the quickest, easiest, and 
most flexible tool for this task. 
A number of software programs are available for 
composing and editing music that conforms to the MIDI 
standard. They offer a variety of functions: for instance, 
when you play a tune on a keyboard connected to a 
computer, a music program can translate what you play 
into a written score. 
A MIDI keyboard is also useful for simplifying the creation 
of musical scores. 

Fig. 10.9 (MIDI Keyboard) 
• MIDI does not record analog
sound wave like a tape recorder. 
• One of the important features 
of MIDI files is that they are meant 
for music only, not voice. 
• MIDI is device dependent. 
Because the quality of the playback 
d d th d ’ MIDI



 

 

MIDI Digital Audio 
MIDI begins with an event, such 
as pressing a key on an 
electronic musical instrument 
such as a MIDI keyboard, and 
codes the event as a series of 
commands. These are stored in 
a file and can be sent from the 
computer to another

Digitized audio begins with a 
sound, samples it, and creates a 
digital representation which is 
stored in a file. 

t is not digitized sound. t is digitized sound. 
MIDI is device dependent.
Because the quality of the 
playback depends upon the 
end user’s MIDI device rather 
than the recording. 

Digital audio is device 
independent. The quality of 
playback depends upon the 
quality of your recording and 
not the device on which your 
end user will play the audio   
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10.6 MULTIMEDIA VIDEO 
Video is the most powerful tool of multimedia. It brings 

computer users closer to the real world. Video makes use of all 
of the elements of multimedia, bringing your products and 
services alive, but at a high cost. Scripting, hiring actors, set 
creation, filming, postproduction editing and mastering can 
add up very quickly. Five minutes of live action video can cost 
many times more than a multimedia production. 

The advantage of integrating video into a multimedia 
presentation is the capacity to effectively convey a great deal 
of information in the least amount of time. With video 
elements in your project, you can effectively present your 
messages and reinforce your story, and viewers tend to retain 
more of what they see. But be careful; good-quality digital 
video clips require very sophisticated hardware and software 
configuration and support. Carefully planned, well-executed 
video clips can make a dramatic difference in a multimedia 
project. 

The ability to incorporate digitized video into a multimedia 
presentation marked an important achievement in the 
evolution of the multimedia industry. 
There are two basic approaches to delivering video on a 
computer screen: 

(i) Analog video (ii) Digital video 
Analog video is essentially a product of the television 

industry and therefore conforms to television standards. 
Digital video is a product of the computing industry and 

therefore conforms to digital data standards. 
Video, like audio, is usually recorded and played as an 

• MIDI files are much more 
compact than 

digital audio files  

Digital audio files are large in 
size. The 
higher the sound quality, the 
larger file size will be  • Because MIDI files are small, 

they don’t take up as much 
memory and disk space. 

As digital audio files are larger 
in size than MIDI files. So, they 
consume more memory and 
disk space  Easy to edit a MIDI file without 

changing the pitch of the 
music or degrading the audio 
quality  

Editing an audio file without 
changing the pitch of the 
music or degrading the audio 
quality is impo ssible  MIDI files sound better than 

digital audio files when played 
on a high-quality MIDI device. 

Sound quality of an audio file 
depends upon size of the file. 

t is difficult to playback spoken i! is easy to playback spoken 
MIDI does not have consistent 
playback quality. 

Digital audio provides 
consistent playback quality. 
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A video source, such as video camera, VCR, TV, or videodisc, 
is connected to a video ipture card in a computer. As the 
video source is played, the analog signal is sent to Le video 
card and converted into a digital file that is 
stored on the hard drive. At the ime time, the 
sound from the video source is also digitized. 

PAL (Phase Alternating Line) and NTSC (National 
Television System Committee) are e two video 
standards of for analog video. PAL is the 
standard for most of Europe and ,e 
Commonwealth, NTSC for North and South 
America. 
).6.1 Analog Video 

Analog video can be delivered into the 
computing interface from any compatible ieo 
source (video recorder, videodisc player, live 
television) providing the computer is [uipped 
with a special overlay board, which synchronizes 
video and computer signals id displays 
computer-generated text and graphics over the 
video. 

In an analog system, the output of the CCD is 
processed by the camera into three lannels of 
color information and synchronization pulses 
and the signals are recorded ito magnetic tape. 
There are several video standards for managing 
analog CCD output, ich dealing with the amount 
of separation between the components—the 
more paration of the color information, the 
higher the quality of the image. If each channel 
color information is transmitted as a separate 
signal on its own conductor, the signal ltput is 
called component (separate red, green, and blue 
channels), which is the eferred method for 
higher-quality and professional video work. 

Analog video has a resolution measured in the 
number of horizontal scan lines, but ich of those 
lines represents continuous measurements of 
the color and brightness ong the horizontal axis, 
in a linear signal that is similar to an audio 
signal. 

The analog video and audio signals are written 
to tape by a spinning recording head at changes 
the local magnetic properties of the tape’s 
surface in a series of long agonal stripes. 
1.6.2 Digital Video 

Digital video is a type of digital recording 
system that works by using a digital rather an an



MULTIMEDIA 10.13

 

digital systems, the output of the CCD is digitized by the camera 
into a quence of single frames, and the video and audio data are 
compressed before being 'itten to a tape or digitally stored to disc. 

One of the advantages of digitized video is that it can be easily 
edited. Analog video, ich as a videotape, is linear; there is a 
beginning, middle, and end. If you want to edit you need to 
continually rewind, pause, and fast forward the tape to display the 
isired frames. 

Digitized video on the other hand, allows random access to any 
part of the video, and liting can be as easy as the cut and paste 
process in a word processing program. In Idition, adding special 
effects such as fly-in titles and transitions is relatively simple. 
Digital video is stored as a standard computer file. Thus it can be 
copied with no loss quality, and also can be transmitted over 
standard computer networks. However a lange in parameters like 
frame size as well as a change of the digital format can :crease the 
quality of the video. 

Digital video has a significantly lower cost than 35 mm film. The 
tape stock itself is ry inexpensive. Digital video also allows footage 
to be viewed on location without the :pensive chemical processing 
required by film. Digital television (including higher lality HDTV) 
started to spread in most developed countries in early 2000s. 
Digital video  
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is also used in modern mobile phones and video conferencing 
systems. Digital video is also used for Internet distribution of 
media, including streaming video and peer-to-peer movie 
distribution. 

Unlike analog video, digital video requires neither a video 
board in the computer nor an external device (which adds extra 
costs and complexity) such as a videodisc player. 
10.6.3 Analog Vs. Digital Video 

 

10.7 IT SECURITY 
IT security or computer security is a security applied to 

computing devices such as computers and smart phones, as 
well as to both private and public computer networks, 
including the whole Internet. 

The confidentiality, availability and the integrity of the data 
is the most important aspect of the computer security. 
Computer security refers to securing your computer from the 
unauthorized access and from internal and external threats like 
virus, spyware, Trojan horses, phishing attacks, hackers and 
intruders. There are a large number of techniques that can be 
used to protect your computer from all these threats. 
Following is an overview of some of the common PC threats 
and the solutions from preventing them. 
• Computer Viruses 

Computer viruses are the one of the most common threats 
to a computer. Any online computer can be attacked by the 
viruses and other online threats in less than 20 minutes, if it 
has not been using a proper security mechanism. A virus 
infected computer can transmitted the viruses to the other 
connected computers in a network. Viruses can harm your 
computer in a variety of ways such as they can corrupt data, 
corrupt the hard disk, delete the operating system files and 
can crash the system. Install up-to-dated antivirus software 
and regularly scan your computer to get rid of the 
potentially dangerous computer viruses

Analog Video Digital Video 
t allows linear access to video. 
You need to continually 
rewind, pause, and fast 
forward the video tape to 
display the desired frames  

• It allows random access to 
any part of the video. 

Difficult to edit. • Easy to edit. 
The clarity of analog video may 
be blurred due to poor 
reception signal

• The digital video has a better 
signal which makes it crystal 
clear  Analog video degrades with 

each copy. 
• No quality is lost when you 

copy digital video. 
Low cost. • High cost. 
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computer with it. 
• Phishing 

Phishing attack is another growing threat for the online 
computers. Phishing is a type of online cheating techniques 
that is designed to steal your confidential information, 
passwords, credit card information and important login and 
password
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through the fraudulent emails. The best solution to avoid 
this threat is to not open the E-mail attachments from the 
unknown and unreliable sources. Secondly, never give your 
personal information to anyone even the E-mails claim to be 
delivered from big sources. 

• Firewall 
If you haven’t implemented a firewall system on your 
computer then chances are that your computer can be 
accessed by the unauthorized users and hackers. The best 
solution to avoid this problem and keep your privacy intact 
is to install and configure a software or hardware firewall 
into your system. 

• Physical Threats 
The physical threats to a computer involves the physically 
damage to the computer components with the fire, water 
and destructions. The best solution to avoid the physical 
threats to your important computer system and data is to 
set an off-site replication. 

• Employee’s Sabotage 
An organization’s employees are most familiar with the 

computers inside an organization. There are a lot of examples 
where the annoyed employees of a company are involved in 
sabotaging or damaging the computer system. Employee’s 
sabotage include entering data incorrectly, destroying system 
hardware, deleting data, changing data, changing the 
passwords and entering the data incorrectly. The best * way to 
avoid the situations like these is to delete the employees’ 
account after they leaves the company so that they can’t no 
more access company’s systems. Secondly, regularly monitor 
the activities of the employees and restrict their access to the 
sensitive resources in the overall IT infrastructure. 
• Vendor’s Default Password Attack 

Vendors of the computer systems have the default 
passwords at many different hardware and software 
components like the router, system BIOS and others. It is 
veiy important to change the default password of the 
computer devices and applications. 
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